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System Requirements and Performance

To run TEMPO 5, your computer must have (as a minimum):
• Windows 2000, Windows XP, or Windows Vista
• Microsoft Internet Explorer 6.0 with Service Pack 4 on Windows 2000
• Microsoft Internet Explorer 6.0 with Service Pack 2 on Windows XP
• Microsoft Internet Explorer 7.0 with Service Pack 2 on Windows XP
• Microsoft Internet Explorer 7.0 on Windows Vista
• A minimum screen resolution of 1024 x 768
• 56K modem internet connection (high-speed broadband, such as cable or DSL, 

preferred)
Microsoft Internet Explorer is the ONLY supported Web browser. AOL, MSN and 
other browsers will not work with TEMPO 5.
The time it takes TEMPO 5 to display search results is dependent upon a number of 
factors, including the number of listings matching the search criteria, the speed of the 
computer’s Internet connection, and the capabilities of the computer’s hardware.
By performing regular system maintenance, you may be able to improve the 
performance of TEMPO 5. Defragmenting your hard drive will free up disk space 
and may even improve the speed at which TEMPO 5 runs. Running the Disk 
Defragmenter checks for errors on your hard disk and will help ensure trouble-free 
computing, while running Disk Cleanup clears your disk of unnecessary files.
For more information on maintaining your computer, refer to Windows help.

To run Disk Defragmenter:

1. Click the Start button.
2. Click All Programs > Accessories > System Tools > Disk Defragmenter.

The Disk Defragmenter dialog box opens.
3. Highlight a volume in the list (for example, your C:\ drive) then click:

• Analyze — estimates the amount of disk usage and reports on whether you 
should defragment your disk. View a report or proceed with defragmentation.

• Defragment — begins defragmentation, displaying progress on the progress 
bar. You can click Pause or Stop at any time. 

To run Disk Cleanup:

1. Click the Start button.
2. Click All Programs > Accessories > System Tools > Disk Cleanup.

The Select Drive dialog box opens.
3. Select the drive you want to clean up from the drop-down list, then click OK.
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The Disk Cleanup for [drive] dialog box opens, displaying how much disk space 
you can free up.

4. Select one or more files to delete from the list box (optional).
5. Click OK to proceed.
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Signing In and Out

This User Guide assumes that you have a basic working knowledge of the MS-
Windows environment, including a familiarity with Windows terminology, navigation, 
the use of a mouse and keyboard commands. In addition, you should have an 
understanding of how to use the Internet.

NOTE! Before you begin using TEMPO 5, review the minimum system requirements. 
See “System Requirements and Performance” on page 2. You will need the MLS User ID 
and Password provided to you by your MLS Board.

To sign in to TEMPO 5:

1. Make sure you are connected to the Internet and launch Internet Explorer.
2. Go to the TEMPO 5 Web address you were given by your MLS. 

The TEMPO MLS system page opens. (Your login page may look slightly 
different than the one shown here.)

3. Enter your MLS User ID and Password, then click Sign In to begin.
NOTE! IF THIS is the first time you have logged into TEMPO 5, the Registration wizard 

appears. Read through the License Agreement and click Next to agree to the 
terms of use and privacy policy. In some instances you may have to scroll down 
to see the Agree option. Proceed to step #4.

4. Enter a Primary e-mail address. 
Note: Any replies to messages you send from TEMPO 5 will be directed 
to this e-mail account, so make sure you enter it correctly. 

5. Click Next.
A confirmation dialog box opens with your Registration summary information.

6. Click Finish.
The TEMPO 5 Home page opens.

TIP ... You may 
want to bookmark 
the TEMPO 5 URL 
in your list of 
Favorites for easy 
access. 

To do this from 
the Internet 
Explorer (IE) 
menu, click 
Favorites > Add 
to Favorites. 
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If you cannot remember your password:

1. On the Log in to the TEMPO MLS system page, click the Forgot your 
password? link.
The MLS System Password Reminder wizard opens. 

2. Enter your User ID in the field.
3. Click the Secret Question drop-down list and choose the question you need to 

answer.
4. Enter the Answer, and then click Next. 
5. When your answer has been verified, click Done to e-mail your password to your 

primary e-mail address.
NOTE! If you don’t remember your secret question or answer, please contact your MLS 

Board.

To sign out:

• In the top right corner of the main menu (also known as the header bar), click the 
Log Off [ ] button. 
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What’s On the Home Page?

The Home page is the first page you see when you log in to TEMPO 5.
Note: You can change your personal defaults to select a different menu 
option to appear when you log in. See “Changing Personal Defaults” on 
page 42.

The Home page presents an overview of important information at a glance. It also 
provides a quick and convenient way to access the main features of the program.

NOTE! To make the most of your available screen space, press the F11 key. This will 
automatically maximize the TEMPO 5 window by hiding the Internet Explorer 
title bar, menu bar, and task bar. To restore Internet Explorer to its normal size 
and appearance, press F11 again. Try setting your monitor to 1280x1024 pixels.

Header Bar Controls

The header bar, located at the top right of the page, displays your Login ID and five 
header bar controls: Home, Email, Help, Log Off and Minimize/Maximize 
buttons. 

To use the header bar controls: 

• Click the button of the page you want:
• Home — click this button to return to the Home page.
• E-mail — click this button to compose an e-mail message. See “E-Mail 

Messages” on page 129.
• Help — click this button to view the online Help system and TEMPO 5 

version information.
• Log Off — click this button to exit TEMPO 5.
• Min/Max — click this button to expand or collapse the main menu bar and 

show or hide the icons. See “A Look at the Main Interface” on page 18.

Header bar menu controls

Click your Login ID to access 
the Identity Sharing feature.
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Main Menu Bar

Use the main menu bar, located at the top of the page, to access the major functions 
from anywhere in TEMPO 5. 

To use the menu bar: 

1. Click a main menu command to go directly to the major program area:
• Search — use the Quick Search, MLS Number Search, History Search, 

Open House Search menu commands; or create a more advanced search 
query using the Search Manager. Save your new search query for future 
reuse.

• Hotsheets — create a hotsheet search for new or changed listings. A 
summary of the search results is displayed on your TEMPO 5 Home page. 

• Reports — create and manage Comparable Market Analysis (CMA) 
presentations to assist you in pricing a property. Use with the Report 
Manager to create or modify reports using the Report Editor. View 
business reports, such as statistics, RETS member logins, inventories, etc. 

• Prospects — access the Prospect Manager, Contact Manager, New 
Prospect Wizard, and New Contact menu items.

• Public Records — find public tax records for any property matching 
selected criteria (this feature is not available in all areas). 

• Financials — access Buyer and Seller Netsheets and the Payment 
Calculator to estimate loan payments, etc.

• Member Info — perform a Member or Office search and set up MLS news 
(Message of the Day).

• My Tools — set up your user preferences, access the Staff Tools and 
Change Password commands and/or change or set up your secret question.

2. Using the mouse, point to a menu item to see a list of related submenu 
commands. 

3. Click a submenu command to access a more specific function. 

Point to the Reports menu 
to display a list of submenu 
commands. 
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My Sidebar

My Sidebar is a useful panel that can be accessed from anywhere in TEMPO 5 
whenever you click it. It uses a vertical tab, located on the left side of the page, to 
display or hide the panel. It features several resources that allow you to open MLS and 
personal links. You can add your own personal links so you can quickly access your 
own favorite Web sites. You cannot, however, change the MLS Links as they are set 
up and maintained by the Board. 

To display and hide the sidebar panel:

• Click the vertically positioned My Sidebar tab once to display the panel. 
Click the tab again to hide the panel.

To access My Sidebar contents:

1. Click one of the section headers, for example, MLS Links, to find a list of 
available resources. 

2. Click the hyperlink of your choice to open it.

To add your own resource links to My Sidebar:

1. From the main menu, click My Tools > Preferences > Personalize Home 
Page Resource Link. 
See “Personalizing Home Page Resource Links” on page 45 for details.

Click the My Sidebar tab to show or hide 
the panel as you prefer.
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2. Once setup, click a hyperlink within a Personal category.
Note: You may have to log out of the system, then log back in to see a 
newly added resource link.

Prospecting Matches

The Matches section displays the number of search results for new listings that 
match saved search criteria (New Prospecting matches). 

They are displayed until you mark them “Read.” Click the link to go directly to the 
Prospect Manager. See “Saving a Prospect Search” on page 99.

Find a Listing

Enter an Address or MLS number, then click the arrow button to quickly locate a 
listing. 

Click one of the links (Search for a listing, Modify or add new listings, or Modify 
or add listing images) to access other common functions. See “Quick Search for a 
Listing” on page 65.
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Inventory Watch

The Inventory Watch section has a number of listing-related links and the 
corresponding number of results for each, based on the previous search. 

Note: The Inventory Watch also includes listings for which you are the 
co-listing agent.

• Keep track of the number of Active Listings, Pending Sales, Office Listings etc., 
then click a link to go to the listing search results page. 

• Click the Refresh link to see the most recent numbers for the specific search 
criteria.

See “Saving a Prospect Search” on page 99.

Hotsheet

This section displays changes to your Hotsheet listings since the previous day. 

• Click a link to go to that hotsheet. 
• Click Change my criteria to update your saved hotsheet criteria. 
• Click Refresh to renew the numbers, based on the search criteria.

The Hotsheet list 
has been extended 
to include many 
more links than 
before.
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See “Viewing Today’s Hotsheet Summary” on page 138.
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Using the MLS, Broker and Office Tabs

The MLS section functions as an “electronic bulletin board” and is a useful area 
where you may read up-to-date news and information that may affect TEMPO 5. 
Click the Broker or Office tab to see news that is specific to your brokerage and/or 
office, such as current events and issues. 
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Identity Sharing

You can invite other members of your office, such as an assistant or a team member, 
to log in and work in TEMPO 5 on your behalf (up to a maximum of 20 users). 
The invited user will “assume your identity” and therefore have the same user class 
privileges as you. For example, if you are an office manager with office level privileges 
(Joan Swanson in the screenshots below), the invited user (Ken Smith) will also share 
your office level privileges. If any modifications are made to listing records, TEMPO 
5 will record the User ID of the person who actually made the changes (Ken Smith).

NOTE! All users must have their own personal login and password.

To invite another member to share your identity:

1. On the header bar, click the [your name] link. 

The Sign-in as dialog box opens. 

2. Click the Create new shared identity link in the bottom left corner of the dialog 
box.
The Member Lookup dialog box opens. 

3. Search for a member by entering the First name and/or Last name, in full or in 
part. Click Find.

Click the link to find a 
member to share your 
identity with.
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A list of current members matching the criteria is displayed. 

4. Highlight a member (one at a time) in the list, and then click OK.
The name appears in the You are currently sharing your identity with these 
members list located at the bottom of the Sign in as dialog box. 

5. Once you have finished adding names of members you are sharing your identity 
with, select the Show Sign-In As option when I log in check box. 
This ensures the Sign in as dialog box is displayed immediately after login.

6. Click OK.
This person (Ken Smith in the example) is now able to log in as you from his 
computer. 

The User ID appears in 
brackets after the 
member’s name.
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To remove the invitation to share your identity:

1. Open the Sign-in as dialog box.
2. Highlight the invitee’s name in the You are currently sharing your identity 

with these members list.
3. Click the Delete selected shared identity link in the bottom right corner of the 

dialog box.
A message box appears asking you to confirm the deletion of the selected 
shared identity.

4. Click OK.
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A Look at the Main Interface

Like many applications, TEMPO 5 is designed to have certain standardized features 
and page elements in common with other programs. For instance, you will find a main 
menu bar along the top of the page, as is the case with most applications. Your 
familiarity with a menu bar lets you begin using the program right away. See “Main 
Menu Bar” on page 7.
Some controls and terminology are more specific to TEMPO 5, such as My Sidebar, 
and words like “hotsheet” that are specific to the real estate industry. This section 
briefly describes the main controls and page elements in TEMPO 5 and how they 
work. 

Collapsing/Expanding the Main Menu Bar

Use the main menu bar, located at the top of the page, to access the major functions 
from anywhere in TEMPO 5. When the buttons are displayed, the menu bar is also 
known as a toolbar.

To save space, or perhaps as a personal preference, you can collapse the toolbar and 
show only the text labels.

To collapse the toolbar: 

1. Click the Minimize button [ ].
The menu collapses, showing only the menu commands, not the buttons. 

2. Click the Maximize button [ ].
The menu expands, showing both menu commands and buttons.

Links

Hyperlinks (links) are text or graphics that you can click to go to another Web page or 
open a document or image. For example, in the Home page, there are links available 
in the Hotsheet section. 

To view a hotsheet:

• Click the appropriate link.

Text that is underlined usually 
indicates a hyperlink.
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Field Related Controls

There may be a list of selections available for entering values on forms, such as when 
you are specifying search criteria in the TEMPO 5 Search Form. The following field 
related controls make it faster and easier for you to enter values. 

Calendar Pop-ups

Date fields accept only numeric entries that are in the format [m/d/yyyy] to be valid. 
Each date search field has a Calendar button next to the field that makes inserting a 
date much easier. 

To insert a date:

1. Click the calendar icon to display the calendar. 
Note: By default the calendar displays Today’s date.

2. Click the following:
• Previous Year [ ], Next Year [ ], Previous Month [ ], Next Month 

[ ] buttons.
• The Month drop-down arrow to select a month and the Year drop-down 

arrow to select a year.
3. Click the date directly to choose that date.
4. Click OK.

Pick Lists

The Search Criteria page has a series of expandable drop-down lists, called pick lists 
or multi-select lists, that allow you to select one or more items and insert them into 
the search field. 

NOTE! If you know the first letter of an item, simply type it in the field. TEMPO 5 will 
automatically highlight the first matching list item. Press Enter to select the 
highlighted item.
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To use a pick list:

1. Click the down arrow [ ] to expand the list. 

2. To select one or more items from the list:
• click an item to add it to the field.
• double-click anywhere in the expanded list to select all items. 
• type the first letter of the item’s Desc, or the item’s short Code to select the 

item. 
3. To clear one or more items from the list:

• click a highlighted item to de-select it; or hold down the CTRL key and click 
multiple selected items to clear them.

• double-click anywhere in the expanded list to clear all selected items. 
• click the Eraser button at any time to clear all selected items from the list.

4. Press the TAB key to advance to the next field and close the list; or click the down 
arrow again to collapse the list. 

Eraser Tool

This button [ ] makes it easy to clear all selections in a field, especially when you 
have selected a long list of values. Clicking to de-select all values one-by-one is time 
consuming. Use the Eraser button to clear the field and start over.

Prices in Thousands

To reduce the number of zeroes you have to type into each Price field when 
specifying search criteria, use the “multiples of 1,000” feature. 

To abbreviate the Price field value:

• Select the in 000s check box after a price field. 
TEMPO 5 will automatically recognize the field value as a multiple of 1,000. 
For example, 150 will be 150,000.

Eraser tool.
TIP ... Press F7 to 
automatically 
expand the pick 
list. Press F7 again 
to collapse it.

Click the in 000s check box to shorten 
the amount of numbers you have to enter 
in the price fields.
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Short Codes

You have the choice to display pick list values as a long description or as an 
abbreviation (short code) in a search criteria field. Short codes are good for saving 
space when there are multiple values. 

To use the short Code or Desc links:

• Click the Code/Desc link to switch between long descriptions or short 
abbreviations.

NOTE! The Listing Maintenance pages have an Option List Display drop-down list that 
lets you specify how the information in pick list fields is displayed: default, long 
description or short code. See “Adding a New Listing” on page 114.

Click the Desc or Code link to specify how you 
want the field values displayed: long description or 
abbreviated.
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Viewing, Sorting and Filtering

There are several ways to make viewing a long list of records easier and more relevant 
to what you need to do. You can sort, rearrange, and narrow the list.

Resizing the Column Width

Information displayed in a column may be truncated from view. You can easily 
stretch the column to see the information.

To resize the column width:

1. Using the mouse, point to the edge where the two column headers meet.
The pointer becomes a double-sided arrow. 
Note: You may be prompted at this point by an Internet Explorer 
message box asking if you want to turn off the “Best Fit All Columns” 
option. Click OK.

2. Hold down the mouse button and drag the pointer to move the split line and 
resize the column width. 

Footer Bar Controls

The footer bar, located at the bottom of the Search Criteria and Results tabbed pages, 
contains controls that let you change the view of a list of records. For example, you 
can move fields up or down, narrow the listings view, etc. 

To use the footer bar controls: 

1. Highlight a field on the Search Criteria page, or select a row on the Search Results 
page.

2. Click the button of the action you want to perform.

Reordering Search Fields

You can change the order of a selected field on a Search Criteria page. 

To reorder a field on a Search Criteria page:

1. Highlight the row in which the field is located.
2. Click either the Move Field Up or Move Field Down button located in the 

footer bar.
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3. Continue clicking the button until the selected field row is in the desired location.

Reordering Records

You can change the order of a selected record in a list of Search Results. 

To reorder records in a list:

1. Select the record you want to move.
2. Click either the Move Up or Move Down button, located in the footer bar.
3. Continue clicking the button until the selected record is in the desired location.

Reordering Columns

You can change the order of columns on a grid by dragging-and-dropping a column 
header to a different location. 

To reorder columns on a grid:

1. Using the mouse, click on the column header you want to move (e.g. MLS#).
2. While holding the mouse button, drag the header across the row to a new location 

in the grid (atop another header), then release the mouse button.
The entire column relocates to the new grid location.

3. From the Action menu, select Save Grid, then click the arrow button.
A message box appears confirming that the grid changes have been saved 
successfully.

4. Click OK.

Sorting the List of Records

You can sort a list of records, such as on the Contact Search Results page, to display 
the list in alphabetical order. Contact lists can be sorted by first or last name. 

To sort a list by a single column:

1. Click a column header, for example Contact Type. 

The column in motion turns translucent to 
indicate that it is being relocated.
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A small arrow appears, pointing in the current sort direction; up for an 
ascending or down for a descending sort. 

2. Click the same column header again to reverse the sort order.

Multi-Field Sorting

The multi-field sorting controls let you select up to three columns by which to sort 
the results, and you may specify either an ascending or descending sort direction for 
each.

To multi-sort a list by up to three columns:

1. Click the Multi-Field Sort button [ ] to expand the section. 

2. Define the first column sort by clicking the Sort By arrow and selecting a column 
header, for example ML#. 

3. Click the Sort Ascending/Descending button [ ] next to the Sort By field 
to choose a sort direction, where: 
• a descending sort lists from Z to A and 9 to 0; and 
• an ascending sort lists from A to Z and 0 to 9.

4. Define the second column sort by clicking the Then By arrow and selecting a 
column header, for example Address.

5. Click the button next to the Then By field to choose either an ascending or 
descending sort direction.

6. Define the third column sort by clicking the second Then By arrow and selecting 
a column header, for example DOM. 

7. Click the button next to the Then By field to choose either an ascending or 
descending sort direction.

8. Click the Sort button.

9. Click the Multi-Field Sort button [ ] to collapse the section.
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Filtering the Search Results List

You can narrow your search by applying a simple filter or by applying several filters 
(together or independently). In this way you can reduce the number of search results. 
Filters are applied by using a drop-down list and selecting one value. All records with 
that value are displayed, while the others are hidden from view. 

To apply a simple filter to a list of records:

1. From a list of search results, click the first drop-down list (Status, as an example) 
and choose one of the status types: Active, Sold, Expired, etc. 
Only those records with the specified status will be displayed.

2. From the same list, click All to remove the filter and display the entire list.

To apply multiple filters to a list of records:

1. From a list of search results (in Contact Manager, for example), click the Contact 
Type drop-down list, and select Buyer.
The list is reduced to display “Buyer” records.

2. Next, click the Status drop-down list and choose New.
The list is further narrowed to display only those “Buyer” records that are 
“New.” 

3. Finally, click the Filter drop-down list and select Show selected.
The list is further narrowed to display only those “Buyer” records that are 
“New” and “Selected.”

To return to an unfiltered Contact list display:

• Click the Contact Type, Status, and Filter arrows and select All.
The full list is once again displayed.
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Showing/Hiding Criteria

The footer bar contains the Show Criteria button, which enables you to see an 
overview of the search criteria used to retrieve the current search results. Similarly, the 
Hide Criteria button lets you close the Search Criteria pane.

To display an overview of the current search criteria:

1. From the footer bar, click the Show Criteria button.
A preview pane opens in the bottom half of the Search Results tabbed page. 

2. Click the Hide Criteria button in the footer bar to close the preview pane.
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Task Related Controls

Once you have selected one or more records to work with, there are buttons, menu 
items, and tools available for you to take action or perform a task. For example, once 
you have searched for and selected several listings, you may want to print or e-mail the 
information.

Results Counter

As you enter multiple search criteria in the fields of a search form, the Current 
Criteria box, available on the left side of the page, keeps track and lists all criteria. 

To use the Count feature:

1. Once you have specified search criteria for all required fields on the search form, 
and they are reflected in the Current Criteria box, click the Count button.
The number of matching records is calculated and displayed in the field. 

2. If the number is extremely large, adjust your search criteria to reduce the number 
of matching records before clicking the Search button to retrieve the records. 

NOTE! TEMPO 5 can display only 1,000 matching records. If the count, based on your 
current criteria, is over 1,000 and you click the Search button, a warning 
message appears prompting you adjust your search criteria to reduce the 
number of matching records.
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Selecting / De-selecting Records

Before you can perform certain actions on a record, you must select it. For example, 
you may want to send an e-mail to a contact after performing a search.

To select/de-select one or more records:

1. Select the check box of the record. 
A check mark appears indicating the record is selected. 

2. Clear the check box.
The check mark is removed, indicating the record is no longer selected.

To select/de-select the entire list of records:

1. Select the check box in the column header to choose all records.  

Now you can click a button, for example, Print to work with selected records.
2. Clear the check box in the column header to de-select all records. 

Quick Access Menu

The Quick Access menu is available for each record in a Search Results list. It enables 
you to perform additional actions for a selected record.

NOTE! The following list of Quick Access menu options may not include all possible 
features, depending on your area and third-party vendors, etc. 

To display the Quick Access menu:

1. Using the mouse, point to the Information button [ ] of a specific record in 
the list. 
The Quick Access menu appears.

2. Click the appropriate button. 

Click the check box in 
the column header to 
select all records.
Click again to de-select 
all records in the list.

Edit — revise a selected record’s information.
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Action Buttons

Action buttons are controls found below (and sometimes above) the main pages 
throughout TEMPO 5 enabling you to perform additional tasks to one or more 
selected records on a page. 

E-mail — send an e-mail message with a link to recommended 
properties to interested contacts.

Print — print contact lists, reports and labels.

Delete — permanently delete a record and all associated information.

Report — generate listings reports, business reports and more. 

Property History— view the selected listing’s MLS property history.

Images — view media for the selected property.

Map — shows the selected property’s location on a map.

Notes — recommend (or reject) a listing and associate it with any 
accompanying notes to a contact record. 

Financial Calculators — access a payment calculator to determine 
payments and manage your buyer and seller netsheets.

Charts — produce a colorful chart of MLS data.
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To execute an action: 

1. Select one or more records in a list, such as the Search Results page. 
2. Click a button to perform an action, such as Map to show a property’s location 

on a map. 

Quick Link Button Bar

The Quick Link button bar is available on the left side of the Search Details page. 
By default, the Listing link will be selected. 

It enables you to quickly access different aspects of the selected property record. 
For example, click the appropriate buttons to view Property History, Images, 
Virtual Tours, Attachments and more. 

Going Back

When you want to return to a previous page, use TEMPO 5’s built-in controls to 
navigate instead of the browser’s Back button. Using the browser’s button may cause 
TEMPO 5 to respond unpredictably.  

Spell Check

There are several places in TEMPO 5 to type free form text: e-mail messages, contact 
descriptions, or notes. Use the Spell Check tool to correct spelling errors. It 
functions like most spell checker tools found in other applications.

To use the Spell Check tool:

1. Click the Spell Check button  located next to a text field. 

Click the [+] icon to 
expand the button bar.
Click the [-] icon to 
collapse the button bar.

Examples of 
Back buttons in 
TEMPO 5.
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The following Progress message appears. 

2. If spelling errors are detected, the Spell Check dialog box displays the text in red 
font and offers possible suggestions. 

3. Use the buttons to perform further tasks:
• Ignore — click to leave this instance of the word “as is.”
• Ignore All — click to leave all instances of the same word “as is.”
• Change — highlight a suggested correction in the list box, then click this 

button to replace this instance of the word.
• Change All — highlight a suggested correction in the list box, then click this 

button to replace all instances of the word.
• Preferences — click to display the Spell Check Preferences dialog box. 

Specify the following spell checking options: Ignore words in ALL 
CAPITALS or Ignore words with digits in them. Currently English is the 
only language available.

• Undo — click to revert back to the original spelling of one or more words 
you changed.

4. Click Done to close the dialog box.
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Personalizing Settings for the Way You Work

With TEMPO 5, you can customize a wide range of program settings, including your 
contact information, favorite reports, e-mail preferences, default search templates, 
Home page resource links and more.

To access Preferences and Settings:

1. From the main menu bar, click My Tools > Preferences. 
The My Preferences & Settings page opens.

2. Click the desired item in the left navigation panel. 

The corresponding page opens.

Updating Your Contact Information

Your personal contact information is stored within TEMPO 5 and is used throughout 
the program. For example, your information is automatically inserted into the header 
or footer of many listing reports, and your e-mail signature is automatically inserted at 
the end of your e-mail messages.

To access and change your contact information:

1. In the My Preferences & Settings navigation panel, click Contact information 
(it should be selected by default).

The selected page is 
highlighted in the 
navigation panel.
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The Contact Information page opens. 

2. Make the necessary changes or additions to your contact information using the 
fields provided.

3. Click Save. 
Note: Changes made to your contact information on this page will NOT 
update your membership data maintained by your MLS.

My Photos

Use this area to select and load various Agent-related images into a library that you 
can use in custom reports and communications. From Agent Photo to CMA 
letterhead pictures, TEMPO 5 has a list of image frames to use.

NOTE! Images should be in .JPG or .BMP format.

To add an Agent type image:

1. In the My Preferences & Settings navigation panel, click My Photos.
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The My Photos page opens to a series of frames. 

2. Click an image frame that describes the type of image you want to add. 
For example, Agent Partner 1, Agent CMA Image, Agent CMA Letterhead, etc.
Note: Use the scroll bar to display the rest of the frames.

A blue outline appears around the selected frame.
3. Click the Add New Image link inside the frame.

The Edit Image dialog box opens.
4. Type the name of the image file in the File Name text box; or click the Browse 

button to navigate and select the image file you want to add, and click Open. 
A preview of the image is displayed in the frame.

NOTE! If you can’t see the image, you may need to add the Web site’s URL to the 
Trusted sites zone in Internet Explorer. Click the Can’t see the image? link 
provided and follow the on-screen instructions.

5. Change the image size by dragging the Zoom slider; or by clicking the Zoom in 
[ ] button to enlarge the image, or by clicking the Zoom out [ ] button to 
reduce the image.

6. Click Save.

To edit an Agent type image:

1. In the My Photos page, click the Edit link inside an image frame.
The Edit Image dialog box opens.

2. Make the necessary modifications. Follow steps 4 and 5 of the adding an image 
procedure. See “To add an Agent type image:” on page 35.

3. Click Save.

To permanently delete an Agent type image:

1. In the My Photos page, click the Delete link inside the frame of the unwanted 
image.
A message box appears, prompting you to confirm the deletion.

2. Click OK.
The image is deleted from TEM PO  5, but NOT from your computer.
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Prospect Defaults

Use this area to specify the default settings for the client gateway, auto-notifications, 
prospect and agent notifications. See “Modifying Search & Notification Settings” on 
page 94See: “Modifying Search & Notification Settings”.

To specify your prospecting defaults:

1. In the My Preferences & Settings navigation panel, click Prospect Defaults.
The Prospect Defaults page opens. 

2. In the Client Gateway Settings section:
• determine if you want to use the client gateway for prospects by clicking 

either the Yes or No option button. If yes, all listings will be displayed in a 
personalized and branded web site. If no, a link to the listings report will be 
sent via e-mail.

• type a personalized message in the Default Client Gateway Home Page 
Greeting text box.

3. In the Auto-Notification Settings section, specify the following:
• Use Auto-Notification — select either the Yes or No option.
• Auto-Notification Expiration — enter the number of days (up to a 

maximum of 180) in which e-mail auto-notification will expire. After this 
time, no more e-mail notifications will be sent.
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• Auto-Notification Frequency — select how often you want the notification 
e-mails to be sent: ASAP, Daily, Monthly, or Never. Daily and monthly 
frequencies have Repeat sub-options. If you select Never, searches will still 
run, but no notifications will be sent.

• Resend notification email when — select one or both check boxes: List 
price changes, Photo added. An email notification will be resent upon the 
selected conditions being met.

• Save history of email notification — select either the Yes or No option.
• Allow Reverse Prospecting — select either the Yes or No option. See 

“Reverse Prospecting” on page 109.
Note: Allow Reverse Prospecting options are displayed only if the 
feature is enabled at the site level.

4. In the Prospect Notifications section specify the following:
• Send Prospect Notifications to — select the Contact’s email address(es) 

check box to enable this feature. Add additional e-mail addresses in the CC 
and/or BCC fields.

• Notification Subject — type a subject line for the e-mail notification. The 
contact’s name and date will be appended to the subject line automatically.

• Notification Text — modify the e-mail text message, using the toolbar to 
apply text attributes, such as bolding or italics. Do not remove the [Listing 
URL] merge code, as it will provide the contact with the necessary link to the 
listings.

5. In the Agent Notifications section, specify if you want to send an Agent 
notification and to which e-mail address by clicking one or both of the check 
boxes:
• My Primary E-mail Address
• My Pager or Cell Phone E-mail Address

6. Click Save.

Website Management

Use this area to manage the web sites that are currently available. You can add, edit or 
delete available system, broker or agent web sites. For more information, see “Creating 
a New Website” on page 238See: “Creating a New Website”.

To view the websites currently available:

1. In the My Preferences & Settings navigation panel, click Website 
Management.
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The Website Management page opens. 

2. From this page, you can do the following: 
• click directly on a link in the Domain column, or select the check box then 

click the Edit icon. The Agent Website Configuration page opens, letting you 
manage the site. See “Configuring an Agent or Broker Website” on page 241.

• select one or more links by clicking in the check box, then click the Delete 
icon. 

• click the New icon. See “Creating a New Website” on page 238See: “Creating a 
New Website”.

3. Click Close.

Setting E-mail Preferences

Use this page to enter your e-mail defaults, such as a pager or cellular phone e-mail 
address, e-mail signature and whether or not you want a copy of all e-mails sent to 
your e-mail address.

To specify your e-mail defaults:

1. In the My Preferences & Settings navigation panel, click E-mail Preferences.

Here is a list of 
the sites currently 
available to you.
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The E-mail Preferences page opens. 

2. Complete the following:
• Pager/cellular e-mail — enter your device’s e-mail address.
• Send me a copy — select the check box if you want to send a copy of all e-

mails to your e-mail address.
• Signature — enter a signature to be automatically appended to your outgoing 

e-mail messages.
• use the toolbar icons to apply attributes to the text.

3. Click Save. 

Client Gateway

Use the built-in features and controls in TEMPO 5 to easily set up and manage the 
appearance and content of your client gateways. A client gateway, used in conjunction 
with your own vanity domain, presents an opportunity to reach your target prospects. 
Using the client gateway, prospects can access properties that interest them, e-mail 
you, and check your Web site. See “Setting Up Branding Preferences” on page 258.

To specify branding content on your client gateway:

1. In the My Preferences & Settings navigation panel, click Client Gateway.

Use the 
toolbar buttons 
to apply text 
attributes and 
more.
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The Client Gateway page opens. 

NOTE! The clock icon indicates that any changes made to your Web site may take up 
to one hour before taking effect.

2. Select the check boxes of the name and contact elements you want included, such 
as My Photo, My Email, Company Logo, etc. 
Note: If a field has not been completed on the Contact Information 
page, the information is not available for inclusion on the Client Gateway. 
For example, My Fax is unavailable because no fax number has been 
specified on the Contact Information page.

3. Select the Logo at top check box to display your logo at the top of each Client 
Gateway page.

4. Select the Show “View My Listings” link check box to enable your prospects to 
view your current listings inventory on the Client Gateway.

5. Select the Show Listing Addresses check box to display the street addresses of 
listings in the client gateway and to enable them to view listings on a map.

6. Enter a title for your Client Gateway site in the Site Title text box.
7. Click Save.
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To preview the Client Gateway settings:

1. Click the drop-down list (just under the clock symbol) and select the name of a 
prospect. .You can toggle how the client list is sorted (by first or last name) by 

clicking the resort name button [  ].

The Web site opens in a new browser window
2. Check to see how the links work and how the page will appear to a client.

Changing Personal Defaults

The Personal Defaults page lets you change a number of default settings. Choose a 
start-up page other than Home to display when you log in. Change the default search 
template, grid layout and view settings for each search type in a group (or database of 
information). Set up a default search type for the Listing Manager. 

To access the personal default settings:

1. In the My Preferences & Settings navigation panel, click, Personal Defaults.

Choosing a Start-Up Page

While most people prefer to begin at the Home page, you have the option of going 
directly to one of several other pages when you log in to TEMPO 5. For example, you 
may prefer to go to the main Search Criteria page when you launch the program.

To change your start-up page:

1. In the Start Menu section of the Personal Defaults page, click the drop-down 
menu and select the option that you want to appear when you first log in to 
TEMPO 5. 

2. Click Save. 
You will now automatically go to this selected page every time you log in.
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Choosing an Image View

You can select the type of image you want to see by default: Slideshow or Photo 
Gallery. See “Viewing Images and Virtual Tours” on page 79.

To change the default image view:

1. In the Image View section of the Personal Defaults page, click the drop-down 
list and choose an option. 

2. Click Save.

Choosing a Listing Manager Search Type Default

You can designate one of the available search types to be the default whenever you 
open Listing Manager. For example, you may want the Residential grid to load when 
you open the Listing Manager. 

To change the default search type for Listing Manager:

1. In the Search Default Settings section of the Personal Defaults page, select a 
search group from the drop-down list. 

For example, a search group can be the MLS database or the Tax database. 
Each search group contains multiple search types, which will be available in the 
second drop-down list.

2. Click the Search Type drop-down arrow and choose the search type you want as 
the default. For example, select Residential/Condo. 

3. Select the Load this search type whenever I access the listing manager check 
box. 
The text tells you which search type is currently selected as your default.

4. Click Save.

Personalizing the Search Grid Defaults

TEMPO 5 has a number of System grids and reports that are used to display 
information whenever you perform a specific type of search. However, you can 
design your own Personal search templates and use them as the default grid views for 
each of the various search types. See “Searching” on page 63.
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Note: The names of the current System default reports applied to the 
various search types is displayed in the System Default list.

To select Personal search templates for a Search Type:

1. In the Personal Selections section of the Personal Defaults page, click the drop-
down arrow for each of the search type(s) you want to change. 

2. Choose the saved search grid or report layout you want loaded when you display a 
search results grid. It can be a standard System report or a Personal report you 
designed. 

3. Click Save to apply the changes.
• click Reset to restore all of the system defaults for all search types in the 

group.
4. Choose a different Search Type and specify your Personal Selections from each 

of the drop-down lists. 
5. When you have finished choosing your personal selections, click Save to apply the 

changes.

Example:

For a Residential Search Type, a few of the System Defaults are:
Saved Search — RES Simple Search
Results Grid — RES Standard Grid
Short Summary View — 18 SFR Multiple-Row

To change the templates that are used in these search instances, click each of the 
drop-down arrows and choose another template. It may look like this:

Saved Search — RES Standard Search.
Results Grid — My Modified Standard Grid
Short Summary View — SFR Multi-Row with MAP
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Personalizing Home Page Resource Links

TEMPO 5 lets you set up links on your Home page so you can quickly access your 
favorite Web sites. See “My Sidebar” on page 8.

To add a new resource link to the Home page:

1. In the My Preferences & Settings navigation bar, click My Links. 
The My Links page opens.  

NOTE! Initially, the category list will be empty.

2. To add a new category name to the list, type in the Category Name field, then 
click Save. 
The new name appears in the list.

3. To add links to a specific category, highlight the category in the list.
NOTE! Categories allow you to organize your links into groups on the Home page. 

For example, you might create one category for business-related links, and 
another for personal links.

4. In the Resource Link section, enter the descriptive text you want to appear on 
the Home page in a blank Description field. 

5. Complete the URL field (Web site address) using the example for proper format 
(including http:// or https://).
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6. Click Test Link to the right of the new link. 
A new browser window opens, launching the Web site. If this does not happen, 
check to make sure that the URL is correct.

7. Click Save to apply your changes.
8. Return to the Home page and view your new resource links from My Sidebar. 

• click the category name to expand the section and show the individual links 
that it contains.

To modify an existing resource link on the Home page:

1. In the Select a category list on the My Links page, click the name you want to 
modify.
It appears in the Category Name field.

2. Type over the existing name, replacing it with a new name, then click Save.
The new name appears in the category list.

3. Follow steps 4 through 7 above. 
4. Return to the Home page and view your new resource links from My Sidebar. 

• click the category name to expand the section and show the individual links 
that it contains.

To hide a resource link from the Home page:

1. From the Select a category list on the My Links page, click the name you want to 
remove.
It appears in the Category Name field.

2. Delete the text in the Category Name field, leaving it blank.
Note: You do not have to remove the corresponding Web addresses. 
You may want to restore the category to the Home page at a later date.

A message box appears asking if you want to hide the category.
3. Click OK.

The Category Name field shows [Hidden].

Choosing Your Favorite Reports

To make it easy to quickly view your favorite reports on the Listing Detail page, as 
quick links, TEMPO 5 lets you maintain a list of the reports you use most often. 
A different list of favorite reports can be set up for each property type. 
See “Working with the Report Manager” on page 176.

To set up a list of your favorite reports:

1. In the My Preferences & Settings navigation bar, click Edit Favorites. 
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The Favorite Reports page opens.  

2. In the Property Type drop-down list, choose a property type for which you want 
to create a list of favorite reports.
All available reports for the selected property type are displayed in the list.

3. Select up to six reports from the Available reports list.
• to select multiple items in the list, hold down the CTRL key and click.

4. Click the right arrow [>] button to move your selected reports to the Favorite 
reports list.
• to remove a favorite report, select the unwanted report from the Favorite 

reports list and click the left [<] arrow button.
5. Click the up and down arrow buttons to re-order the items in the list.

Note: The order of the reports determines the order in which they will 
be displayed on the Listing Detail page.

6. Repeat steps 3 through 5 for each property type.
7. Click Save.

Your favorite reports will be highlighted in yellow to distinguish them from 
other reports in the list.

Entering an E-mail Disclaimer

Use this text box to enter a disclaimer message that will appear at the bottom of all 
e-mails sent from TEMPO 5 by users in your office.

To set up an E-mail disclaimer:

1. From the My Preferences & Settings page side bar, click E-mail Disclaimer. 
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The E-mail Disclaimer page opens. 

2. Type up to 255 characters in the text box.
3. Click the Spell Check icon (located in the upper right corner of the page) to 

check the spelling. See “Spell Check” on page 30.
4. Click Save.

Click here to use the 
Spell Checker.
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Working with the Contact Manager List

The Contact Manager is a powerful tool for working with contact records. When you 
open the Contact Manager, a list of all records currently in your database is displayed. 
Each column gives you an overview of contact details which you can sort, reorder, 
filter and print. Select one or more records in the list then use the action buttons to 
perform a task.

To display the Contact Manager:

• From the TEMPO 5 main menu, click Prospects > Contact Manager.
The Contact Manager page opens.  

To change the Contact Manager list view:

1. From the Contact Manager page, you can change the list view by:
• clicking on a row to see an expanded preview of the contact’s details.
• clicking a column header to sort the list in ascending or descending order. 

See “Viewing, Sorting and Filtering” on page 22.
2. Click the Display drop-down list and select a specific type, for example all Buyer 

records. The list of records is narrowed by applying this simple filter. 
See “Viewing, Sorting and Filtering” on page 22.

3. Using the mouse, point to the Information icon of a record to display the Quick 
Access menu commands: Edit, E-mail, Print or Delete.

4. Select one or more records, then: 
• click an action button: New Contact, Import, Export, E-mail, Print.

Filter the list. 

Use the 
Advanced Search 
feature.

The Action buttons 
let you perform 
functions to 
selected contact 
records.
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• click the Delete Selected button in the footer bar.
5. Click the Print button to print the list of records (as seen on the page).

Note: To print the actual record details, select Print from the Contact 
Record page. See “Printing Contact Information” on page 266.

6. Click New Contact to add a new contact record. See “Adding a New Contact” on 
page 58.

7. To search for a contact, type the first name, last name, or e-mail address in the 
field located in the top right corner. Click the Search button. See ““Searching the 
Contact List” on page 51”.

8. To view a record in more detail, click the name, which is a hyperlink, to open the 
record. See “Viewing Contact Record Details” on page 60.

Searching the Contact List

The Contact Manager page provides a quick and convenient ways to search for 
contacts. 

To perform a quick search by name, in whole or in part:

1. From the Contact Manager page, type in the Search by field:
• the first name and/or last name of the contact you want to find; or 
• the first letter of the contact’s name; or

NOTE! You can also search by entering the contact’s email address or ID#.

2. Click the Search button.
The Contact list displays only those records that match the criteria; or those 
contacts whose first or last name begins with the letter of the alphabet you 
entered.

To display all contacts: 

• Click the Show All button, which appears adjacent to the Search button once 
you’ve performed a search. 

The Contact list displays all records.

NOTE! To perform a more advanced search for Contacts, see “Creating More Advanced 
Search Queries” on page 68”.
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Editing Contact Information

You can edit only one record at a time from either the Contact Manager list page or 
from within the contact record itself.

To edit a contact record:

1. From the Contact Manager page, select a contact record you want to edit. 
2. Using the mouse, point to the Information icon and select Edit from the Quick 

Access menu. 
The Edit Client Information [Client name] pop-up window opens. 

3. Make the necessary changes using the same fields as described in another section. 
See “Adding a New Contact” on page 58.

4. Click Save. 
The contact record is updated.
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Sending E-mail to Contacts

You can send an e-mail message to any number of contacts and members. 

To send an E-mail to a single contact:

1. From the Contact Manager page, select one contact from the list.
2. Using the mouse, point to the Information icon and select E-mail from the 

Quick Access menu.
The Send E-Mail dialog opens. 

3. Complete the To, Cc, and Bcc fields as necessary. 
Note: The To field will already contain the email address of the selected 
recipient. The From field shows the sender’s name.

• click the hyperlink on the right side to select additional recipients to receive 
this e-mail.

Note: If you have multiple recipients in the To field, you cannot use the 
Cc and Bcc fields.

4. Select the Send me a copy of this e-mail check box to receive a copy of this e-
mail.

5. Type a Subject line.
6. In the Message box, type a message, then click the SpellCheck icon to check for 

errors. 
7. Use the E-mail rich text editor to add attributes to the text. See “Sending E-mail” on 

page 130.
8. Click Send. 
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To send an E-mail to multiple contacts:

1. From the Contact Manager page, select multiple contacts in the list.
2. Click the E-mail action button, located in the lower right corner of the page. 

The Send E-mail dialog opens showing the e-mail addresses of the selected 
contacts, separated by semi-colons.

3. Follow steps #3 - 8 above. 
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Printing Contact Information

The Print feature lets you print contact information in a variety of different formats, 
from contact lists to custom-designed reports and mailing labels. 

To print a contact list:

1. From the Contact Manager page: 
• using the mouse, point to the Information icon and choose Print from the 

Quick Access menu; or 
• select one or more contact records from the list and click the Print Action 

button in the bottom right corner of the page.
The Print dialog opens. 

2. From the top section of the Print dialog, select one of the options: Single Client, 
Selected Clients, or All Clients.

3. Select the type of printout you want, for example Clients Grid, Reports or 
Labels.
The corresponding print options, based on the selections in step #3, are 
displayed. 

4. Choose the print options, and click Preview, Save as PDF or Print.
Note: The Print feature is described in another section. See “Printing 
Contact Information” on page 266. 
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Deleting Contact Records

Select one or more unwanted contact records to delete from the database. Any CMAs 
associated with a contact, will also be deleted.

NOTE! TEMPO 5 does not have a “Recycling Bin.” Deleted records are gone for good.

To permanently delete a single contact record:

1. From the Contact Manager page, select one contact from the list. 
2. Using the mouse, point to the Information icon and select Delete from the 

Quick Access menu. 
A message box prompts you to confirm the deletion. Take note of the 
information you are about to lose, such as saved searches and CMAs associated 
to the contact.

3. Click OK.
The contact record and all related information is deleted.

To delete multiple contact records:

1. From the Contact Manager page, select multiple contacts in the list.
2. Click the Delete Selected button from the footer bar. 

A message box prompts you to confirm the deletions. Take note of the 
information you are about to lose.

3. Click OK.
The contact records and all related information are deleted.

To delete an open Contact record:

1. From the Contact Manager page, click a contact’s name hyperlink to display the 
record details. See “Viewing Contact Record Details” on page 60.

2. From the Contact Info tab, click the Delete Contact Action button.
A message box prompts you to confirm the deletion. Take note of the 
information you are about to lose, such as CMAs associated to the contact and 
saved searches.

3. Click OK.
The contact record and all related information is deleted. You are returned to 
the Contact Manager list page.
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Importing and Exporting Contact Information

You can enter contact information manually, but you can also import contact 
information directly from other sources, such as Microsoft Outlook or Top 
Producer®. 

To import contact information:

• From the Contact Manager page, click the Import Action button.
The Client Import page opens. 

Note: This feature is described in another section. See “Importing Client 
Information” on page 328.

To export client information:

• From the Contact Manager page, click the Export Action button.
The Client Data Export page opens. 

Note: This feature is described in another section. See “Exporting Data 
from TEMPO 5” on page 330.
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Adding a New Contact

You can add a new contact record to the database from the Contact Manager or 
directly from the Prospects menu.

To add a new contact record:

1. From the Contact Manager page, click the New Contact Action button; or from 
the main menu, click Prospects > New Contact. 
The Add a New Contact pop-up window opens.
Note: You will need to scroll down to complete the entire record. 

2. In the Contact Information section, enter all known information, including:
• First name/Last name — these are required fields.

NOTE! Required fields are marked with an asterisk (*) and must be completed. 
The field label appears in ‘red’ until completed, then it changes to ‘black’.

• Mailing label — enter the first line of text for a mailing label, if different 
from the first and last name.

• Status — click this drop-down list and select a category, such as New or 
Active. This field is used to categorize and sort your clients.

• Contact Type — click this drop-down list to assign up to eight different 
contact types to a client record. This field is used to categorize and sort your 
contacts.

TIP ... Press TAB to 
move quickly to the 
next field. 

You can label these 2 
fields to whatever you 
want.
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• Use the two fields with editable labels, Other Phone 1 and Other Phone 2, 
to store custom information, such as additional phone numbers, Web 
addresses, etc. 

NOTE! You will need to scroll down, as there are many more fields available that are 
not shown in the screen shot.

3. In the Summary Comments section, enter free-form text, then click the 
SpellCheck icon to find any potential spelling errors. 

4. In the Home/Work/Other Address sections, enter all the address information 
for the contact. Click the This is their mailing address option button to 
indicate which of the multiple addresses should receive mail.

5. In the Tracking Information section, enter:
• Lead source/Source name — click the drop-down list and select the source 

of the lead, then type the source’s name in the text box.
• Contact ID — assign an identification number by which you can track this 

client.
• Notes — click Add a Note to prefix your comments with a date/time stamp. 

Enter free-form text, then click the SpellCheck icon to find any potential 
spelling errors.

6. In the Contact’s Preferences section, enter:
• property information including price range, number of bedrooms, number of 

bathrooms, square footage, what they are interested in and MLS number.
7. In the Contact’s Personal Information section:

• enter birthday information, children’s names, anniversary dates. 
Note: The date fields all have a pop-up calendar window, from which 
you can quickly select a day, month, and year.

8. Click Save. 
The contact’s name now appears in the Contact Manager list.
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Viewing Contact Record Details

The contact record provides a consolidated view of a selected client’s contact 
information, search and e-mail history, CMAs, property lists, private searches, 
netsheets and client gateway information. 

To see a preview of a client’s contact information only:

• From the Contact Manager page, click a record item in the list. 
The line item opens to display a brief summary of contact information, such as 
address, phone numbers, e-mail addresses, etc. 

To view a client’s detailed information:

1. From the Contact Manager page, click a client’s name (hyperlink) in the list.
The contact record (with the client’s name displayed) page opens. 

2. Click a tab for the type of information you want to access: Contact Info, 
Searches, Saved Listings, E-mail History, CMAs, Netsheets, or Client 
Gateway.
Note: The Contact Info tab is selected by default.

3. Click the Back to Contact Manager button, located in the top right corner, to 
return to the Contact Manager list.
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Contact Info

Click the Contact Info tab to see detailed client information, such as phone numbers, 
addresses, tracking information, preferences, etc. From the Contact Info tab, the 
following Action buttons are available: 
• Save Changes — See “Editing Contact Information” on page 52.
• Delete Contact — Click this button to delete the contact record, along with all 

associated searches and CMAs. See “Deleting Contact Records” on page 56.
• E-mail — See “Sending E-mail to Contacts” on page 53.
• Print — See “Printing Contact Information” on page 266.

Searches

The Searches tab displays a list of all prospecting searches associated with the 
contact. See “Working with the Prospect Manager” on page 87.
You can see a summary of information for each saved search, such as search name 
and description, auto-notification expiry date, etc. From the Searches tab, the 
following buttons are available: 
• Check All — Located on the footer bar, click this button to select all items in the 

list. The button changes to Uncheck All, which lets you clear all check boxes.
• Delete Search — Located on the footer bar, click this button after selecting one 

or more unwanted searches in the list.
• Add New Search — See “Using the Search Criteria Page” on page 68.
• View Search Results — See “Working with the Search Results Page” on page 75.
• Edit Search Criteria — See “Using the Search Criteria Page” on page 68.
• Search And Notification Settings — See “Using the Search Criteria Page” on 

page 68.

Saved Listings

The Saved Listings tab displays a list of property searches attached to this client and 
rated according to interest. Filter the list by clicking the Show Group drop-down list 
and choosing a designated category: All, Favorite, Recommend, Possibility or 
Reject.
From the Comments column, the following links are available:
• add new — if the listing does not have any comments associated with it, click 

here to add a new note. See “Property Notes and Ratings” on page 91.
• view/edit — if the listing has an existing comment associated with it, click here 

to view or modify the saved note. See “Property Notes and Ratings” on page 91.
The following buttons are available: 
• Check All — Located on the footer bar, click this button to select all items in the 

list. The button changes to Uncheck All, which lets you clear all check boxes.
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• Delete Selected — Located on the footer bar, click this button after selecting 
one or more unwanted items in the list. 

• View Details — See “Viewing Listing Details” on page 78.

E-mail History

Click the E-mail History tab to see a list of all outgoing e-mails associated with the 
contact. Click the Subject link of an item to read the e-mail message details. 
The following buttons are available:
• Check All — Located on the footer bar, click this button to select all emails in 

the list. The button changes to Uncheck All, which lets you clear all check boxes.
• Delete Selected — Located on the footer bar, click this button after selecting 

one or more unwanted items in the list. See “Deleting E-mail” on page 133.
• Compose E-mail — See “Sending E-mail” on page 130.

Note: Auto-notification e-mails are automatically deleted after 60 days.

CMAs

The CMAs tab displays a list of the contact’s saved CMAs. The summary information 
includes CMA name and property type, number of comparables, modification and 
purge dates. From the CMAs tab, the following buttons are available:
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Simple Searches from the Home Page

The Search function can be as simple or advanced as you like. If you know a little bit 
of information about a listing property or a contact, you can quickly search for and 
find the record directly from the Home page.
To conduct a more detailed search, click the Search for a listing link, or use the 
Search menu. See “Using the Search Criteria Page” on page 68.

Finding a Listing

Use the Find a Listing section of the Home page to quickly search for a property 
listing by using the Address, in whole or in part, or the ML number. 

To find a listing by Address:

1. Under Find a Listing, click the Lookup by Address option button.
Three address fields are available.

2. In the Street# field, type the address number only. If you have a partial address, 
enter the digits you know.

3. In the Street Name field, type the name, in full or part.
Note: Do not type Street, Avenue, etc.

4. If there is an apartment or unit number to the address, type it in the Unit# field.
5. Select the Show On Market listings only check box to search the available 

properties only.

6. Click the Go button [ ].
The Search Results page opens, displaying the matches, if any.

To find a listing by ML number:

1. Under Find a Listing, click the ML# option button. 

2. In the Lookup by field, type the entire ML number. 
Note: Partial ML numbers are not accepted.

3. If you are entering multiple ML numbers, separate them with commas.

4. Click the Go button [ ].
The Search Results page opens, displaying a list of matches, if any. 

Perform a quick 
search from this 
section of the Home 
page.
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Property Type Searches

There are several pre-defined property type searches available from the Search menu 
that let you query property information based on the specified system fields. You can 
add additional fields to the search form template to customize it, but then you must 
save it with a different name. See “Saving a Prospect Search” on page 99. 

Quick Search for a Listing

If you need to perform a quick search for a listing using criteria other than the 
Address or ML number, click:
• the Search for a listing link on the Home page; or
• Search, then click the property type from the main menu.
The Search Criteria page opens letting you search for listings based on multiple search 
criteria. See “Using the Search Criteria Page” on page 68.

MLS Number Search

The MLS Number Search is similar to the Find a Listing by ML# search on the 
Home page, except that you can add more fields to the search form or select a system 
defined search template. 

To search for an MLS Number:

1. From the Search menu, click MLS Number Search.
The ML# search template opens. 

2. Type the entire ML # in the field.
• to add more fields to the search criteria, click the Add Fields button in the 

Footer bar. See “Adding More Search Criteria Fields” on page 70. Or select the 
ML# Search template from the Search drop-down list. 

3. Click the Search button.
Note: To use a different search template, click the Search drop-down list 
and select from: All Property Search, Listing Maintenance Search, ML# 
Search, Multi-Address Search, Price Change Search or Price Variance 
Search.

Click the Search drop-
down list and select 
from five available 
templates.
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History Search

By performing a History Search, you can see the historic records of listing changes for 
one or more properties. Searches may include status or price changes, and whether or 
not the property was previously listed. TEMPO 5 saves the “before and after” values 
for each record, including the changed field, the date and time of modification, the 
date the change becomes effective and the User ID of the person who made the 
change.

To search for a property history:

1. From the Search menu, click History Search.
The History Search template opens displaying pre-selected fields. 

2. Complete the search fields as required. See “Using the Search Criteria Page” on 
page 68.

3. When you have entered all your search criteria, click the: 
• Search Results tab; or Search button [ ] in the Action bar to see a list of 

matching records. See “Working with the Search Results Page” on page 75.
• Save Search button [ ] in the Action bar to save the settings. 

See “Saving a Search” on page 73.

Open House Search

The Open House search lets you locate active (or cancelled) open houses for a 
specified area and time-frame. If you select a property with multiple open houses, a 
single record of the listing will be displayed. 

To search for open houses:

1. From the Search menu, click Open House Search.
The Open House search template opens. 

2. Complete the search form with your Open House search criteria (e.g., Area, Open 
House Date, etc.) See “Using the Search Criteria Page” on page 68.
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Note: Now you can select open houses by using the search by map 
function. See “Using the Search Map Page” on page 74.

3. When you have entered all your search criteria, click the: 
• Search Results tab; or Search button [ ] in the Action bar to see a list of 

matching records. See “Working with the Search Results Page” on page 75.
• Download button [ ] in the Action bar to export the search results. 

See “Exporting Listings Data” on page 332.
• Save Search button [ ] in the Action bar to save the settings. 

See “Saving a Search” on page 73.
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Creating More Advanced Search Queries

The Search feature enables you to construct more complex search queries using 
Boolean field operators and multiple search criteria on a template, which you can save 
and re-use. Depending on the type of information you want to find, search for:

• contact records
• property types
• prospects
• listings and comparables
• tax information (where available)
• hotsheets
• offices and members

Using the Search Criteria Page

Whether you want to perform a Quick Search, or a more complex search, you will do 
so by specifying search criteria and field operators to build a query using the Search 
Criteria page. You can then save, edit and re-use copies of search templates.

Note: A template is comprised of the individual fields into which you 
enter search criteria.

To access the Search Criteria page:

• From the Home page, click the Search for a listing link. 

TIP ... Boolean 
operators include: 
AND, OR, NOT, 
etc.
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The Search Criteria page opens.

To create a more advanced listing search:

1. From the Search Form, you can select the search type: 
• click the Property Type drop-down list and choose a listing search (for 

example, Residential/Condo, All Property Types etc.).
• select a Search template from the drop-down list. The templates can be 

found within several categories (for example, System Searches, Office 
Searches, or My Searches, etc.).

The corresponding search form opens. 
2. Enter your criteria in the search template fields. For information on using pick 

lists, short codes and long descriptions, and other controls, see “Field Related 
Controls” on page 19. 

3. Click the Count button in the Current Criteria section to display the number of 
listings that currently match, based on your criteria (which are also listed). 

Click here to show or hide the field operators: 
Between, Equals, Not Equal, Contains, etc., 
known as the advanced search options.

There are 2 
search tabs: 
Search Form 
and Search 
Map.

TIP ... When 
entering criteria, 
move quickly 
through the fields 
by using the TAB 
key. 
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Note: If the number of matches is very large, you might want to further 
narrow the search before retrieving records.

4. To add more fields to the search template, click the Add button [ ] to expand 
the Additional fields section, located in the sidebar; or click the Add Fields 
button in the Footer bar. See “Adding More Search Criteria Fields” on page 70.

5. To manage the fields on the Search Form, highlight a field in the list, then use the 
Footer bar buttons to add, remove, move up or down, and clear. 

6. To add or change the search operators for one or more fields, click the Advanced 
Options button. 
• the field operator drop-down lists are displayed, letting you choose different 

operators. See “Show/Hide Advanced Search Options” on page 71.
7. If you plan on using this search again, click the Save Search button in the bottom 

right corner. See “Saving a Search” on page 73.
8. To graphically define the search area, click the Search Map tab. See “Using the 

Search Map Page” on page 74.
9. When you have entered all your search criteria, click the following: 

• Search Results tab; or Search button [ ] in the Action bar to see a list of 
matching records. See “Working with the Search Results Page” on page 75.

• Statistics button to generate and print a statistics report.
• Map Results button [ ] in the Action bar to see a list of matching 

records and a map. See “Viewing a Map of Listing Search Results” on page 223.
• Download button [ ] in the Action bar to export the search results. 

See “Exporting Listings Data” on page 332.

Adding More Search Criteria Fields

After you have selected a search type and template, you may decide that the query 
requires more fields than currently displayed. You can add additional search criteria 
fields to the template.

To add more search criteria fields:

1. From the Search Criteria page, click the Add Fields button in the Footer bar; or 
click the Add button [ ] to expand the Additional Fields category in the 
sidebar.
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The Additional Fields section expands. 

2. Click the Category drop-down list and choose the category of new search 
criterion you want to add.
The list displays all fields within the selected category.

3. To quickly find a field name, type full or partial information in the Search for 
field box. 

4. Highlight the field you want to add to the search form, and then click the Add to 
Search button.

The new field is appended to the bottom of the Search Form.

Show/Hide Advanced Search Options

More advanced users can use the default search operators to construct more complex 
search arguments using Boolean logic. Boolean logic consists of a series of true or 
false connectors (operators) linking conditions or statements. 
There are three main Boolean operators: AND (which narrows a search), OR (which 
broadens a search), and NOT (which excludes from search).
There are plenty of resources available on Boolean logic. Try searching the Internet, 
which requires you to use some Boolean logic to enter your query!

To apply search operators to a field:

1. From the Search Criteria page, click Show Advanced Options in the Footer bar. 
A series of drop-down lists appear adjacent to the fields on the Search form, 
each with the applicable search operators for the search string you need to build.

NOTE! Depending on the nature of the field, the list may contain operators such as 
Equals, Not Equals, Equals Any, Equals All, Between, Minimum, Maximum, 
Contains, Starts With, Not Starting with, and Advanced.

2. Select the operator that corresponds to the type of search you want to construct. 
For example, to create a search for properties with two or three bedrooms, select 
the Between operator for the Beds field, then enter 2 and 3 in the adjacent data 
entry fields.
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3. To combine And/Or and Not arguments within a single field, select the 
Advanced operator from the drop-down list.
Note: Advanced operator is not available for all fields. Examples of 
where you can find it include the Building Information, Laundry, Building 
Utilities or Unit Parking fields.

The Advanced Search window opens. 

4. Highlight items in the Available Items list, then click the Right arrow button 
[ ] to move them to the And/Or/Must Not lists.
• for the And/Or list, select the option button above the list. 
• to remove all selections from the And/Or/Must Not lists, click Clear.

5. When you are satisfied with the Advanced Search operators, click OK.
You are returned to the Search Criteria page.

6. Click the Hide Advanced Options button in the footer bar to return to normal 
view.

NOTE! Changing a field’s operator from Advanced to something else will delete the 
field’s existing search criteria.

Search Example:

Imagine you have an older client who is looking for a secure community, but isn’t 
ready to move into an age-restricted retirement home. For this person, you could use 
the Advanced Search operator on the Community Features field to:
• add Gated Community and Guard Gate in the AND/OR list (using the OR 

operator); and 
• add Retirement Community and Age Restricted in the NOT list. 

Use the arrows to 
move selected items 
between lists.
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The resulting search would query for properties in a gated area that are not just for 
elderly or retired people.

Saving a Search

Once you have added search criteria to define a property type search, you can save the 
search settings to the currently defined search; or save the settings as a new custom 
search.

To save search settings:

1. From the Search Criteria page, after you have entered your search criteria, click 
the Save Search button.
The Search Settings page opens. 

2. Type a Search Name in the text box.
3. Type a Search Description in the text box.

NOTE! The Search Description is displayed publicly on the Client Gateway and Private 
Client View, so be sure the description is client-friendly.

4. From the Results Grid menu, select the search results grid that you would like to 
use with this search.

5. Click the Search Type drop-down list and select one of the categories, for 
example, Custom Search Only.

6. Click the Save button. 
You are returned to the Search Criteria page of the saved search. The search also 
appears on the Search Manager page. See “Working with the Search Manager” on 
page 83.
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Using the Search Map Page

As a matter of preference, you can graphically define the area you want to search by 
using a dynamic mapping system in conjunction with the Search Form. 

NOTE! If you try to specify an Area using both search criteria and the Map Area 
feature, no matching listings will be found unless the two areas overlap.

To perform a map search:

1. From the Search Criteria page, click the Property Type drop-down list and 
choose the kind of records to search for (for example, Residential/Condo, etc.).

2. Select a Search template from the drop-down list. This can be a System or a 
Personal template. 

3. Use the Search Form to enter essential search criteria, such as Area. 
See “Using the Search Criteria Page” on page 68.

4. Click the Search Map tab. 
5. Define a search area on the map using the drawing tools. Mapping instructions 

are described in another section. See “Mapping” on page 215.
NOTE! Notice the Current Criteria section on the side panel. It now displays the 

Longitude and Latitude values of the map location. If you want to go back to 
working with the criteria on the Search Form, be sure to clear any defining 
shape you drew on the Search Map tab.

6. Click the Show Listings button on the footer bar to display the property “push 
pins” on the map.

7. Click the Count button in the Current Criteria section to display the number of 
listings that currently match, based on your criteria (which are also listed).
If the number of matches is very large, you might want to further narrow the 
search before retrieving records.
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Working with the Search Results Page

The list of results on the Search Results page can be quickly and easily sorted, 
rearranged, and filtered to display the listing information in the manner that best suits 
your needs. You can also view the results with or without a map. 

NOTE! The List Price column displays price increase and decrease indicator icons. 
The List Price and Status columns both display color-coded values. 

Description Text Color

Price increase indigo
Price reduction violet
Active status green
Pending status orange
Expired status purple
Sold status red
Off market status blue

Click the Listing hyperlink to view the listing’s details. Click the Address hyperlink to open a 
map of the listing’s location.

A new Save Grid icon lets you save any changes you made to the grid.
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To view the Search Results:

1. From the Search Results page, you can change the grid view by:
• clicking a row to see an expanded preview of the listing details, including a 

thumbnail image of the property. 

• clicking the Photo button [ ] to launch the Image Viewer, with one or more 
snapshots of the property. See “Managing Images” on page 293.

• clicking a column header to sort the entire list in ascending or descending 
order. See “Viewing, Sorting and Filtering” on page 22.

• clicking the Multi-Field Sort button [+] to Sort by three levels of criteria as 
selected from the drop-down lists. See “Viewing, Sorting and Filtering” on page 22.

2. Click the Columns list and choose a layout grid; or click the Column Manager 
button [ ] to work directly with the Column Manager. See “Managing Column 
Reports” on page 318.

3. To display only those listings with a specified status, choose an item from the 
Status drop-down list, for example Active. 

4. To filter by list price, click the Price arrow to display the slider control. 

• click and drag the markers to change the upper and lower limits of the price 
range. 

The Search Results list automatically updates to only show listings that have a 
list price within the selected range.

5. Using the mouse, point to the Information icon to display the Quick Access 
menu commands: Report, Tax, Property History, Images, Map, Notes, Print, 
Email, Financial Calculators, and Charts. 
Note: The Quick Access menu commands may vary for your particular 
area and MLS setup.
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6. Select a record, then use the Footer bar buttons to narrow/restore the list, move 
the item up/down in the list, show/hide the search criteria used, or show/hide a 
map. 

7. Select one or more records, then click a button from the Action bar to perform 
further tasks: 
• Revise Search — takes you back to the Search Criteria page to re-define your 

criteria.
• Save Search — takes you to the Search Settings page to save the criteria to 

the current search template; or to name a new search. See “Saving a Search” on 
page 73.

• Map — select one or more properties in the list, then click this button to 
display a Map View page. See “Viewing a Map of Listing Search Results” on 
page 223.

• Driving Directions — click this button to plan your route to one or more 
selected properties. See “Creating Driving Directions” on page 225.

• Download — click this button to export one or more listings for use with 
another program, such as Excel. See “Exporting Listings Data” on page 332.

• CMA — click this button to create a new CMA presentation for a listing. 
See “Creating a New CMA” on page 152.

• Statistics — click this button to generate a printable report. See “Running 
Business & Statistical Reports” on page 193.

• Transfer Listings — click this button to transfer one or more selected 
listings to another listing or selling office.

• One-Line CMA — click this button to generate a quick grid report based on 
the results that you can print or e-mail.

• E-mail — click this button to send an e-mail to one or more properties. 
See “Sending E-mail” on page 130.

• Print — click this button to print the search results grid view, or more 
detailed reports. See “Printing Listing Search Results” on page 274.

8. To view the records in more detail, select one or more, then click the Details tab 
to retrieve the data.
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Viewing Listing Details

NOTE! If you want to view just one listing record, you can roll the mouse pointer over 
the listing’s Information icon on the Search Results page, and then click the 
Report button from the Quick Access menu. The listing appears in a pop-up 
window that you can keep open while you continue to work. From this window, 
you can view and Print a variety of detailed listing reports.

To view the listing details for one or more selected properties:

1. From the Search Results page, select one or more records you want to view. 
Note: To view all properties, do not select any.

2. Click the Details tab to display the listing property details. 

3. Click the Quick Link Button Bar for more options:
NOTE! The available quick links will differ according to your area and subscription to 

third-party providers.

• Listing — includes in-depth property information, description, agent-to-
agent remarks, financial and office information.

• Images — displays photos of the property.

Select a report format from the View 
list. Favorite reports are shown at the 
top and are highlighted yellow.

To view different property listings, 
select an item from the drop-down 
list or click the arrow buttons.

A new Select Stationery 
icon lets you add a theme to 
e-mailed or printed reports.
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• Virtual Tour/Links — displays virtual tours and third-party links for the 
property.

• Tax (if available in your area) — includes property tax information.
• Map — displays the property’s location on a map.
• Directions — generates driving directions to the property.
• History — includes property history reports.
• Attachments — lets you view any attachment files associated with the 

property.
• Calculators — opens the Payment Calculator so you can use the financial 

functions.
• Charts — generates a Market Area Activity chart.
• Report a Violation— lets you send an e-mail to MarketLinx if you need to 

report a data error.
4. To view the listings using different report formats, click the View drop-down list 

on the MLS Data page, then select a report format. 
Your favorite reports are shown at the top of the list and are highlighted in 
yellow. 
Note: To set up your favorite reports, see “Choosing Your Favorite Reports” on 
page 46.

5. To apply a stationery to your report, click the Select Stationery icon to display a 
list of available templates. See “Selecting a Stationery Style” on page 167.

6. To move through the different listings/pages, click the left and right arrow 
buttons at the top of the page. Alternatively, you can go directly to a particular 
listing or report page by selecting the property address from the drop-list in the 
top left corner of the page.

7. Click the E-mail button to send an e-mail to selected recipients about the 
selected properties. Choose how they will view the report: Within the client 
gateway or Independent of the client gateway. See “Enabling a Client Gateway” on 
page 101.

8. Click the Print button to send the report to the printer. See “Detailed Listing 
Reports” on page 275.

9. To return to the Search Results page, click Back to List. You can also click the 
Search Results, or even Search Criteria tabs to return to those pages. 

Viewing Images and Virtual Tours

The Image Viewer is a multi-faceted tool that enables you to view different image 
media, including an automated slideshow, a photo gallery view, virtual tours and 
attachment files. It can be accessed from any Search Results or Search Details page 
where there are attached images.



Searching

80 TEMPO 5 User Guide

To use the Image Viewer from a search results page:

1. Using your mouse, point to the Information icon to display the Quick Access 
menu.

2. Click on one of the following icons:
• Images — lets you access the Slideshow and Photo Gallery tabs.
• Links (Virtual Tours) — lets you access the Virtual Tour / Links tab.
• Attachments — lets you access the Attachments tab.
The Media Viewer pop-up window opens. 

NOTE! The number of tabs available in the Image Viewer depends on what files have 
been appended to the record. For example, if there are no virtual tour links, the 
tab will not be available. To add attachments, select the Edit icon from the 
Quick Access menu.

Viewing Slideshows

1. From the Image Viewer window, click the Slideshow tab. 
The page displays the pictures (slides) in the side pane, with the selected picture 
enlarged in the main frame.

2. Use the following controls:
• Previous/Next Image — click these buttons to scroll through each of the 

images, manually.
• Play Slideshow — click this button to scroll through all of the images 

automatically (as a slideshow). The button changes to Pause Slideshow.
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• Pause Slideshow — this button is only available once you have started 
playing the slideshow. Click the button to pause the slideshow.

Viewing the Photo Gallery

• From the Image Viewer, click the Photo Gallery tab. 
The page displays the photos in two columns with a descriptive label beneath 
each image. 

Viewing Virtual Tours

1. From the Image Viewer, click the Virtual Tour / Links tab.
A list of available URLs appears on the page. 

2. Click a link to launch a virtual tour (branded or non-branded) in a separate 
browser window.
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Viewing File Attachments

1. From the Image Viewer, click the Attachments tab.
A list of file attachments appears on the page. 

2. Click a link to open a file attachment.



Searching

TEMPO 5 User Guide 83

Working with the Search Manager

The Search Manager lets you easily manage the different kinds of searches you have 
set up (All Property Types, Member, Contact record, etc.) and filter them by their 
source (System, Office, Personal saved searches, etc.). You can also search for and re-
use a favorite search.

To access and use the Search Manager:

1. From the main menu, click Search, and then click Search Manager.
The Search Manager page opens. 

2. To sort the list of searches in ascending or descending order, click the column 
heading. See “Viewing, Sorting and Filtering” on page 22.

3. Click one of the drop-down lists to filter by: 
• Search Type — All, Member, All Property Types, History, Contact record 

etc.
• Source — All, My Searches, Office, Firm, MLS or System.
• Prospect — All, Prospect Searches or Non Prospect Searches.

4. To find a particular search, enter the name in full or in part, into the Search by 
search name field, then click Search. 
• click the Show All button to display all searches.

5. To load a specific search, click the search name (blue hyperlink) in the list.
Note: You can also select the search then click the Open Search button.

6. To perform a new search, click the New Search button.

Click the 
Search Name 
hyperlink to 
load the search 
criteria.
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A blank Search Criteria page opens. See “Using the Search Criteria Page” on page 68.
7. Select one search record, then click a button from the Action bar to perform 

more tasks: 
• Copy Search — takes you to the Search Settings page, where you can create a 

copy of the selected search so that you can modify and reuse it. See “Saving a 
Search” on page 73.

• Rename Search — takes you to the Search Settings page, where you can 
rename an existing search. See “Saving a Search” on page 73.

8. To delete one or more saved searches, select the unwanted items then click 
Delete Selected Searches in the footer bar.
Note: To print the actual property record details, select Print from the 
Search Results page. See “Printing Listing Search Results” on page 274.
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New Prospecting Matches

Once you have set up a prospecting search for a client using specific criteria, you can 
link this search to their client record for up-to-date monitoring. Additionally, you can 
set up the auto-notification feature to automatically check for new, or changed listings 
that match the prospect’s search criteria. When listings match, the number of new 
listings is displayed on the Home page under Matches. 

To see new prospecting matches:

1. From the Prospecting section of the Home page, any new matches such as a 
listing change or the addition of a property image, will show up in the counter. 

NOTE! To have the notifications go directly to the Matches section of the Home page, 
don’t select the e-mail options when setting Auto notification. See “Modifying 
Search & Notification Settings” on page 94.

2. Click directly on a link to open the Prospect Manager.

Click here to see all the searches that 
expire in 14 days.
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Working with the Prospect Manager

The Prospect Manager lets you easily view and manage the different kinds of searches 
you have set up (Prospecting and Non-Prospecting), and filter them by their source 
(System, Office, Personal saved searches, etc.). You can also modify the criteria and 
auto-notification settings for an existing search query.

To access and use the Prospect Manager:

1. From the main menu, click Prospects, and then click Prospect Manager; or 
click one of the links in the Matches section on the Home page.
The Prospect Manager page opens. 

2. Click the Display drop-down list and choose which searches you want to display: 
All Searches, Auto-Notification On, Searches expiring in 14 days, or Auto-
Notification Off. See “Viewing, Sorting and Filtering” on page 22.

3. To find a particular search, enter (in full or in part) the first or last name, e-mail 
address or ID# in the field, in the top right corner, then click the Search button.
• click the Show All button to display all searches.

4. To sort the list of searches in ascending or descending order, click the column 
heading. See “Viewing, Sorting and Filtering” on page 22.

5. Click any of the blue hyperlinks in the list (such as Prospect Name or Search 
Name) to retrieve the related data. For example, click the prospect’s name to 
open the client record.
• click the e-mail icon to send a message to the prospect. See “Sending E-mail” on 

page 130.

Click the 
Prospect Name 
hyperlink to open 
the contact 
record.
Click the Search 
Name hyperlink 
to load the search 
criteria.
Click the icon to 
open the Browser 
and view the 
Personalized 
Real Estate Site 
for the client.
Check the Last 
Gateway Access 
column for the 
date and time of 
the most recent 
web site access.
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• hover the mouse over the phone icon to view the prospect’s phone number.
• click the Notes, Fav, Pos, Rej or Rec column hyperlink (highlighted in 

yellow) to open the Saved Listings tab of the contact record. See “Viewing 
Contact Record Details” on page 60.

• click the [ ] icon in the last column to preview the personalized real estate 
site for the prospect. See “Client Gateway” on page 257.

• check the Last Gateway Access column to see the date and time the client 
gateway was accessed by the prospect. 

6. To set up a new prospect type search, click the New Prospect button from the 
Action bar. 
The Prospect Wizard opens. See “Creating a New Prospect Search” on page 98.

7. Select a search record, then click a button from the Action bar to perform more 
tasks:
• View Search Results — retrieves and displays new matches for the saved 

search. See “Saving a Prospect Search” on page 99.
• Edit Search Criteria — opens the Search Criteria page, letting you modify 

the search criteria. See “Editing Saved Search Criteria” on page 93.
• Search And Notification Settings — the Search Settings page opens, letting 

you save search settings and edit the auto-notification settings. See “Modifying 
Search & Notification Settings” on page 94.

8. To delete one or more saved searches, select the unwanted items then click 
Delete Selected Searches in the footer bar.
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Viewing Search Results

Use the selected search criteria to perform the search again to find new results. The 
list of results can be quickly and easily sorted, rearranged, and filtered to display the 
saved search information in the manner that best suits your needs. You can use the 
Column Manager to view the results in a different layout format. See “Column 
Manager” on page 317. 
The page and its options are very similar to the Search Results page arrived at through 
Search Manager. See “Working with the Search Results Page” on page 75.

To retrieve new search results from a saved search:

1. From the Prospect Manager page, select one or more check boxes of the searches 
you want to run.

2. Click the View Search Results button.
The Property Search [Search Name] page opens with the Search Results tab 
selected. 
Note: Any new matches that have occurred since the search was last 
run, are highlighted with a yellow ‘Newly Matched’ icon. 

3. If you selected multiple searches, use the Previous [ ] and Next [ ] buttons at 
the top of the page to scroll through each of the search results.

4. Click a blue hyperlink to view the details of the selected search.

The Newly Matched 
icon and bold type 
indicates new 
matches since that 
you have not yet 
marked as read.
To Mark as Viewed, 
select the item, then 
click the button in the 
footer bar.
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5. Select a search result in the list, then click one of the buttons on the footer bar: 
Move Up, Move Down, Recommend, Reject, Show Criteria, Mark as 
Viewed, Mark as New or Show Map. See “Viewing, Sorting and Filtering” on 
page 22.

6. Using the mouse, point to the Information icon and select a Quick Access 
menu item: 
• Report — displays a property listing report that you can print or save as a 

PDF. See “Printing Listing Search Results” on page 274.
• Tax — displays a public tax listing report that you can print or save as a PDF. 

See “Viewing Tax Details” on page 202.
• Property History — displays the Property History Report that you can print 

or save as a PDF.
• Images — opens the Image Viewer, letting you see property photos. 

See “Image Report” on page 297.
• Map — displays the selected property on a map that you can print. 

See “Viewing a Map of Listing Search Results” on page 223.
• Notes — displays the Note dialog box, letting you add or edit comments 

associated with the property. See “Property Notes and Ratings” on page 91.
• Edit — lets you view or edit the listing’s details. See “Listing Maintenance” on 

page 112.
• Print — lets you choose the print options for listing reports. See “Printing 

Listing Search Results” on page 274.
• E-mail — lets you choose the properties you want to e-mail. See “Sending E-

mail” on page 130.
• Financial Calculators — opens the Payment Calculator. See “Using the 

Payment Calculator” on page 209.
• Charts — displays the market area activity as a line chart, that you can cut and 

paste into another program, or print.
7. Select one or more search results in the list, then click one of the action buttons:

• Revise Search — returns you to the Search Criteria page to revise search 
criteria.

• Save Search — displays the Search Settings page so you can save the criteria. 
See “Modifying Search & Notification Settings” on page 94.

• Map — displays the search results on a map. See “Viewing a Map of Listing 
Search Results” on page 223.

• Driving Directions — lets you plot a map of directions to the properties. 
See “Creating Driving Directions” on page 225.

• Download — exports the listing data in a format that can be used by another 
application, such as Excel. See “Exporting Listings Data” on page 332.

• CMA — select a listing to begin a new CMA presentation. See “Creating a New 
CMA” on page 152.
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• Statistics — displays listings statistics in a format that you can print. 
• One-Line CMA — lets you create a simple one line grid report based on one 

or more of the selected properties. 
• E-mail — lets you e-mail a link to the selected properties; or add to the client 

gateway as an Agent recommendation. See “Sending E-mail” on page 130.
• Print — lets you print the selected listing reports. See“Printing Listing Search 

Results” on page 274.
8. Click the Back to Prospect Manager button in the Header bar.

Property Notes and Ratings

When you enter property notes for a listing, keep in mind the comments are for your 
prospect to read when they view a recommended property using the Client Gateway. 
The note is time and date stamped. You can also select a rating option, e.g. 
Recommend this listing.

To add a note from the property Search Results page:

1. Using the mouse, point to the Information icon of a selected listing to display 
the Quick Access menu.

2. Click the Notes [ ] button.
The Note web page dialog box opens. 

3. Type your comments in the bottom text box, then click Save.
The dialog closes and a flag icon appears in the grid to indicate there are notes 
associated with the listing. 

4. Click the Back to Prospect Manager link in the header bar, where you can view 
the comments by clicking the hypertext number (which shows the number of 
notes associated with the listing) in the Notes column. 

Change the 
property 
recommendation at 
any time by 
selecting another 
option button.

Click here to edit the 
text of a saved note.
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The Saved Listings tab of the contact record opens, displaying a list of the 
properties, their ratings and a view/edit link to the comments. See “Working 
with the Prospect Manager” on page 87.

To edit the text of a saved note:

1. From the Note dialog box, click the small up arrow and “edit text” label located 
between the two text fields. 
You can now modify the text of the saved comment.

2. Click Save.

To remove the ‘Newly Matched’ indicator:

1. Select one or more properties in the list.
2. From the footer bar, click the Mark as Viewed button. 

The bolding and the Newly Matched indicator are cleared.

To mark a property match as “New” again:

1. Select one or more properties in the list. 
2. From the footer bar, click the Mark as New button.

The Newly Matched indicator is displayed.
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Editing Saved Search Criteria

You can change the search criteria of a selected saved search directly from the 
Prospect Manager. 

To load the criteria of a selected saved search:

1. From the Prospect Manager, either:
• click directly on the Search Name blue hyperlink; or
• select a single search in the list and click the Edit Search Criteria button.
The Property Search [Search Name] page opens with the Search Criteria tab 
selected.

2. Make any changes to the search criteria fields. See “Using the Search Criteria Page” on 
page 68.

3. Click the Save Search button.
4. Click the Back To Prospect Manger button in the Header bar. 
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Modifying Search & Notification Settings

From the Prospect Manager page, select one prospecting search in the list to specify 
how the prospect is to be notified of new matching listings. You can save new, modify, 
or delete a prospecting search’s notification settings.

To view or modify search settings:

1. From the Prospect Manager page, select a prospecting search in the list.
2. Click the Search And Notification Settings button.

The Search Settings page opens for the selected search. 
3. Select one of the Save this search as options:

• Save changes to current search — click this default option to save any 
minor changes you may have made to the current settings. 

• Save as a new search — click this option to keep the original search intact, 
while saving the new search settings under a different name and Search 
Type.

Note: The Save Search function is usually performed from the Search 
Criteria and Search Results pages, but can be done from the Search 
Settings page. 

4. In the Search Name field:
• accept the current name or type a new one for a saved search;
• type a new name for a new search.

5. In the Search Description field:
• accept the current description or type a new one for a saved search;
• type a brief description for the new search’s client gateway (optional). 

6. From the Results Grid menu, select the search results grid that you would like to 
use with this search.

7. In the Search Type section: 
• the current search type setting is displayed for the existing saved search;
• click the drop-down list and choose one of the available search types for a 

new search (this is only possible when you are saving as a new search).
8. Click Save. 
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You are returned to the Prospect Manager. 
Note: Click the Search And Notification Settings button again to make 
further changes, or to specify the auto-notification settings for the 
selected search.

9. Proceed to the Auto-Notifications Settings section, where you can define the 
frequency, duration and trigger events for sending e-mail notifications.

To view or modify auto-notification settings:

1. In the Auto-Notification Settings section of the Search Settings page, select the 
following options:
• Activate this Search— click Yes to use auto-notification.

2. In the Auto-Notification Expiration section, enter the number of days (up to a 
maximum of 180) in which e-mail auto-notification will expire. After this time, no 
more e-mail notifications will be sent.

3. In the Auto-Notification Frequency section, select how often you want the 
notification e-mails to be sent:
• ASAP — sends a separate e-mail notification as soon as a new or changed 

listing matches the saved search criteria.
• Daily — sends a single, combined notification e-mail on the day(s) of the 

week you specify by checking one or more of the check boxes. 
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• Monthly — sends a single, combined notification e-mail on the 1st of the 
month and/or the 15th of the month, depending on the check boxes selected. 

• Never — searches will run, but no notifications will be sent.
4. In the Resend notification e-mail when section, select one or both check 

box(es):
• List price changes — the notification is sent again, should the list price 

change.
• Photo added — the notification is sent again, but only once, should pictures 

be added.
5. In the Allow Reverse Prospecting section, select Yes or No. See “Reverse 

Prospecting” on page 109.
6. Proceed to the Prospect Notifications section, where you can set automatic e-

mail notifications to the prospect associated with the selected saved search. 

To view or edit prospect notification settings:

1. In the Prospect Notifications section of the Search Settings page, select the 
Send Prospect Notification To check box to send an e-mail to the prospect’s 
primary e-mail address (displayed by default). 

• use the CC or BCC fields to copy or blind copy other recipients on the e-mail 
notifications. Enter their e-mail addresses in the fields.

2. In the Notification Subject field, either accept the default ‘Notification’ subject 
line or type your own.
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Note: The contact’s name and e-mail date will be added to the subject 
line automatically.

3. In the Notification Text section, use the default text message ‘as is’ or apply text 
attributes by using the toolbar. 
Note: Do not delete the [Listing URL] merge code from the body of the 
message or else recipients will not be able to view the new property 
listing matches.

4. Click one of the links: 
• Edit my default text — displays the Notification Message pop-up dialog 

where you can change the text of the message that is sent with each e-mail. 
• Restore to my default text — click this link to revert back to the original 

notification message.
5. If the prospect does not have a client gateway set up, the Send listing report(s) 

drop-down list becomes available. Select a report from the list.
Note: If the prospect has a client gateway set up, you cannot send a 
listing report. Instead, the client gateway will be used. See “Enabling a 
Client Gateway” on page 101.

6. In the Save history of e-mail notifications section, click the Yes option to save 
a copy of the e-mail notification in the prospect’s E-mail History. See “Viewing 
Contact Record Details” on page 60.

7. Proceed to the Agent Notifications section, where you can select a report and 
send a copy of the notifications to the agent’s primary e-mail or cell phone 
address. 

To view or edit agent notification settings:

1. In the Agent Notifications section of the Search Settings page, select the select 
the My Primary email address check box if you want to receive a copy of the 
notification via e-mail. 

2. Click the Use the listing report drop-down list box to select the name of a 
report.

3. Select the My Pager or Cell Phone E-Mail Address check box if you want to 
receive notification by way of your e-mail enabled pager or cell phone.
• click the Change link to modify the displayed e-mail address.

4. Click Save.
You are returned to the Prospect Manager page.
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Creating a New Prospect Search

The Prospect Wizard guides you with easy step-by-step on-screen instructions on 
how to create one of five types of prospecting searches. Use the Select Prospect 
Search Type page to select one of the prospecting search type options. 

To access the New Prospect Search Wizard:

1. From the main menu, click Prospects, and then click New Prospect Wizard.
The Select Prospect Search Type page opens. 

2. Select one of the option buttons:
• Prospect Search - attach to new Contact — create a new contact record, 

associate search criteria to it, and set up auto notifications of listing matches. 
See “Attaching to a New Contact” on page 99.

• Prospect Search - attach to an existing Contact — associate search criteria 
to an existing contact record and set up auto notifications of listing matches. 
See “Attaching to an Existing Contact” on page 105.

• Farming Search — set up multiple contacts to receive auto notification 
updates for a single saved search. See “Farming Search” on page 106.

• Personal Search with Auto Notification — set up a search for which only 
you will receive auto notifications when matching properties are listed. 
See “Personal Search with Auto-Notification” on page 107.

• Contact only — create a new contact record, but do not associate any search 
criteria to it at this time. See “Contact Only” on page 108.

Depending on the option you selected, the next logical page opens. You can see 
the number of steps involved with each search type by looking at the Prospect 
Wizard navigation bar.

TIP ... You can also 
open the Prospect 
Wizard from the 
Prospect Manager 
page by clicking 
the New Prospect 
button.
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Attaching to a New Contact

If you selected the Prospect Wizard’s first option, you will be guided through the six 
steps of creating a new contact record, saving the prospect search and attaching it to a 
new contact, enabling the client gateway, setting up notifications, reviewing the 
matching listings and sending them to the prospect via email. 

To attach a prospect search to a new contact:

1. From the Select Prospect Search Type page, select the Prospect Search - attach 
to a new Contact option.

2. Click Next Step.
The Contact Info page opens. 

3. Enter client information in the Contact Information, Summary Comments, 
Home/Work/Other Address, Tracking Information, Contact’s Preferences 
and Contact’s Personal Information sections. See “Adding a New Contact” on 
page 58.
Note: Be sure to complete all required fields (red text). It’s a good idea 
to enter an e-mail address to take advantage of e-mail features.

4. Click Next Step.

Saving a Prospect Search

When you have defined a search query to your liking and are satisfied with the results, 
you’ll want to re-use it by associating the search to a prospect, either existing or new. 
You can select an existing search and rename it, or define a new search.
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To attach an existing search to the prospect:

1. From the Save Prospect Search page, click the Property Type drop-down list and 
select a search type, for example, Residential/Condo. 

2. Click the Search drop-down list and select an existing saved search. 
NOTE! If you select a saved search that has auto-notification enabled (listed under the 

Prospect Searches: Auto-Notification On or Off categories), you will be 
prompted to rename the search. 

NOTE! If there are no saved searches under the category you want, it means the list is 
empty and you’ll have to create a new search.

3. Click the Edit/Preview button if you want to modify the search criteria, prior to 
renaming the selected search. See “Using the Search Criteria Page” on page 68.

4. Type a new name in the Search Name text box. 
5. Type a short description in the Search Description text box. that will be 

displayed on the client gateway. 
6. Click Next Step.

To attach a new search to the prospect:

1. From the Save Prospect Search page, click the Property Type drop-down list and 
select a search type, for example, Residential/Condo.

2. Click the Create New Search button to build a new search query to associate 
with your new contact. See “Searching” on page 63.
• enter search criteria, perform a preliminary Count on the Search Criteria page 

and click Save; or
• click the Search Results tab to retrieve the matching listings, select the 

records you want and click Save.
The Save Prospect Search page re-opens. 

3. Enter a Search Name and Search Description for the new search.
4. Click Next Step.
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Enabling a Client Gateway

The client gateway lets you establish a personalized, branded web site where the 
prospect can view recommended listings, make notes, and more. 

To set up a client gateway for the prospect:

1. From the Enable Client Gateway page, the Yes option is selected by default.  

NOTE! If you have attached a new search, the system assumes automatically that a 
Client Gateway is being used. 

2. Type a Client Gateway Home page Greeting in the text box.
3. Click Next Step.

To send a Listing report via e-mail:

1. From the Enable Client Gateway page, click the No option.
2. Click Next Step.

The Set Up Notifications page opens, with the No option selected by default.
3. Click Finish.

You are returned to the Prospect Manager page.

Setting Up Notifications

The Set Up Notifications page lets you specify how to notify the prospect of new 
matching listings. You can also modify notifications directly from the Prospect 
Manager page. See “Modifying Search & Notification Settings” on page 94.

To set up Auto-Notification settings for the prospect:

1. From the Set Up Notifications page, complete the sections:
NOTE! The option buttons in the Use Auto-Notification section will not be available. 

Since you have enabled the Client Gateway, the Yes option is pre-selected.

• Auto-Notifications Settings — follow the instructions as described in “To 
view or modify auto-notification settings:” on page 95.

• Prospect Notifications — follow the instructions as described in “To view or 
edit prospect notification settings:” on page 96.

NOTE! Since the prospect has a client gateway set up, you cannot send a listing report. 
Instead, the client gateway will be used. 

The greeting 
will appear on 
the web site’s 
Home page.
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• Save history of e-mail notifications — section, click the Yes option to save 
a copy of the e-mail notification in the prospect’s E-mail History. 

• Agent Notifications — follow the instructions as described in “To view or edit 
agent notification settings:” on page 97. 

2. Click Next Step.

Reviewing Listings

The Select Listings to Send Now page lets you review the listings that currently match 
the prospect’s search criteria and select those you Recommend, while filtering out 
those you Reject. When the prospect runs this search on the web site, they will see 
your recommended properties. Or, you can choose to allow the auto-notifications to 
send only new or updated listings to the prospect at a later time. See “Sending E-mail” 
on page 130.

To send selected listings to the prospect:

1. From the Select Listings to Send Now page, click the review these listings now 
link. 
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The Search Results pop-up window opens with the newly match listings. 
See “Working with the Search Results Page” on page 75.

2. Select only those listings you want to send to the prospect, then click the 
Recommend button on the footer bar.

The red flag [ ] icon appears in the row of recommended listings.
Note: Be sure to clear the check boxes for the Recommended listings 
prior to selecting listings you want to tag as Reject. Otherwise, all 
selected listings, including the Recommended ones, will be tagged as 
Reject.

3. To filter out those listings you don’t want your prospect to see, select them in the 
list, then click the Reject button.

The frowning face [ ] icon appears in the row of rejected listings.
4. Click OK.

You are returned to the Select Listings to Send Now page. The total number of 
listings recommended (and rejected) is reflected in the new total. 

5. Click Next Step.
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Sending Listings Now

The Send E-mail page opens when the selected prospect has a valid e-mail address 
entered in the Contact record and you have chosen to send matching listings. 

To send an e-mail to the prospect:

1. The Send E-mail page should have the relevant fields already completed. Make 
any changes as required. See “Sending E-mail” on page 130.
• to add more recipients, click the link to the right of the To/CC/Bcc fields. 
• select/clear the Send me a copy of this email check box to enable/disable 

this option. 
2. Click the Finish button.

The e-mail is automatically sent and the Email Confirmation page opens. 

3. Click the View email link to read the message.
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4. Click the Print button to print a copy of the confirmation.
5. Click Close.

You are returned to the Prospect Manager.

Attaching to an Existing Contact

If you selected the Prospect Wizard’s second option, you will be guided through the 
five steps of saving the prospect search and attaching it to an existing contact, 
enabling the client gateway, setting up notifications, reviewing the matching listings 
and sending them to the prospect via email. 

To attach a prospect search to an existing contact:

1. From the Select Prospect Search Type page, select the Prospect Search - attach 
to an existing Contact option. The Select a Contact drop-down list opens. You 
can toggle how the client list is sorted (by first or last name) by clicking the resort 

name button [  ].

2. Click an existing client name.
3. Click Next Step.

The Save Prospect Search page opens.
4. The remaining steps are the same as for attaching a prospect search to a new 

contact. See:
• “Saving a Prospect Search” on page 99.
• “Enabling a Client Gateway” on page 101.
• “Setting Up Notifications” on page 101.
• “Reviewing Listings” on page 102.
• “Sending Listings Now” on page 104.
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Farming Search

If you selected the Prospect Wizard’s third option, you will be guided through the 
four steps of saving the prospect search and attaching it to a multiple contacts, setting 
up notification updates, reviewing the matching listings and sending them to the 
prospects via email. 

To create a new farming search:

1. From the Select Prospect Search Type page, select the Farming Search option. 
2. Click Next Step.

The Save Prospect Search page opens.
3. Select an existing saved search and rename it; or create a new search. See “Saving a 

Prospect Search” on page 99.
4. Click Next Step.

The Set Up Notifications page opens. 
5. Set up new auto-notification settings, or edit the existing settings inherited from a 

saved search. See “Setting Up Notifications” on page 101.
• Notification Subject — this field in the Prospect Notifications section 

cannot be left blank.
• Modify recipients list — click this link and select multiple recipients to 

receive this e-mail.
NOTE! There must be at least one recipient specified to whom notifications will be 

sent.

6. Click Next Step.
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The Select Listings to Send Now page opens. 

7. Select the Send [x] selected listings to this prospect opion button.
• click the Review/select listings to send link. View the search results, select 

the check boxes of the listings you want to send, then click the Send Selected 
Listings to Prospect button. 

Note: If you select the Don’t send any listings now option, auto-
notifications sent to the prospect later will include only those properties 
that have been listed or updated. Click Finish.

8. Click Next Step.
The Send E-mail page opens. 

9. Add more contacts to the e-mail recipients list, if you want, choose whether or 
not to send a copy of this e-mail to yourself, and append text to the e-mail 
message area. See “Sending Listings Now” on page 104.

10. Click Finish.
The E-mail Confirmation page opens, letting you view or print the e-mail 
message.

Personal Search with Auto-Notification

If you selected the Prospect Wizard’s fourth option, you will be guided through the 
two steps of setting up a prospect search for which only you will be sent auto-
notifications when matching properties are listed. 

To create a personal search with auto-notification to yourself:

1. From the Select Prospect Search Type page, select the Personal Search w/ Auto 
Notification option. 
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2. Click Next Step. 
The Save Prospect Search page opens.

3. Select an existing saved search and rename it; or create a new search. See “Saving a 
Prospect Search” on page 99.

4. Click Next Step.
The Set Up Notifications page opens. 

5. Choose whether or not to set up and use Agent-only Auto-Notification. If Yes, 
include:
• Notification Subject — this field in the Prospect Notifications section 

cannot be left blank.
• My Primary E-mail Address — select this check box to include, then click 

the drop-down list and choose a report format.
• My Pager or Cell Phone E-mail Address — select this check box to 

include, then click the Change link if you need to modify this address.
See “Setting Up Notifications” on page 101.

6. Click Finish.

Contact Only

If you selected this option, you will create a new contact record only, without 
associating any search criteria to it at this time. See “Adding a New Contact” on page 58. 
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Reverse Prospecting

Reverse prospecting lets you match all current active and pending market listings (for 
which you are the listing agent or co-list agent) to active prospects, who are set up to 
allow reverse prospecting. The Allow Reverse Prospecting option can be selected 
when you are setting the Auto-Notification Settings for a saved search. 
See “Setting Up Notifications” on page 101.

To search for active prospects for your current listings:

1. From the Prospects menu, click Reverse Prospecting.
My Current Listings page opens displaying the number of listings. 

2. Select the check box for a listing to reverse prospect.
3. Click the View Matching Prospects button.

The Reverse Prospecting page opens, displaying a list of all prospect searches. 

Note: The prospects listed on this page are active prospects who have 
the Allow Reverse Prospecting option enabled. See “Modifying Search & 
Notification Settings” on page 94.

4. Select a prospect in the list then click one of the action buttons:
• E-mail — lets you send an e-mail to the agent associated to the selected 

record.
• Print — lets you preview, save as PDF or print the search results grid list.

5. Click Back to Listings to return to the My Current Listings page.

Click a link to view 
Agent information.
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Listing Maintenance

The Listing Maintenance functionality in TEMPO 5 lets you search for a listing, add a 
new listing, and modify or delete existing listings from the MLS database. Features 
include the ability to automatically complete the listing information from public tax 
records, to graphically pinpoint a listing’s location on a map, and to save unfinished 
listings for later completion. Other tabs allow you to add and view prohibited words.

NOTE! Some or all components of Listing Maintenance may not be available to you. 
The procedure for loading listing information and images varies from area to 
area.

To access Listing Maintenance:

1. From the main menu, click My Tools > Staff Tools.
The Listing Manager link in the navigational sidebar is selected by default. 
The Listing Maintenance page opens displaying a list of any Incomplete Listings 
you may have been working on. See “Working with an Incomplete Listing” on 
page 114. 

2. To search for an existing listing that has been submitted:
• enter the listing’s ML number in the Find a listing by ML# field, then click 

the arrow [ ] button. 
• click the Search for listing button, perform a search and select the record. 

See “Using the Search Criteria Page” on page 68 and “Editing an Existing Listing” on 
page 119.

3. To add a new listing, click the Enter a new Listing button. See “Adding a New 
Listing” on page 114. 

Expanding Listing Form Fields

You can expand picklist fields and free form text fields that allow more than 50 
characters:
1. Press F7 or ALT+Down Arrow on your keyboard.

A counter shows you the number of incomplete listings.
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2. Click the field (or the screen next to the field) to expand it.

You can cancel the auto-expand feature by pressing F7 or ALT+Down Arrow again.
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Working with an Incomplete Listing

When adding a new listing, you can temporarily stop working on it and not lose any of 
the information. The next time you open the Listing Maintenance page, you’ll see a 
list of the Incomplete Listings.

To access an Incomplete Listing:

1. From the Listing Maintenance page, click a row. 
The Modify Incomplete Listing page opens. 
Note: The Modify Incomplete Listing page looks almost identical to the 
Add New Listing page. 

2. Complete the rest of the fields. See “Adding a New Listing” on page 114.
3. Click one of the action buttons to perform more tasks:

• Map Property — to manually locate the property address. See “Using the Map 
Property Feature” on page 117.

• Tax Autopop — to automatically search for and insert tax information. 
See “Using the Tax Auto-pop Feature” on page 118.

• Delete — deletes the record you are currently working on. A message box 
opens asking you to confirm the deletion. Click OK.

• Print — generates a selected listing report to send to the printer. 
See “Printing” on page 265.

4. When the listing is complete (all required fields are complete), click Submit. 

Adding a New Listing

You can add a new listing record to the MLS database. If you are working on an 
Incomplete Listing record, you can use these same instructions to complete the fields. 
Skip to step #5.

To enter a new listing record:

1. From the Listing Maintenance page, click the Enter a new Listing button.
The Add Record dialog box opens.

2. Click the Select Property Type drop-down list and choose from the available 
property types, for example Residential/Condo, Duplex, Land, etc. 

3. Click OK. 
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The Tax Autopop Selection pop-up window opens.

Note: The Tax Search feature may or may not be available in your area.

4. If you do not want to auto-populate the listing information form with tax 
information at this time, click Cancel to go immediately to the Adding a New 
Listing page. 

NOTE! You can use the Tax Autopop button at the bottom of the Add New Listing 
page. See “Using the Tax Auto-pop Feature” on page 118.

The Add New Listing page opens.

5. To change the display of information in the pick list fields, click the Option List 
Display drop-down list and select one of the options:
• Default — displays the default setting for all pick list fields on the page.
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• All as Short Code — changes all pick list fields on the page to display the 
information as a short code. 

• All as Long Description — changes all pick list fields on the page to display 
the information as a long description.

6. To display only specific fields, click the Edit Mode drop-down list, located in the 
top right corner and select a filter: All Input Fields, MLS Information, etc. 
See “Edit Mode Maintenance” on page 125.
Note: All of the red fields [ ] are required and must be completed in 
order to submit this form.

7. Enter as much information about the listing as you can. 
• press the TAB or ENTER key to move quickly from field to field.

8. Some free form text fields, such as Remarks, have a help icon [ ] that, when 
clicked, opens a dialog box with suggestions from the Board on what kinds of 
comments you should and should not enter in the field. For example, the field 
may be available for public usage and therefore, you should not enter any sensitive 
information such as security or alarm information.

9. To temporarily stop working on the listing (not posting it to the MLS), click the 
Save as Incomplete button. See “Working with an Incomplete Listing” on page 114.
• a message dialog opens telling you the listing has been saved for later. 

Click OK. You are returned to the Listing Maintenance page.
Note: TEMPO 5 saves the listing as you move from field to field, so even 
if you lose your Internet connection, your listing will be saved as a 
temporary listing and you’ll be able to complete it later.

10. Click one of the action buttons to perform more tasks:
• Map Property — manually places the location of the property. See “Using the 

Map Property Feature” on page 117.
• Tax Autopop — searches the public tax records and auto populates the fields 

with the listing’s tax record information. See “Using the Tax Auto-pop Feature” 
on page 118.

• Save as Incomplete — saves an unfinished record “as is” and lists it in the 
Incomplete Listings list on the main Listing Maintenance page. See 
“Working with an Incomplete Listing” on page 114.

• Print — generates a selected listing report to print. See “Printing” on page 265.
11. When the listing is complete (all required fields are complete), click Submit. 
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Using the Map Property Feature

If TEMPO 5 notifies you that it is unable to accurately locate the property address of 
the new listing, the Map Property pop-up window is opened automatically so you can 
pinpoint the location manually. Also, you can click the Map Property button.

To use the Map Property feature:

1. From the Map Property pop-up window, click the Automatically map this 
property link.

2. If you need to manually locate the property and know the Latitude and 
Longitude coordinates, enter the information in the fields. Otherwise:
• use the map view and zoom controls to locate the property, then click the 

map to place a property marker. The latitude and longitude values are 
automatically determined. See “Mapping” on page 215.

3. Select the Save current map center and zoom level as user default check box 
to save the map setting. 

4. Click Refresh map to verify the property location. 
5. Click OK to set the property location. 

You are notified when the listing has been successfully submitted to the MLS. 
It can now be searched for and seen by other MLS members.

Click here to 
change the 
zoom level.

Click here to save 
current map center 
and zoom level as 
user default.
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6. Click Print to send the map to the printer. See “Printing” on page 265.
7. Click OK. 

The Listing Summary page opens. 

Using the Tax Auto-pop Feature

If you did not use the tax autopop feature previously, but would like to now, click the 
Tax Autopop button from the Adding a New Listing page.

NOTE! Depending on the provider you choose, the remaining fields that you need to 
complete in the dialog box may vary.

To auto-populate the listing form with tax information:

1. Click the Tax Autopop button.
The Tax Autopop Selection dialog box opens. 

2. Click the Select Tax Provider drop-down list and choose the provider. In the 
case of a single provider, this drop-down list is not visible.

3. Click the Select Tax County drop-down list and choose the county. In the case 
of a single county, this drop-down list is not visible.

4. Choose one of the following search options: 
• Search by Tax ID — enter the tax ID number required to locate the tax 

record (to retrieve a match, the ID must be properly formatted).
• Use Tax Search to find the tax record — click OK to display the Tax 

Search Form. See “Public Records” on page 199.
The Tax Search Results page opens.

5. Select the appropriate tax record, then click OK. 
The fields of the Add New Listing page are completed using the selected tax 
record information.

In this example there 
is only one tax 
provider and one 
county available. 
Therefore, the Select 
Tax Provider and 
Select Tax County 
drop-down lists are not 
visible.
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Editing an Existing Listing

NOTE! If you are completing an Incomplete Listing record, see “Adding a New Listing” on 
page 114 or “Working with an Incomplete Listing” on page 114.

Once you have added a listing to the MLS database, you can search for that listing to 
edit, copy, delete, map or print the listing record. You can also add a new record from 
this page. 

To search the MLS for an existing listing to edit:

1. From the Listing Maintenance page: 
• enter the listing’s ML number in the Find a listing by ML# field, then click 

the arrow [ ] button. 
• click the Search for listing button, perform a search and select the record. 

Click the Edit Selected Listing button. See “Using the Search Criteria Page” on 
page 68 and “Editing an Existing Listing” on page 119. 

The Listing record opens.  

2. To view the listing’s information, click each of the subsections: Summary 
Report, Open Houses, etc.

3. Click the Links drop-down list and choose a third-party provider to work with on 
the selected property listing. For example, select Google, then click the arrow 
button to open an advanced Google Search on the property.

4. Click the Edit button to modify the property listing’s information at the field data 
level. Make changes to the listing accordingly. See “Adding a New Listing” on 
page 114.

5. Click Close.

Click the drop-
down list and 
select one of the 
available third-
party service 
providers to use 
with the selected 
listing.
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Copying a Listing

You can take a copy of an existing property listing and create a new record.

To copy an existing listing:

1. From the Listing Maintenance summary page, click Copy.
A message dialog opens prompting you to confirm that you want to create a 
new record by copying the selected record. 

2. Click OK to confirm. 
The Copy Listing page opens showing the copied listing’s property information.

3. Add the required listing information. See “Adding a New Listing” on page 114.
4. Click Submit. 

You are returned to the Listing Summary page.

Deleting a Listing

You can permanently delete an unwanted listing from the MLS database.

To delete a listing:

1. From the Listing Maintenance summary page, click Delete.
A message box appears prompting you to confirm the deletion.

2. Click OK.
A second message box opens, confirming the listing (by ML number) has been 
deleted successfully.

3. Click OK.
You are returned to the Listing Maintenance page.

Mapping a Listing

You can view the listing property on a map and print it.

To view the currently displayed listing on a map:

1. From the Listing Maintenance summary page, click Map. 
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The Map Property pop-up window opens with the listing’s location. 

2. You can view the listing in different ways on the map. See “Mapping” on page 215.
3. Click the Print button to send the map to the printer.
4. If you use the mouse to click elsewhere on the map, thereby changing the location 

you want to view, click OK to accept the new position as the default.
5. Click Close. 

Printing a Listing

You can preview and print one or more listing maintenance reports for the selected 
property.

To print a listing:

1. From the Listing Maintenance summary page, click Print.
The Print Options dialog box opens.

2. Choose the following options:
• Single Maintenance Listing — click the drop-down list to select a different 

listing than the one shown.
• All Maintenance Listings

3. Click a print option:
• Print report

• Print labels (may not be available for all listing results)
4. Select a report format from the list.
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• to select multiple reports, hold down the CTRL key and click.
5. Click Preview.

You can see how the report will look before you print it.
6. Click Save as PDF to save the report in Portable Document Format. See “Saving 

a Report as a PDF Document” on page 269.
7. Click Print.

A standard Windows Print dialog opens.
8. Choose any additional print options (e.g., number of copies, destination printer, 

etc.) then click OK. See “Printing Listing Search Results” on page 274.

Adding an Open House to a Listing

The Listing Maintenance module makes it easy to schedule upcoming open houses. 
Once added, other agents can search for and see the details of your open house(s).

To add an open house to a listing:

1. From the Listing Summary page, click Open Houses to expand the section.
2. Click the Add an Open House button.

The Add New Open House page opens, with the related fields highlighted.
3. Enter the Open House Type, Date, Time and Office Phone information.

Note: You can even indicate whether there will be refreshments served!

4. Click Submit.
The Listing Summary page opens, showing the scheduled open house in the 
Open Houses section.
Note: If you schedule an open house which you later have to cancel, you 
can edit the open house record and change the Status to Canceled; or 
you can just delete it.

Images

You can add, edit or change the order of images for property listings, as well as add 
descriptive text. See “Managing Images” on page 293.

To view the existing images for a selected listing:

1. From the Listing Summary page, click Images to expand the section. 
2. Click on an image frame to highlight it. 
3. Then do one of the following:

• click the Edit link to change the image, its name or descriptive comment. 
• click the Delete link to permanently delete the image from the listing.
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• click the Reorder Image arrows to change the selected image’s position in 
the row.

4. Click Save.

Uploading Listing Attachments

TEMPO 5 lets you upload files onto your computer and attach them to a specific 
listing. The size and types of files that can be uploaded are determined by MLS 
administrators.

NOTE! Listing attachments can be seen by all MLS users from the Detailed Report 
view, so be careful not to upload any confidential documents.

To upload a listing attachment:

1. From the Listing Summary page, click Attachments to expand the section.
2. Select Add New Attachment from the Action menu, then click the arrow 

button.
The Upload Document dialog box opens. 

3. Click the Browse button to select a file to attach to the listing.
A Choose File dialog box opens.

4. Navigate to and select the file you want to upload, then click Open.
5. Select the attachment Type from the drop-down list box.

NOTE! You can now attach valid movie file types (with extensions .mov, .wmv, .mpg, 
.mpeg, .avi, .mkv, .mlv, .mp2, .mp4, .mp2v, .mpa, .mpe).

6. Enter a Description in the field.
7. Your MLS may allow certain types of attachments to be viewed by non-members. 

If this is the case, you can make the attachment visible to the public by setting the 
Public Access property. Otherwise, this property is not editable.

8. Click Save.
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When the file is finished uploading, it will appear in the Attachments list on the 
Listing Summary page. You can edit or delete the attachment, if required.
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Edit Mode Maintenance

The Edit Mode Maintenance functionality in TEMPO 5 enables the user to manage 
the filters available from the Edit Mode drop-down list on the Add New Listing 
page. Each filter consists of specified fields and can be assigned exclusively to a 
particular Board, or be available to all users.

To access an existing Edit Mode filter:

1. In the Listing Manager section of the Tools page, click the Edit Mode 
Maintenance tab. 
The Edit Mode Maintenance page opens. 

2. Click the Sub Types drop-down list and choose a category.
The existing filters for the selected sub-type appear in the list box.

NOTE! The filters are listed in the Edit Mode drop-down list on the Listing 
Maintenance page.

3. Highlight a filter from the list, then click one of the action buttons:
• Modify — lets you select a Board ID and manage the fields included in the 

filter.
• Copy — lets you take a copy of an existing filter and rename it.
• Delete — lets you remove a filter from the category list.

To add a new Edit Mode filter:

1. From the Edit Mode Maintenance page, click the New button. 
2. In the Edit Mode Name text box, type a name.
3. Click the Board ID drop-down list and select a board’s ID only if you want to 

assign exclusive use to that board; otherwise, leave the field blank. 
4. From the Available items list, select one or more fields and click the right arrow 

to move them to the Selected items list.
• use the up/down arrows to arrange the field order you want.

5. Click OK.
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Prohibited Words

The Board can enter and maintain a list of prohibited words and phrases that comply 
with the Fair Housing Rules. The words or phrases can be flagged as a warning 
(which can be saved to the MLS); or as a stop-word (which cannot be saved to the 
MLS).

To enter a list of prohibited words:

1. In the Listing Manager section of the Tools page, click the Prohibited Words 
tab. 
The Prohibited Word page opens. 

2. Enter the words or phrases in the following text boxes:
• Warning Words or Phrases — these entries will receive a warning, and can 

be saved to the MLS database.
• Stop Words or Phrases — these entries will be stopped, and cannot be saved 

to the MLS database. 
3. You can click the Paste from Clipboard link to enter words in this fashion.
4. Click Save.
5. Select the Enable the Prohibited Word check check box to enable this feature.

To view all listings that contain the violations:

• In the Listing Manager section of the Tools page, click the View Prohibited 
Word Violations tab.
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Virtual Tour URL Tool

This tools lets MLS staff maintain a list of approved Virtual Tour sites. Enter each 
URL on a separate line (followed by a hard return, that is, press ENTER). Use the 
proper format http:// as all invalid domains cannot be saved.

To add an allowable Virtual Tour URL to the list:

1. From the Tools page sidebar, click Listing Manager, then click the Virtual 
Tour URL Tool tab.
The Virtual Tour URL page opens. 

2. On a new line at the bottom of the list, type the URL for a virtual tour tool, then 
press ENTER; or if you have cut or copied URL information to the clipboard, click 
the Paste from clipboard link to paste the information.
Note: When pasting from the clipboard for the first time during the 
session, you will be prompted by a dialog box to give access to your 
clipboard. Click the Allow Access button to proceed. Access only needs 
to be granted once. You can continue pasting (CTRL+V).

3. Select the Enable the Virtual Tour URL check option to ensure your URLs are 
entered correctly with the proper prefix (http://).
Note: An invalid URL cannot be saved. You will be prompted to correct 
the URL.

4. Click Save.
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Sending E-mail

You can send an e-mail message to any number of contacts and members from a 
Search Results page, the Contact Manager or directly from a Contact/Member 
Record. In addition, you can e-mail a link to the client gateway, so the contact can 
access your personalized web site to view listings.

To send an e-mail:

1. From a page within TEMPO 5, click the E-mail action button. 
The Send E-Mail page opens. 

2. Enter an e-mail address in the To, Cc, or Bcc fields. 
3. Click the [click here] link to the right of the address fields to select any additional 

recipients to whom you want to send the message. (Alternatively, you can simply 
type additional e-mail addresses in the appropriate field, separated by semi-
colons.) 

Use the toolbar to add 
attributes to your text.

Link to address book
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The Select Recipients page opens.

4. Choose the kind of e-mail address records you want to Search for: Clients or 
Members.

5. If you are looking for client addresses, you can quickly locate a client by typing 
their name in the field. 
• if you are looking for an MLS member, you must enter at least two letters of 

their first and last name, or office code, then click Find.
6. Select a contact from the list, then click either To, Cc, or Bcc to add them to the 

appropriate address field under Message Recipients. 
• to select multiple contacts, hold down the CTRL or SHIFT key while you click.

NOTE! Cc means “Carbon Copy” and Bcc means “Blind Carbon Copy.” When sending 
a single e-mail, a Bcc recipient is not visible to the main message recipient. 
However, you cannot use these fields when there are multiple addresses in the 
To field.

7. Click the Add new client button to enter a new client record to the database. 
See “Adding a New Contact” on page 58.

8. Click the Edit client button to modify an existing recipient’s client record. 
See “Editing Contact Information” on page 52.

9. Click OK to accept the Message Recipients and return to the Send E-mail page.
10. Select the Send me a copy of this e-mail check box to enable this feature.
11. Type the message’s Subject. 

Note: This is a required field, marked by an asterisk.

12. Type the body of the e-mail in the Message box. 
13. Use the E-mail Editor to apply text attributes to the message:

Click the drop-down list 
and specify Clients or 
Members as the types 
of recipients you want 
to search for.
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• Fonts — click the drop-down list and select one of the available font styles, 
for example Arial, Times New Roman, etc.

• Size — click the drop-down list and select the font size (in points), for 
example, 8pt, 10pt, 12 pt, etc.

• Font Color — click the down arrow to open the Color palette, letting you 
select a color to apply to selected text. Highlight the text you want to apply 
color to, then click the Font Color icon.

• Back Color — click the down arrow to open the Color palette, letting you 
select a color to apply to selected text as a background highlight. Highlight the 
text you want to highlight, then click the Back Color icon.

• Bold, Italic, Underline — highlight the text you want to format, then click 
the corresponding toolbar icon. 

• Numbered — place the cursor where you want to begin a numbered list (1, 
2, 3, etc), then click this icon.

• Bullet — place the cursor where you want to begin a bulleted list, then click 
this icon.

• Insert Line — place the cursor in the message, then click the icon to insert a 
line.

• Cut, Copy, Paste — highlight the text you want to cut or copy, then click the 
corresponding toolbar icon. Place the cursor in the message to insert text, 
then click the Paste toolbar icon.

• Undo, Redo — click one of the toolbar icons to undo an action or to redo an 
action. For example, if you cut a chunk of text from the message, then 
changed your mind, click the Undo toolbar icon to reverse the action. 

• Spell Check — click the Spell Check icon to search for spelling errors in the 
message.

NOTE! Disclaimer text may be added to the end of your e-mails. This text is 
maintained by your office manager and cannot be removed. See “Entering an E-
mail Disclaimer” on page 47.

14. Click Send. 
A message box notifies you when the e-mail has been successfully sent.

NOTE! To view, forward, or delete messages that you have sent, open the Contact 
Record and click the Email History tab.
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Sending E-mail from the Contact Manager

From the Contact Manager page, you can send an e-mail to a selected contact in the 
list; or you can select multiple contacts and send a mass e-mail to all of them. 
See “Sending E-mail to Contacts” on page 53.

To send a single e-mail:

1. From the Contact Manager page, select an e-mail recipient from the list. 
2. Using the mouse, point to the Information icon to display the Quick Access 

menu, and click E-mail.
The Send E-Mail page opens.

3. Follow the instructions in the previous topic. See “Sending E-mail” on page 130.

To send multiple e-mails:

1. From the Contact Manager page, select multiple e-mail recipients from the list. 
2. Click the Email Action button at the bottom of the page.

The Send E-Mail page opens with the clients’ e-mail addresses in the To field, 
separated by semi-colons.

3. Follow the instructions in the previous topic. See “Sending E-mail” on page 130.

Sending E-mail from an Open Contact Record

You can send an e-mail to a contact directly from their opened contact record. Click 
the Email button from the Contact Info tab, or click the Compose Email button 
from the Email History tab. In addition, you can view and forward previously sent 
e-mails from the Email History tab, send a CMA or Client Gateway link via e-mail 
from the corresponding tabs. See “Sending E-mail to Contacts” on page 53.

Deleting E-mail
When you delete an e-mail from TEMPO 5, you do so from the contact record. 

To delete e-mail messages from the contact record:

1. Click the Email History tab.
2. Select one or more messages in the list.
3. Click the Delete Selected button from the footer bar. 

A message dialog appears, prompting you to confirm the deletion.
4. Click OK to continue.
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E-mailing Listing Reports

When you send a listing report to a client via e-mail, you are actually sending a link to 
the live MLS listing information. This means that your clients will always be looking at 
the most current information available and can see any price or status changes 
immediately. 

To e-mail one or more listing reports:

1. From the Search Results page, select one or more property listings
2. Click the Email action button. 

Note: You can also e-mail a listing report while viewing the listing 
details. 

The E-mail Options dialog opens. 
3. Select the property listings you want to send: 

• Single Record — select a property from the drop-down list, which becomes 
available when this option is selected.

• Selected Records — choose this option if you have already selected the 
listings from the Search Results page. The number appended to the option 
tells you how many have been selected.

• All Visible Records — this option selects just those listings that are currently 
displayed on the Search Results page. You may have applied one or more 
filters to narrow the list, which could affect which listings are visible. The 
number appended to the option tells you how many listings are visible.

4. Select how the e-mail recipients will view the listing report when they receive it:
• Send link to selected property report(s) — click this option button, then 

select one or more reports from the list. The link to the specified reports is 
sent in the email message.

• Send link to Client Gateway

5. Click OK. 
The Send E-mail dialog opens. 

6. Follow steps # 3 - 10 in “Sending E-mail” on page 130.
NOTE! Do not delete the link in the message box. It is the link to the properties. You 

can move it, but do not delete it. Also note that disclaimer text may be added 
to the end of your e-mails. This text is maintained by your office manager and 
cannot be removed.

7. Click Send. 
You are notified when the e-mail message has been successfully sent.

NOTE! To view, forward, or delete messages that you have sent, open the Client 
Record and click E-mail History.
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E-Mailing CMAs

When you send a Buyer Presentation or Seller CMA to a client via e-mail, you are 
actually sending a link that your clients can open in a Browser. See “E-Mailing CMAs” 
on page 135.

To e-mail a CMA:

1. From the CMA Manager page, click an existing CMA to open it. 
The CMA Wizard opens. 

2. From within the CMA Report Wizard, click step #8 — View Report, to go to 
the last page. 

3. Click the E-mail button. 
The Send E-mail page opens. 

The e-mail is automatically addressed to the client that the CMA presentation is 
linked to.

NOTE! Cc means “Carbon Copy” and Bcc means “Blind Carbon Copy.” Bcc recipients 
are not visible to other message recipients.

4. Click the link to the right of the address fields to select e-mail addresses from your 
personal TEM PO  5 address book. 
• alternatively, you can simply type e-mail addresses in the appropriate field, 

separated by semi-colons. 
Your address book contains the e-mail addresses of any clients you have 
previously entered, plus e-mail addresses for other members of your MLS. 

Link to address book

Link to properties must 
appear in the message
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The Select Recipients dialog opens.
5. Choose the kind of e-mail address records you want to Search for: Clients or 

Members. See “Sending E-mail” on page 130.
6. Select the contacts in the list that you want to send the e-mail message to and click 

either To, Cc, or Bcc to add them to the appropriate address field. 
• select multiple contacts by holding down the CTRL or SHIFT key while you click.

7. Click OK. 
The selected contacts are added to the list of e-mail recipients. You are returned 
to the Send E-mail window.

8. Enter the Subject of the e-mail.
9. Make any changes to the Message that you want.

NOTE! Do not delete the line in the message box that begins with “http.” It is the link 
to the CMA. You can move it, but do not delete it.

10. Click Send. 
You are notified when the e-mail message has been successfully sent.

NOTE! To view, forward, or delete messages that you have sent, open the Contact 
Record and click the Email History tab. S



Hotsheets

Viewing Today’s Hotsheet Summary
Using the Hotsheet Search Criteria Page
Running a Hotsheet Search
Working with Hotsheet Results
Viewing Hotsheet Details



Hotsheets

138 TEMPO 5 User Guide

Viewing Today’s Hotsheet Summary

Hotsheets alert you to changes in the market, such as when a new property is listed, 
or when a listing’s price or status changes. You can see a quick summary of Today’s 
Hotsheet activity from the Home page, up to two days back. 

Using the Hotsheet Links

Each link displayed in the Hotsheet section of the Home page represents the 
number of matches (search results), based on your saved Hotsheet search criteria. 

To use the Hotsheet summary area of the Home page:

• Click the Day’s Back drop-down list and select 1 or 2 to see the changes to 
Hotsheet activity since yesterday or the day before.
Note: Zero (0) is today and is the default setting.

The number of matches is displayed.
• Click a link to go directly to a list of search results. For example, if you click MUL 

New Listings (45), TEMPO 5 loads the entire list of expired listings matching 
the last search criteria, so you can look at the details. See “Working with Hotsheet 
Results” on page 141.

• Click the Change my criteria link to modify the search criteria upon which the 
search results are based.

• Click Refresh at any time to update the Hotsheet search, whether you have 
changed the search criteria or just want to get the latest numbers.

The number of matches for each 
Hotsheet is listed. This summary is 
based on your saved Hotsheet 
criteria.
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Using the Hotsheet Search Criteria Page

Using the Hotsheet search function is similar to performing a regular search, but with 
fewer features. 

To access the Hotsheets Search Criteria page:

• Do one of the following: 
• from the main menu, click Hotsheets; or 
• from the Home page, click Change my criteria from the Hotsheet section.
The Hotsheet Search Criteria page opens. 

Running a Hotsheet Search

There are two ways to create Hotsheet reports; by specifying new search criteria or by 
loading previously saved search criteria.

To run a Hotsheet report search using previously saved criteria: 

1. From the Hotsheet Search Criteria page, click the Hotsheet drop-down list and 
choose a report type you want to work with:

Click the short Code link to switch to the long 
Desc of the criteria.
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• Daysback Hotsheet — tracks changes to the market from today up to 30 
days back. Click the Days Back drop-down list and select from 0 to 30.

• Personal Hotsheet — tracks changes to the market since the last time you 
ran this search. The date and time of the last time you ran this search is 
displayed.

• Previous Personal Hotsheet — this option only appears after you have 
done two personal hotsheet searches. It shows you the most recent previous 
personal hotsheet information. 

• Date Range — tracks changes to the market in the last 30 days. 
• Custom Search — tailor a more specific search, based on a specified 

Property Type (such as Residential, Business, Rental, etc.) and Search 
template. 

The corresponding Hot Sheet Search Criteria page opens, displaying the 
previously saved search criteria. Also, look to the sidebar to view the Current 
Criteria section (a summary of currently specified search criteria) and the Hot 
Sheet Matches section. 

2. Click the Search button or the Results tab to perform the search.
The Search Results page displays a grid of matching listings.

3. Proceed to “Working with Hotsheet Results” on page 141.

To run a Hotsheet report search using new search criteria:

1. From the Hotsheet Search Criteria page, click the Hotsheet drop-down list and 
choose a report type you want to work with.
The Hot Sheet Search Criteria page opens, displaying the previously saved 
search criteria.

2. Enter new or revised search criteria in the fields. For information on using pick 
lists, etc., see “Field Related Controls” on page 19.

3. Click the Search Map tab to perform a Hotsheet search using the mapping 
function. See “Searching by Map Area” on page 221.

4. Click the Count button.
The Hotsheet Matches section, located on the left side, displays the number of 
matching listings for each section.

5. Click the Save Search button to save the search criteria for reuse (not available 
for the Custom Search).

6. Click the Search button or the Results tab. 
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Working with Hotsheet Results

The Hotsheet Results page is similar to the Search Results page. You can perform 
many of the same actions, such as sending e-mail, generating a map view, and printing 
reports. You can also perform different actions, such as working with property 
history, accessing tax records, etc. 
The list of results on the Hotsheets Results page can be quickly and easily sorted, 
rearranged, and filtered to display the information in the manner that best suits your 
needs. See “Viewing, Sorting and Filtering” on page 22. 

To change the Hotsheet Search Results view:

1. From the Search Results page, you can change the list view by:
• clicking on a row to see an expanded preview of the listing details, including a 

thumbnail image of the property. Click the same row again to close.
• clicking a column header to sort the list in ascending or descending order. 
• dragging and dropping a column header to a new location to rearrange the 

column order. See “Reordering Columns” on page 23.

Using the mouse, point to the Information 
icon to display the Quick Access menu.

Click anywhere on a row to expand the item and see a preview of 
its information. Click the row again to hide the preview.

Click here if you want to change the 
criteria and run a new Hotsheet search.

Click here to display all matches of a 
Section category.
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• clicking the [+] Multi-Field Sort button to Sort by three levels of criteria as 
selected from the drop-down lists. See “Viewing, Sorting and Filtering” on page 22.

2. Click the Displays drop-down list and choose a layout in which to view different 
columns of information. 
• click the [ ] icon adjacent to the drop-down list to open the Column 

Manager, should you want to select a different display format. See “Column 
Manager” on page 317.

• click the Save Grid [ ] icon to save any changes you made to the column 
grid.

3. To filter the list by record selection, select any number of records from the list. 
Click the Filter drop-down list and select an option: 
• Show all — all records are displayed.
• Show selected — only the selected records are displayed.
• Show unselected — only the records that are not selected are displayed.

4. Click the Sections drop-down list and choose one of the Hotsheet sections, for 
example, Pending Listings.
Note: The items appearing in the Sections list are determined by the 
criteria you specified in the Sections field of the hotsheet Search Criteria 
page. See “Using the Search Criteria Page” on page 68.

5. Select a record, then click the Move Up/Move Down buttons on the footer bar 
to reorder the records. See “Footer Bar Controls” on page 22.

6. Click the Show/Hide Criteria button on the footer bar to view a summary of 
the search criteria without leaving the Search Results page. A preview pane opens.

7. Click the Show Map button on the footer bar to display a resizable, split screen 
view of the results grid with a map view. See “Using the Search Map Page” on page 74.

8. Click on a record’s Listing# or Address hyperlink to view the property on a 
map. 
See “Viewing a Map of Listing Search Results” on page 223.

9. Select a record, then point to the Information icon to display the Quick Access 
menu commands: Report, Tax, Property History, Images, Map, Edit, E-mail, 
Financial Calculators, etc.
Note: These options may vary depending on your area and availability.

10. Select one or more records, then click on an Action button to perform more 
tasks:
• Revise Search — opens the Search Criteria page, where you can modify the 

search criteria. See “Using the Search Criteria Page” on page 68.
• Driving Directions — to plan a route to multiple properties. See “Creating 

Driving Directions” on page 225.
• Map — to see a map view of the selected properties. See “Viewing a Map of 

Listing Search Results” on page 223.

TIP ... To clear an 
applied filter and 
see all records, 
choose Show all 
from the Selection 
list and All from 
the Status list.
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• Download — to export the selected hotsheet data. See “Exporting Hotsheet 
Data” on page 334.

• E-mail — lets you select properties and reports, including all hotsheet 
sections at once, to send via E-mail. See “Sending E-mail” on page 130.

• Print — lets you print a list of property search results (as seen on the page). 
See “Printing Listing Search Results” on page 274.

Note: To print the actual listing details, select Print from the Search 
Results page. See “Printing” on page 265.

11. Proceed to “Viewing Hotsheet Details” on page 144.
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Viewing Hotsheet Details

NOTE! If you want to view just one property record, point to the listing’s Information 
icon on the Hotsheet Search Results page and click the Report icon from the 
Quick Access menu. The item appears in a pop-up window that you can keep 
open while you continue to work in TEMPO 5. From this window, you can view 
and Print a variety of detailed reports.

To view the Hotsheet details for a selected listing:

1. From the Hotsheet Results page, select one or more listings you want to view. 
Note: To view all properties, do not select any.

2. Click the Details tab.
The Hotsheet listing details page opens. 

3. To view different types of data for the selected listing(s), click the Quick Link 
Button Bar icons: Images, Virtual Tour/Links, Tax (if available in your area), 
Map, Directions, Report Data Error, etc. 

4. Click the View drop-down list, located in the top right corner, to see the listing 
information using a different report format.
Note: Your favorite reports are shown at the top of the list and are 
highlighted in yellow. To set up your favorite reports, see “Choosing Your 
Favorite Reports” on page 46.
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5. To scroll through the previous and next selected listing, click the left and right 
arrow buttons [ ] at the top of the page. Alternatively, you can go directly to a 
particular report page by selecting it from the drop-down list in the top left corner 
of the page. 

6. Click an action button to perform further actions: 
• Email — use the Send E-mail pop-up dialog to select properties to send via 

e-mail. See “Sending E-mail” on page 130.
• Print — use the Print dialog box to choose the report printing options. 

See “Detailed Hotsheet Reports” on page 279.
7. To return to the Search Results page, click Back to List.
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Working with the CMA Manager

TEMPO 5’s Comparative Market Analysis (CMA) feature lets you create:
• attractive, graphical reports analyzing a seller’s property.
• presentations for your buyers. 
All reports and presentations can be quickly and easily e-mailed to your clients.

To display the CMA Manager reports list:

1. From the main menu, click Reports > CMA Manager.
The CMA Manager page opens, displaying a list of all existing seller CMAs and 
buyer presentations. 

2. From the CMA Manager page, you can change the list view by: 
• clicking the Display drop-down list to filter the list. See “Viewing, Sorting and 

Filtering” on page 22.
• clicking on a row to open the CMA.
• clicking a column header to sort the list in ascending or descending order. 

See “Viewing, Sorting and Filtering” on page 22.

Click here to create 
a new CMA. 

Use this menu to view CMAs for a single contact
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• dragging and dropping a column header to a new location to rearrange the 
column order. See “Reordering Columns” on page 23.

3. Type the name, or first few letters of a name, in the Search by contact field, then 
click the Search button.
The presentations matching the selected name, or first few letters, are displayed 
in the list. 

• click the Restore button to display the entire list.
4. To select CMAs for a single contact, you can also select the contact’s name from 

the drop-down list at the top right of the CMA Manager. You can toggle how the 
client list is sorted (by first or last name) by clicking the resort name button [  

].

5. Select one or more unwanted CMAs in the list, then click the Delete Selected 
button in the footer bar. 
• A message box appears, asking you to confirm deletion. Click OK. 

See “Deleting a CMA” on page 151.
6. Select a CMA in the list, then click an Action button to perform more tasks: 

• Open CMA — view or edit the selected CMA presentation. 
See “Opening or Editing a CMA” on page 149.

Note: Clicking on a row in the list is the same as using the Open CMA 
Action button. It allows you to view or edit an existing CMA report. 

• Copy CMA — creates a copy of a CMA report you want to duplicate, while 
keeping the original intact. See “Copying a CMA” on page 150.

7. Click the New CMA button to create a new Buyer or Seller CMA. 
See “Creating a New CMA” on page 152.

8. Click the CMA Presentation Library button to open the CMA presentation 
library of default report pages. See “CMA Presentation Library” on page 169.

Opening or Editing a CMA

You can open and edit a selected CMA report at any time from the CMA Manager. 
Simply click a presentation in the list; or select a presentation, then click the Open 
CMA button.

To view or edit a CMA presentation:

1. From the CMA Manager page, click a CMA presentation report in the list.
Note: You can only edit one report at a time.

The CMA Wizard page automatically opens after the last fully completed step of 
the presentation. For example, if you started a new CMA, getting as far as step 
#3 — Adding Comparable properties, the wizard opens at the next step that 
needs to be completed. 
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2. Click one of the CMA Wizard’s numbered steps to edit a specific area of the 
existing CMA. 

3. Make changes to the property information as required. Follow the instructions 
given in “Creating a New CMA” on page 152.

4. Depending on which page you are on, click Save. 
5. Click Close to return to the CMA Manager.

Copying a CMA

To make a copy of a buyer or seller CMA while keeping the original intact, use the 
Copy CMA Action button on the CMA Manager page.

To copy an existing CMA:

1. From the CMA Manager page, select a presentation you want to copy.
Note: You can only copy one CMA at a time.

2. Click the Copy CMA button.
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The Enter CMA Name dialog opens. The default name is “Copy of [Seller 
CMA/Buyer Presentation] for [client name]”. 

3. Type a new name or accept the default.
4. Click OK.

The new item appears in the list, ready to be edited. 
See “Opening or Editing a CMA” on page 149.

Deleting a CMA

To delete a CMA:

1. From the CMA Manager page, select one or more CMAs from the list.
2. Click Delete CMA from the footer bar.

A message box opens, prompting you to confirm the deletion. 

3. Click OK.
The CMA is permanently deleted.
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Creating a New CMA

When you click the New CMA button from the CMA Manager main page, the CMA 
Wizard appears to assist you with creating a new Buyer or Seller CMA. There are 8 
easy-to-follow steps that take you from the basic presentation setup to adding 
comparables, adjustments, and pricing to finally creating a CMA report. You can also 
add a new client or use the library of system CMA templates. 

To create a new CMA:

1. From the CMA Manager main page, click New CMA; or from the main menu, 
click Reports > New CMA.
The CMA Report Wizard page opens at step 1. Getting Started. 

2. Select the type of CMA: Buyer or Seller. 
3. Click the Select Property Type drop-down list and choose the kind of CMA 

presentation to create (for example, Residential/Condo).
4. Click the Select Contact drop-down list and select a contact name to associate 

with the CMA. 
• click the Edit contact button to make changes to the contact record. 

See “Editing Contact Information” on page 52.
• click the Add new contact button to add a new contact record, then select 

the name from the list. See “Adding a New Contact” on page 58.
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NOTE! Be sure to select the correct CMA Type, Client, and Property Type NOW, as you 
cannot change these values later.

5. In the Name of this CMA field, enter a descriptive title. 
The default is [Buyer/Seller] CMA for [client name]. 

6. Click the Use contact’s home address as Subject Property check box, if 
appropriate.
This option automatically copies the property information from the existing 
contact record to the new CMA. Once you have created the new CMA, you will 
also have the option of adding Subject Property information directly from an 
MLS or Tax search (where available).

7. Click Next Step. 
The Subject Property page opens. 

8. Proceed to “Adding Subject Property Information”.

Adding Subject Property Information

If you selected Use contact’s home address as Subject Property when creating the 
CMA, some of the fields may already contain information. Otherwise complete the 
fields on the Subject Property page manually, or import property information by 
performing an MLS Search or a Public Records tax search. 

To add subject property information:

1. From the Subject Property page, enter or find the information for the available 
fields. 
Note: The information you enter here is used in various locations in the 
CMA, so it is important that you enter as much information as possible. 

TIP ... You can 
also click step 2. 
Subject Property 
from the CMA 
Wizard side 
panel.
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2. Click the drop-down list in the top right corner and select the category of fields to 
display on this page, for example, RES CMA Fields, or All Fields. 

3. You may be able to search for and import information. If the subject property: 
• has a recent listing record in the MLS database, click the MLS Search button 

at the bottom of the page. 
• does not have a listing record in the MLS database, click the Public Records 

button to search the public tax records (if available in your area).
The Search Criteria dialog opens, from which you can perform a search. 
See “Property Type Searches” on page 65.

4. Make any changes or additions to the imported property information as required. 
NOTE! Although it is possible to find Subject Property information through an MLS or 

tax record search, changes to the subject property information will NOT affect 
the listing or tax record itself. Adding subject property information through an 
MLS or tax search makes a copy of the information that can then be edited 
independently.

5. To add a subject property photo, click the Add Photo link, located in the upper 
right panel.
The CMA Subject Property Photo window opens. See “Managing Images” on 
page 293.
• click Delete Photo to remove the subject property’s image.
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6. If TEM PO  5 is unable to determine (or has incorrectly determined) the 
property’s location on a map, based on the address and zip code information, 
click the Set Map Location link to manually set the map.
The Set Map Location dialog opens. See “Mapping” on page 215.

7. Click Next Step.
The Search Criteria dialog is automatically launched allowing you to look for 
specific comparable listings. Or, if there are comparables associated with the 
CMA, the Comparable Properties page opens. 

8. Proceed to “Working with Comparable Properties”.

Working with Comparable Properties

Use the Comparables feature to search for and list a number of comparable 
properties for the selected CMA. The list can be sorted, filtered, reordered, and 
resized similar to the standard Search Results list. See “Viewing, Sorting and Filtering” on 
page 22. You can search the MLS, perform a tax search, or add a new comparable 
manually. 

To add comparable properties:

1. From the Search Criteria dialog that automatically opens from the previous step, 
perform a search of the database. See “Property Type Searches” on page 65. 
• from the Search Results tab, select one or more listings, then click the Add 

Selected Records as Comparables button. A copy of the selected record’s 
information appears. Skip to step #3.

Note: Click Cancel to exit the Search dialog box if you are going to add 
comparable properties by using the action buttons. 

2. If the comparable property: 
• has a recent listing record in the MLS database, click the MLS Search button 

at the bottom of the page to perform a search. 
• does not have an listing record in the MLS database, click the Public 

Records button to perform a tax search.
• does not have a listing record in the MLS database and you want to add the 

listing information manually, click the Manual Entry button to create a new 
comparable listing.

TIP ... You can 
also click step 3. 
Comparables 
from the CMA 
Wizard side 
panel.
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The Comparable Properties page opens displaying the newly added listings.  

3. From the Columns drop-down list, you can choose a different layout grid view. 
See “Column Manager” on page 317.

4. Sort the list in ascending or descending order by clicking a column header. 
See “Viewing, Sorting and Filtering” on page 22.

5. Select a listing, then click the Move Comparable Up/Move Comparable 
Down button on the footer bar to move it up or down in the list.

6. To filter the list by record selection, select any number of records from the list. 
Click the Selection drop-down list and select an option:
• Show all — all records are displayed.
• Show selected — only the selected records are displayed.
• Show unselected — only the records that are not selected are displayed.

7. To filter by status, choose an item from the Status drop-down list. Only those 
items with the corresponding status are displayed. For example, Sold, Back on 
Market, etc.

8. Click the Multi-Field Sort button to perform a multiple sort. See “Multi-Field 
Sorting” on page 24.

9. Select a record, then click the Information icon to display the Quick Access menu 
commands: Report, Tax, Property History, Images, Map, Edit, or Delete.

10. Click the Statistics button to generate a Search Criteria report that you can print. 
See “Running Business & Statistical Reports” on page 193.
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11. Click Next Step.
The Comparable Adjustments page opens. 

12. Proceed to “Making Adjustments to Comparables”.

To edit a comparable:

1. From the Comparable Properties page, select one or more comparables in the list.
2. Point to the Information icon to display the Quick Access menu, then select Edit. 

The Edit CMA Property window opens.
Note: If you are editing the comparable because its price or status has 
changed, select Status Change or Price Change from the drop-down list. 
Only the fields necessary to make these changes are displayed, making it 
quicker and easier for you to make these kinds of changes.

3. Make changes to the property information as required.
4. Click Save to save the comparable property information; if you want to discard 

your edits and make new changes, click Reset.

5. To edit another comparable property, click the Previous [ ] and Next [ ] 
buttons at the top of the window, or select a property from the drop-down list to 
go directly to it.

6. Click Close.
A message box opens prompting you to save your changes.

7. Click OK.
8. Proceed to “Making Adjustments to Comparables”.

To delete comparables:

1. From the Comparable Properties page, select one or more unwanted comparables 
in the list.

2. Select the Delete Comparable button on the footer bar.
A message box opens, prompting you to confirm the deletion.

3. Click OK.
4. Click Next Step.
5. Proceed to “Making Adjustments to Comparables”.

TIP ... You can 
also click step 4. 
Adjustments 
from the CMA 
Wizard side 
panel.
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Making Adjustments to Comparables

The Comparable Adjustments page displays a side-by-side comparison of Subject 
property and Comparable property. You can add value adjustments to comparable 
properties to factor in/out for features not available in the selected property.

To make adjustments to comparables:

1. From the Comparable Adjustments page, complete the Adjustment 
Description, Subject Property, Comparable Property and Adjustment 
Amount boxes as required. 

Note: If an amount is meant to reduce the Adjustment Amount of the 
comparable property, make sure you put a minus sign (“-”) in front of the 
amount.

2. Add any Comments for the comparable that you want to show up in the finished 
CMA report.
• click the Spell Check icon to check the spelling.

3. To make price adjustments to other comparable properties, click the Previous 
[ ] and Next [ ] buttons at the top of the window, or select a property from 
the drop-down list to move directly to it.

4. To edit the Subject Property or the displayed Comparable Property, click the 
Edit Comparable button. 
The Edit CMA Property window opens. See “To edit a comparable:” on page 157.
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5. To delete the Subject Property or the displayed Comparable Property, click the 
Delete Comparable button. See “To delete comparables:” on page 157.

6. Click Next Step.
The Suggested Price page opens. 

7. Proceed to “Determining the Suggested Price”.

Determining the Suggested Price

Enter a suggested list price or price range for the subject property, or use one of the 
calculation methods to determine a suggested list price based on the selling prices of 
comparable properties. Within each type of calculation method, choose if you want to 
use the High, Low, Median or Average value to perform the calculation.

To determine the suggested price of the subject property:

1. From the Pricing page, click the Calculate Price Based On drop-down list and 
select an option: 

• Manually Entered Price — enter your own suggested price, then enter 
values in the Suggested Price or the Suggested Price Range fields.

• Selling Price — automatically calculates a suggested selling price, based on 
the high, low, average, or median adjusted selling price (after price 
adjustments) of sold comparable properties.

TIP ... You can 
also click step 5. 
Pricing from the 
CMA Wizard 
side panel.
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• Listing Price — automatically calculates a suggested selling price, based on 
the high, low, average, or median adjusted listing price (after price 
adjustments) of comparable properties, regardless of their list status.

• Price Per Sq Ft — automatically calculates a suggested selling price per 
square foot, based on the high, low, average, or median adjusted selling price 
per square foot of sold comparable properties, multiplied by the square 
footage of the subject property (ppsf x subject property sq ft.).

• Assessed Tax Value Ratio — automatically calculates a suggested selling 
price, based on the tax value ratio (assessed tax value divided by the adjusted 
selling price) of sold comparable properties. The assessed tax value of the 
subject property is divided by the high, low, average, or median tax value ratio 
of sold comparable properties. 

Note: Suggested price values are calculated after price adjustments 
have been applied to the subject property, then rounded to the nearest 
$100.

2. Review the CMA analysis, based on the selected comparable properties. 
• to adjust the comparables, click on the link, e.g. Comp1, Comp2, etc.

3. Click Next Step.
The Estimated Seller’s Net Proceeds or Buyer’s Closing Costs page opens. 

4. Proceed to “Estimating Net Proceeds & Closing Costs”.

Median vs. Average Definitions

A median value is the “mid-point” value in a range of numbers which have been put 
in order of magnitude (from lowest to highest). Approximately half of the data are 
smaller and half of the data are larger. 
An average value, also known as the “mean” is the value of all data totalled up and 
divided by the number of values in the sample. 

TIP ... You can also 
click step 6. 
Netsheet from the 
CMA Wizard side 
panel.
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Estimating Net Proceeds & Closing Costs

Prepare an estimate of the Seller’s net proceeds or the Buyer’s closing costs to include 
with the CMA. A running total is displayed at the bottom of the page. You can view 
and modify existing netsheets later by clicking on the Financials menu. See “Buyer 
and Seller Net Sheets” on page 206.

To estimate net proceeds or closing costs:

1. From the Estimated Seller’s Net Sheet or Estimated Buyer’s Closing Costs page, 
enter the seller or buyer financial information in the fields at the top of the page. 
Note: The Estimated Sale Price is the same as your Suggested Sale 
Price. 

Note: If you are preparing a Buyer Presentation, this page looks slightly 
different than the Estimated Sellers Net Proceeds page.

The list of Settlement Charges or Closing Costs should show all of the 
hypothetical transaction details, including all of the seller or buyer paid fees and 
closing costs.

2. To change the order of expenses in the list (which is also the order in which they 
will be printed), select the expense you want to move and click the up and down 
arrow buttons (located on the right side of the list).

3. To quickly add a standard list of pre-defined seller expenses or buyer costs, click 
Apply Defaults. 



CMA Manager

162 TEMPO 5 User Guide

• to set up your list of default expenses, or make changes, click Edit Defaults. 
See “Setting Up Default Netsheet Information” on page 162.

4. Use the Action buttons at the bottom of the page to manage the individual 
expenses in the list: 
• click New Charge to add an expense or cost item; or to add a heading or 

separator line. See “Adding and Editing a New Charge” on page 163.
• to modify an existing expense, select it then click Modify. 

See “Adding and Editing a New Charge” on page 163.
• to delete an expense, highlight it in the list, then click Delete. 
Note: Use the up/down arrows to move blank lines out of the list.

5. Click Next Step.
The Select Pages page opens. 

6. Proceed to “Selecting Pages for the CMA Presentation”.

Setting Up Default Netsheet Information

You can pre-define a list of regularly used closing costs or settlement charges to be 
applied to all new netsheets. Click the Apply Defaults button to automatically add 
the list to the page. Click the Edit Defaults button to make changes to your system 
default charges.

To set up a list of default seller expenses or buyer costs:

1. At the bottom of the Netsheet, click the Edit Defaults button.
The Default Netsheet Information page (whether for Seller or Buyer) opens. 

TIP ... You can also 
click step 7. Select 
Pages from the 
CMA Wizard side 
panel.
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2. To re-order an item in the list, highlight it, then click the up [ ] and down [ ] 
arrows at the far right until the item is correctly positioned.

3. Click the New Charge button to specify the details of a new expense item. 
• click the Modify button to edit the details of a selected expense item. 

See “Adding and Editing a New Charge” on page 163.
4. To remove an unwanted expense item, highlight it then click Delete.
5. Select the Save as System Defaults check box to make this pre-defined list of 

default expenses the default list. 
NOTE! This new default list supersedes any other list and will be the one applied if you 

restore the system defaults.

6. Click the Restore System Defaults link to revert back to the original list. 
7. Click Save.

You are returned to the main Netsheet page.

Adding and Editing a New Charge

You can use the Add expense dialog box to not only add a new item, but also to insert 
a descriptive sub-heading or a separator line. Similarly, use the Edit expense dialog 
box to modify the charge.

To add a new expense, manually:

1. Click the New Charge Action button to add an expense that is not yet listed. 
The Add expense dialog box opens.

2. Enter the following: 
• Description — a brief description of the expense. 
• Fixed Dollar Amount — type the actual expense amount, for example $125.
• Plus % — type a percentage (%) amount of the value you select from the 

drop-down list. For example 10% of the Purchase Price.
Note: If you enter a value in both the Fixed Dollar Amount and % fields, 
the values will be added together.
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3. Click OK.

You are returned to the Netsheet page. 

To add a blank line (separator):

1. Leave all fields empty in the Add expense dialog box.
2. Click OK.
3. Use the up/down arrows on the Netsheet page to position the separator in the 

list.

To add a sub-heading:

1. Type the sub-heading in the Description field of the Add expense dialog box. 
2. Click OK.
3. Use the up/down arrows on the Netsheet page to position the heading in the list.

Selecting Pages for the CMA Presentation

Select the report pages to include with this CMA. Some reports can be created, 
copied, edited, and previewed from this page.

To select the report pages to include:

1. From the Select Pages page, click the CMA Presentation drop-down list and 
select a category: Buyer, Seller, or Custom.

2. Click the Owner drop-down list to select from System reports or Personal 
reports. 
Note: If you are working with a Custom presentation, you can choose 
from All, System, Personal or Office reports.
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The Available reports list displays the reports you can use in this presentation. 

3. From the Available reports list, highlight one or more reports in the list.

4. Click the right arrow [ ] button to move your selections to the Selected reports 
list.
• in the Selected reports list, highlight a report and click the up/down arrows 

to re-order the list.
5. Use the Action buttons:

• New Report — click this button to design a new report that can be used in 
this presentation, other presentations, or by other users. See “Creating a New 
Report” on page 178. 

• Edit Report — click this button to modify an existing Personal report. 
System reports cannot be edited. 

Note: The changes will be applied to all CMAs where this report has 
been used.

• Copy Report — when working on a Custom CMA, click this button to make 
a copy of an existing report so that you can edit it. Make the copy available to 
this CMA exclusively, other CMAs, or everywhere as a Personal report.

• Preview Report — click this button to preview each report page as you 
highlight it in the list.

6. Click Next Step.
The View Report page opens. 

7. Proceed to “Viewing the New CMA Presentation”.

TIP ... You can also 
click step 8. View 
Report from the 
CMA Wizard side 
panel.
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Viewing the New CMA Presentation

The final step in the CMA Wizard enables you to view and print each page in the 
CMA presentation so that you can make any last minute changes. Then, save 
individual pages or the entire final report to PDF format, attach it to an e-mail or 
print it. 

To review the finished CMA report:

1. From the CMA Wizard page, click 8. View Report.
The View Report page opens. 

2. To review each page of the report:
• click the left [ ] and right [ ] arrow buttons to scroll through each page; or 
• click the drop-down list and choose the page you want to see.

3. To change one or more pages in the final report, display the page you want to 
modify, then click the Edit Report button.
Note: You can modify an existing Personal report. System reports 
cannot be edited.

The CMA Report dialog box opens. 
• Select one of the options, depending on how you want to apply the new 

report, then click OK:

Select Stationery icon.
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• Make this report exclusively for this CMA Presentation
• Allow this report to be available for other CMA Presentations
• Add this report to my Personal Reports so it’s available everywhere

The Report Editor opens. See “Using the Report Editor” on page 184.
4. To remove one or more pages from the final report, click the drop-down list to 

display the unwanted page, then click the Remove Report button.
Note: Removing report pages does not change the CMA presentation 
template, only the appearance of this particular report.

Selecting a Stationery Style

You can choose to give your CMA reports a more attractive look by applying a visual 
background image to one or all pages of a report and/or a CMA presentation. Once 
applied, the stationery appears on-screen, in print, e-mail and PDF formats. 

To apply a stationery design:

1. From the View Report page of the CMA Wizard, click the Select Stationery icon 
[ ].
The Select your Stationery dialog box opens. 

2. Click on a design to highlight it. (A red frame appears around the selection).
3. Click one of the option buttons, at the bottom of the dialog box:

• Apply to this single CMA Report — the selected theme is applied only to 
the report page currently displayed.

All available 
stationery themes 
are included in a 
template library. 
You cannot upload 
custom images.
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• Apply to all reports in this CMA — the selected theme is applied to all 
pages of the report.

4. Click Apply.

Selecting a Final Output for the CMA

Once the CMA presentation is complete, there are a couple of ways to present the 
final report to your client. You can save the report as a PDF file, which can be easily 
distributed. The recipient requires Adobe® Reader (available for free from the Adobe 
web site) to open and read a PDF file. 
If you choose to e-mail your client, you are actually sending a link in the body of the e-
mail message which, when clicked, opens the CMA presentation in a Browser. 
Finally, you can print the CMA presentation, in its entirety or one page at a time.

To save, send, or print the final CMA report:

1. From the final CMA presentation page, click one of the following buttons:
• Save PDF — saves the report as a PDF file for easy readability and 

distribution. See “Saving a Report as a PDF Document” on page 269.
• Print Current Page — lets you print a single selected page of the CMA. 
• Print — lets you print the entire CMA. See “Printing” on page 265.
• E-mail — lets you send an e-mail to the recipient, with a link to the CMA 

presentation. See “E-Mailing CMAs” on page 135.
2. Click Close.
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CMA Presentation Library

TEMPO 5 has an integrated library of pre-designed CMA presentations. Use them 
directly, or copy and modify the CMAs to suit your needs. Choose and apply the 
presentation pages that are to be used by default whenever you create a new CMA. 
Some presentations may have been created by your office administrators, while you 
can and will create some yourself.

NOTE! You can only edit and delete CMA presentations you created yourself.

To access the CMA Presentation Library:

1. From the CMA Manager page, click the CMA Presentation Library button.
The CMA Presentation Library pop-up window opens with a list of available 
templates. 

2. Click the Property Type drop-down list and choose a category for which you 
want to view related CMAs (for example, Residential).
• select All to display all property type CMAs.

3. Click the Owner drop-down list and select from: All, System, Office, or 
Personal.

4. To sort the list of displayed presentations in alphanumerical order, click in the 
column header. 
• click the same column header again to reverse the sort order.

5. Use the Action buttons at the bottom of the page to perform more tasks:



CMA Manager

170 TEMPO 5 User Guide

• New CMA Presentation — lets you create a new CMA presentation binder 
by selectively adding report pages. See “Creating a New CMA Presentation 
Binder” on page 170.

• Edit — lets you edit a Personal CMA presentation you created by selectively 
adding or removing report pages. See “Editing a CMA Presentation Binder” on 
page 172.

• Copy — lets you copy a System CMA presentation to modify and re-use. 
See “Copying a CMA Presentation Binder” on page 173.

• Delete — lets you delete a CMA presentation. See “Deleting a CMA 
Presentation Binder” on page 173.

• Defaults — lets you specify CMA Presentation Default Settings to use for 
each type of property search. See “Setting Up Default CMA Presentations” on 
page 174.

6. Click Close.

Creating a New CMA Presentation Binder

When creating a new CMA Presentation, you must assign it to a particular property 
type, then select the report pages you want to include. 

To create a new CMA presentation binder:

1. From the CMA Presentation Library page, click the New CMA Presentation 
button. 
The CMA Presentation dialog opens. 

2. Select a Property Type from the drop-down list.
Note: Depending on the property type you choose, different fields are 
available when adding and modifying presentation pages. 

3. Click OK.
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The CMA Presentation Report Selection page opens. 

4. Enter the Presentation Name and a Description for the new CMA.
5. Select the Owner Type option, for example Personal. 

Note: You will only see the options for which you have access rights.

6. Click the Owner drop-down list and select from: All, System, Office, Personal, or 
Board.
The reports corresponding to the Owner type appear in the Available reports 
list.

7. Select one or more reports, (called pages) to add to the CMA presentation binder 
from the Available reports list. 
• to select multiple reports, hold down the CTRL key and click.
Note: You must include at least one report.

8. Click the right [ ] arrow button to move the pages to the Selected reports list.
• to remove an unwanted report from the Selected reports list, highlight it and 

click the left [ ] arrow button.
9. To rearrange the order of the Selected reports, select one report at a time, and 

click the up/down arrow buttons. 
Note: The order in the Selected reports list determines the order of 
appearance of the pages in the CMA presentation.

10. Click the Action buttons to manage report pages:
• New Report — to create a new CMA report from scratch. 

See “Creating a New Report” on page 178.
Note: To create a new report from an existing report, select one of the 
Available reports from the list and click Copy Report. 



CMA Manager

172 TEMPO 5 User Guide

• Edit Report — to modify an existing report, for which you have sufficient 
access rights. See “Editing a Personal Report” on page 181.

• Copy Report — to copy an existing report, modify and reuse it. 
See “Copying an Existing Report” on page 180.

11. Click Save. 
The new CMA appears in the CMA Presentation Library list. 

Editing a CMA Presentation Binder

NOTE! You can only edit CMA presentations you created yourself. If you try to edit a 
report that you don’t have access privileges to, TEMPO 5 automatically makes a 
copy of the report, which you can edit.

To edit a Personal CMA Presentation binder:

1. From the CMA Presentation Library page, select the presentation you want to 
edit from the list.
Note: You can edit only one template at a time.

2. Click the Edit button; or click directly on the row. 
The CMA Presentation Report Selection window opens. 

3. If you are editing a copy, or just want to change the name, type a new name in the 
Presentation Name field. 

4. Modify the Description text.
5. Select an Owner Type option (if you have privileges to change this).
6. Add or remove reports from the presentation by using the left/right [< >] arrow 

buttons between the Available reports and Selected reports lists.
7. Click the Action buttons to manage report pages:

• New Report — to create a new CMA report from scratch. 
See “Creating a New Report” on page 178.

Note: To create a new report from an existing report, select one of the 
Available reports from the list and click Copy Report. 

• Edit Report — to modify an existing report, for which you have sufficient 
access rights. See “Editing a Personal Report” on page 181.

• Copy Report — to copy an existing report, modify and reuse it. 
See “Copying an Existing Report” on page 180.

8. Click Save.
The modified CMA appears in the CMA Presentation Library list. 
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Copying a CMA Presentation Binder

You can copy a presentation binder of reports that you like to use with a different 
contact.

To take a copy of an existing CMA presentation binder:

1. From the CMA Presentation Library page, select the presentation you want to 
copy in the list.
Note: You can copy only one presentation at a time.

2. Click the Copy button. 
The CMA Presentation Report Selection dialog box opens. 

3. Accept the default Presentation Name (“Copy of [presentation name]”) or enter 
a new name.

4. The remaining steps are the same as when creating a new CMA presentation. 
See “Creating a New CMA Presentation Binder” on page 170.

Deleting a CMA Presentation Binder

NOTE! You can only delete CMA presentations you created yourself or for which you 
have access rights.

To delete a CMA presentation binder:

1. From the CMA Presentation Library page, select a Personal CMA presentation to 
delete.
Note: You can delete only one Personal template at a time.

2. Click the Delete button.
A message box appears, prompting you to confirm the deletion.

3. Click OK. 
A message appears advising that your changes have been saved.

4. Click OK.
The presentation no longer appears in the CMA Presentation Library list.
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Setting Up Default CMA Presentations

You can set up a number of your favorite CMA presentation binders to be used as 
defaults whenever you create new CMA presentations. Choose two default CMAs per 
property type: one for Seller presentations and one for Buyer presentations. 

To set up your default CMA Presentations:

1. From the CMA Presentation Library page, click the Defaults button. 
The CMA Presentation pop-up window opens. 

2. Click the Select a Search Type drop-down list and choose a type of search, for 
example Multi Family.

3. Click each of the Default [Seller/Buyer] CMA Presentation drop-down lists 
and choose a CMA presentation binder.
The selected CMA presentations will be used by default whenever you create a 
new Seller or Buyer CMA for the selected property type.

4. Click Apply.
5. Repeat steps 2 - 4 for each search type in the drop-down list.
6. Click Close.

You are returned to the CMA Presentation Library page. See “CMA Presentation 
Library” on page 169.
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Working with the Report Manager

TEMPO 5 features a Report Manager and online Report Editor to give you complete 
control over creating and managing flyer-style listing reports. In addition, you have 
statistical reporting capabilities for analyzing market trends and determining agent 
and office performance.
The list of reports can be quickly and easily sorted, rearranged, and filtered with each 
column giving you an overview of reporting details. 

To access the Report Manager:

• From the main menu, click Reports > Report Manager.
The Report Manager main page opens.  

To change the Report Manager list view:

1. From the Report Manager page, you can change the list view by clicking a column 
header to sort the list in ascending or descending order.

2. Narrow the list of records displayed by applying a simple filter. Click one of the 
following drop-down lists:
• Report — choose a report category, for example, MLS or Tax.
• Type — select what kind of reports you want to view, for example, All, 

Residential, Open House, etc.

TIP ... Filters can 
be applied 
together, or 
independently. 
See page 22.
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3. To filter the list of reports by Owner, click the drop-down list and choose:
• All — displays all reports in the system.
• System — displays all read-only reports.
• Board — displays all reports specific to your MLS Board.
• Firm — displays all reports specific to your firm.
• Office — displays all reports specific to your office.
• Personal — displays all editable reports that you have created yourself.

NOTE! To view the entire list of reports, select All from the Report and Owner drop-
down lists.

4. Select one or more reports, then use the action buttons to perform specific tasks:
• New Report — create a new report. See “Creating a New Report” on page 178.
• Copy Report — copy an existing report. See “Copying an Existing Report” on 

page 180.
• Report Properties — change the name and type of an existing report. See 

“Changing Report Properties” on page 182.
• Edit Report — modify an existing report. See “Editing a Personal Report” on 

page 181.
• Delete Report — delete an existing report. See “Deleting a Personal Report” on 

page 183.
NOTE! You can only edit, rename or delete Personal reports that you created yourself. 

The TEMPO 5 pre-designed System reports are NOT editable. 
You must make a copy of a System report and rename it after making changes.
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Creating a New Report

You can create a new report from scratch, or copy an existing report to use as a 
template for your new Personal report.

To create a new report:

1. From the Report Manager page, click the New Report button.
The New Report dialog box opens in conjunction with Report Editor. 
See “Using the Report Editor” on page 184. 

2. From the Report drop-down list select a category, for example MLS.
3. From the Type drop-down list, select the kind of report you want to create. 
4. Select a report format from the Select a Report Format gallery.
5. Click OK. 

The Report Editor opens with the corresponding report type data fields.
6. Use the editor’s functionality to design the report. See “Using the Report Editor” on 

page 184.
7. When you are finished, click the Save tool bar icon. 
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The Save Report dialog box opens. 

8. Enter the Report Name and an optional Description. 
9. Select the Make this report only available for CMAs check box to enable this 

function.
10. Select a Report Type option button, for example Personal.

11. Click OK.
The “Report has been saved” message box appears.

12. Click OK.
13. Click Close. 

You are returned to the Report Manager page where the new report is displayed 
in the list.
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Copying an Existing Report

You can copy any type of report in order to create a new report with similar features.
NOTE! You can only copy one report at a time.

To copy an existing report:

1. From the Report Manager page, select the report you want to copy.
2. Click Copy Report.

The Report Editor opens.
3. Use the editor’s functionality to re-design the selected report. See “Using the Report 

Editor” on page 184.
4. Click the Select category drop-down list in the upper left corner and choose the 

category to which the report will be saved.
5. Click the Save As tool bar icon.

The Save Report dialog box opens.
6. Enter a new Report Name and an optional Report Description.

Note: If you accept the original report name, your new report will be 
saved with the same title as the original report. The difference is your 
new copy is a Personal report that you can edit, whereas, the original is a 
System report that is read-only. 

7. Select the Make this report only available for CMAs check box to enable this 
function.

8. Select a Report Type option button, for example, Personal.
9. Click OK.

The “Report has been saved” message box appears.
10. Click OK.
11. Click Close. 

You are returned to the Report Manager page where the copied report is 
displayed in the list.
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Editing a Personal Report

NOTE! You can only edit a Personal report (one that you have created). TEMPO 5’s pre-
designed System reports are not editable. You must make a copy to edit. 
See “Copying an Existing Report” on page 180.

To edit a Personal report:

1. From the Report Manager page select the report you want to edit: 
• click the report line item directly; or
• click the check box of the target report, then click the Edit Report button.
Note: You can only edit one report at a time. If you select multiple 
reports, the Edit Report button will NOT be available.

The Report Editor opens. See “Using the Report Editor” on page 184.
2. Make changes to the report. See “Creating a New Report” on page 178.
3. When you have completed your modifications, click the Save tool bar icon.

The Save Report dialog box opens.
4. Click OK.

A message box appears confirming the report has been saved. 
5. Click OK.
6. Click Close. 

You are returned to the Report Manager page.
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Changing Report Properties

The Rename Report button has been changed to the Report Properties button, 
letting you change the report name and type.

NOTE! You can only rename a Personal report (one that you have created). TEMPO 5’s 
pre-designed System reports are not editable. 

To rename a Personal report:

1. From the Report Manager page, select the report you want to rename.
Note: You can only rename one report at a time. If you select multiple 
reports, the Report Properties button will NOT be available.

2. Click Report Properties.
The Report Properties dialog box opens. 

3. Change the Report Name.
4. Enter the Description. 
5. Select the check box if you want this report to be available to CMAs.
6. Select a Report Type option button, for example Personal.
7. Click OK.

A message box appears confirming the report was successfully renamed. 
8. Click OK.
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Deleting a Personal Report

NOTE! You can only delete a Personal report (one that you have created). You can NOT 
delete any of TEMPO 5’s pre-designed System reports.

To delete a personal report:

1. From the Report Manager page, select one or more Personal reports that you 
want to remove permanently.

2. Click Delete Report.
A message box appears, prompting you to confirm the deletion.

3. Click OK. 
A confirmation message appears.

4. Click OK.
The reports no longer appear in the Report Manager list.

Setting a Favorite Reports List

To make it easy to quickly view your favorite reports on the Listing Detail page, 
TEMPO 5 lets you maintain a list of the reports you use most often. A different list 
of favorite reports can be set up for each property type. See “Choosing Your Favorite 
Reports” on page 46.

NOTE! You can choose up to six (6) reports for each Property Type. These appear as 
Favorite Quick Links on the Listing Details page and are highlighted in yellow.
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Using the Report Editor

The Report Editor enables you to design new reports or modify copies of System 
reports. You can apply word processing-like formatting, insert data fields, objects and 
more. 

To access and use the Report Editor:

1. From the Report Manager page:
• click New to create a new personal report; or 
• click Edit to modify a copy of a system report
The online Report Editor opens. 

NOTE! Using the mouse, point to any tool bar icon to see a description of what it does. 

Drag data 
fields, images 
and label 
objects from 
here onto the 
page.

Select the type 
of object you 
want to add to 
the report.

Tool bar

Search 
category
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Icon Description
Save — Saves changes to an existing report.
Save As — Lets you copy the report and save it under another 
name.
Print — Sends the report to the printer.
Preview — lets you search for a listing, then preview your report 
using the information.

Page Setup — Select page size, orientation and set margins.

Spell Check — Lets you check the spelling of labels on the 
report.

Cut, Copy and Paste — Cut or copy selected text to the 
clipboard. Paste or insert the clipboard text at the cursor’s 
insertion point.
Undo, Redo — Lets you undo an action or redo an action (to 1 
level).

Bring to Front, Send to Back — Layer objects or groups of 
objects from front to back.
Delete Object — Delete a selected object.
Object Property — Lets you view the property settings for the 
selected object.
Zoom — Change the page viewing size.

Show/Hide Rulers — Turn rulers on or off.

Gridline Options — Displays the Grid Properties dialog box, 
letting you adjust the Grid Spacing, and enable/disable the 
Grid Options: Grid Visible or Snap to Grid.
Font and Size — Select the font name and size (in points).

Bold, Italic, Underline, Font Color, Outside Border — Add 
attributes to selected text. Put a box around a selected object.

Align Left, Center, Align Right — Aligns selected text.

Align Tops, Align Middles, Align Bottoms — Aligns selected 
objects.

Align Lefts, Align Centers, Align Rights — Aligns selected 
objects.

Add/Delete Page — Append a new page to the report. Remove 
a selected page from the report.

View Page — Select a page to view from multiple report pages.
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Setting Up a Report Page

To produce a well-designed report, use the available guidance tools, like grids and 
rulers, to accurately line up page elements. 

To set up your work space settings:

1. Select a zoom level from the [xxx%] drop-down list.
The view size is adjusted accordingly.

2. Click the Gridline Options tool bar icon. 
The Grid Properties dialog box opens. 

NOTE! The grid lines are only a design aid; they are not part of the report and will not 
be displayed when viewing or printing the final report. The grid lines also 
indicate the usable page area as determined by the Margins setting under 
Page Setup. Objects cannot be placed or moved outside the grid area.

3. Set the following grid properties, then click OK: 
• Grid Spacing — click the drop-down list and select a grid size, for example, 

8 Points per inch.
• Grid Options — select the Grid Visible check box to display or hide the 

grid. Click the Snap to Grid check box to make objects automatically line up 
with the grid line intersections when they are moved or resized on the report 
page.

4. Click the Rulers tool bar icon to display (or hide) rulers at the top and to the left 
of the page. 

To set up the report parameters:

1. Click the Page Setup icon. 
The Page Setup dialog box opens. 

2. Select: 
• Page size — Letter or Legal. 
• Orientation — Portrait or Landscape.
• Margins — Top, Bottom, Left and Right.

3. Click OK.
4. Click the Select category drop-down list and choose a type of report. 
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The corresponding data fields are displayed in a list on the left side. 

To manage report pages:

1. Click the appropriate tool bar icon:
• Add Page — a new blank page is appended to the end of the report. 
• Delete Page — deletes the page you are currently viewing and all of its 

contents.
2. To view a specific page number (other than the one you ar currently working on), 

select the page number from the drop-down list. 

Working with Objects

Text labels, maps, charts, and image files that can be placed on the report page are all 
considered “objects” and are categorized into three groups: Data Fields, Images, 
and Toolbox. 

Toolbox objects enable you to add the following features to your report:
• Text boxes
• Lines
• Frames
• The date on which the report is generated
• The time at which the report is generated
• Page number
• Page count
• Maps
• Charts
• Showing time
• Inline frames

To add Data Fields:

1. Click Data Fields in the category list at the bottom left corner of the page. 
The available field names are displayed in the list.

2. Select the Include Label check box to ensure that when you drag data fields onto 
the form, the names (or labels) go also.
Note: It is recommended you select the Include Label check box. 
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3. To help you search for a data field, enter the first few letters in the Search For 
field to narrow the list to where your label is located. 

4. Click and drag one or more data field objects from the list onto the page.
Note: This is where it’s nice to have the grid lines and rulers displayed 
for easy line-up. 

5. Use the tool bar buttons as needed.

To add Images:

1. Click Images in the category list at the bottom of the left column.
2. Click the Select category drop-down list at the top of the left column and 

choose an image type (for example Agent Image, MLS Image, etc.).
Note: Select the image slot number, if required.

The corresponding image merge codes appear in the list.
3. Click and drag one or more image merge code objects from the list onto the page.

A box representing an image appears on the form.
• Some image categories have the Manage images link to help add, edit or 

delete images from the database. The TEMPO 5 image submission window 
opens. See “Managing Images” on page 293.

4. Use the tool bar buttons as needed.

To add Toolbox objects:

1. Click Toolbox in the category list at the bottom of the left column.
2. Click and drag a toolbox object from the list onto the page.

Note: Depending on the object you select, a dialog may open to 
request more information.

3. Use the tool bar buttons as needed.

To select one or more objects on a page:

NOTE! An object must be selected before you can delete it or modify its properties. 

1. Click the object once. 
The object appears ‘outlined’ to indicate that it is selected.
• to select a group of objects, hold down the CTRL key while clicking on 

additional objects.
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2. Another way to select a group of objects is to click and drag on an empty area of 
the page to create a “selection rectangle.” 
• extend the rectangle around the objects that you want to select. When you 

release the mouse button, the objects within the rectangle remain selected. 
NOTE! Selecting a group of objects is very useful when you want to apply the same 

changes to multiple objects at the same time. For example, you can select a 
group of text objects and then use the Font and Font Size controls to change 
these properties simultaneously on all of the selected objects.

To delete an object:

1. Select the object you want to delete.
2. Click the Delete icon or press the DELETE key on your keyboard.

A message box opens, prompting you to confirm the deletion.
3. Click OK.

To change the size of an object:

1. Select the object you want to modify. 
Each side and corner of the object’s selection box displays a small white square 
(called a ‘handle’).

2. Click a handle and drag it in any direction to resize the object.
NOTE! Any portion of an image or text that extends beyond the object's borders will 

be cut off when displayed or printed. Ensure that the object is large enough to 
accommodate its contents.

To change the position of an object:

1. Place the cursor over an object until the mouse pointer becomes a four-way 
arrow. 
Note: For a Label Object, place the cursor over the edge of the object 
(but NOT over a handle) to make the mouse pointer become a four-way 
arrow.

2. Click and drag the object in any direction to reposition the entire object.
3. If two or more objects overlap, specify which object is on top and which is on the 

bottom using the Bring to Front and Send to Back icons. 
• select the object you want to bring forward or send back and click the 

appropriate icon. 
Note: This feature can be especially useful when overlapping images to 
create an artistic effect.

To align a group of objects:

1. Select the group of objects that you want to align as described above.
2. Click one of the Align icons. 
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The selected objects are aligned according to the selected aspect. For example, if 
you click the Align Lefts icon, all of the selected objects will be moved to the 
left so that their left edges line up with the edge of the left-most object.

To change an object's text formatting:

1. Select the text object(s) that you want to modify. 
• If you are working with a single Label Object, you can use the cursor to 

highlight and format just a portion of the label's text.
2. Use the tool bar drop-down lists to select a font and point size for the text.
3. Click the Outside Border icon to create a black border around the text. 

• use the object handles to change the border size dimensions. Click the icon 
again to remove the border.

4. Click the Font Color icon to change the text to the currently selected color. 
• click the drop-down list to select a new color from the Color window, then 

click OK.
5. Click the Bold, Italic and Underline icons to apply these effects to the text. 

• click the icons again to remove the effect.
6. Click the Align Left, Center and Align Right icons to change the justification of 

the text within the boundaries of the text object.

To work with a selected object’s properties:

1. Select an object, then click the Object Property toolbar icon; or double-click the 
object.
The Data Properties dialog box opens. 

2. Click one of the tabs:
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• Data Field — this tab lets you work with the data field information, 
including two fields that let you append a Prefix or Suffix to the fields.

• Font — this tab lets you work with border style, width and color.
• Hyperlink — this tab lets you enter several types of links: Navigation or 

URL address, E-mail Link, Data Field Links (for URLs contained in a data 
field), Smart Links (such as DigiMap Tax) or Report Links (Listing reports, 
Media Viewer > Attachments, Show Map, etc.).

3. Click OK.

Previewing a Report

You can get a sense of what your report design will look like when viewed with real 
data. When you retrieve a listing record, it’s data will replace the data fields on the 
report template.

To preview a report from Report Editor:

1. From the Report Editor page, click the Preview toolbar icon.
The Report Preview dialog box opens. 

2. Click the Search for a listing link to search for and retrieve a listing.
The MLS number appears in the text box.

3. Click OK.
The Report Preview page is displayed showing real data from the MLS.

4. Use the toolbar to scroll between multiple pages, zoom in or out, and print the 
report preview.

Printing a Draft of the Report

You can get a sense of what your report design will look like when printed, and make 
changes accordingly.

To print the report from Report Editor:

1. From the Report Editor page, click the Print tool bar icon. 
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A standard Windows Print dialog box opens.
2. Choose any additional report options (e.g., number of copies, destination printer, 

etc.), then click OK to print the report. See “Printing” on page 265.
NOTE! Reports printed directly from the Report Editor will not show any property 

information, images, or other data. Merge codes and image placeholders will 
print exactly as shown on screen.

To complete the report:

1. When you are satisfied with the report, click the Save icon.
2. Enter the Report Name and the optional Report Description. 

Note: If this page is just for use with CMAs, select Make this report only 
available for CMAs.

3. Click OK. 
4. Click Close to return to the Report Manager page.
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Running Business & Statistical Reports

Reports help you track clients and manage your business. Statistical reports include 
information such as office inventory, market share and penetration, and home sales.

To run a statistical report:

1. From the main menu, click Reports > Business Reports.
The Business Reports Criteria page opens. 

While more limited in some ways, this page is similar to the listing Search 
Criteria page. See “Using the Search Criteria Page” on page 68.

2. Click the Statistical report drop-down list and choose the type of report to 
create.

3. To build a more advanced search or change the search operator(s), click the Show 
Advanced Operators button in the footer bar.
The Boolean operator drop-down lists are displayed. See “Creating More Advanced 
Search Queries” on page 68.

4. Build your search query by entering the appropriate criteria in the fields. 
See “Field Related Controls” on page 19.

NOTE! The available search criteria fields are different for each statistical report type.

5. Click the Search button. 
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A dialog box is displayed, showing the number of records that match your 
search criteria.

NOTE! The larger the number of matching records, the longer the statistical report will 
take to generate.

6. Click OK.
The Reports page opens.

7. To browse through multiple pages, click the arrow buttons at the bottom left of 
the scrollable portion of the window.

8. To view a printable report of the search criteria used to generate this statistical 
report, click the Search Criteria Report link. See “Using the Search Criteria Page” on 
page 68.

9. To return to the Search Criteria page, click the Back to Criteria link.
10. To print the statistical report, click Print Report. 

A standard Windows Print dialog opens. See “Printing” on page 265.
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Types of Statistical Reports

The following reports are available in one form or another to most TEMPO 5 users. 
Variations in name, content, and format should be expected.

Agent Award Detail Report

To verify Agent Awards, this report calculates an agent’s total number of properties 
and dollar volume on the List/Sell sides of transaction activities. Showing one agent 
per page, the report provides detailed listing information including the ML#, 
Address, number of agents involved, units, volume, sale price, close date, and DOM.

Agent Market Share Report

This report ranks all agents in the MLS by their monthly performance, based on the 
number of sold properties, as per the property types specified in the search criteria. 
The report displays each agent’s rank, number of properties sold, the percentage of 
the report’s total listings that the agent possesses, the sales volume, the average and 
median sale prices. The report also lists these stats for the List Side.

Data Export Report

This reports displays the number of records and images exported by each user for the 
specified period of time.

Dollar Value Report by Area

This report provides the total number of listed properties, with their total, average, 
and median list price values. The report is sorted by area, as per the criteria selected in 
the search.

Firm Activity By Month

Showing one firm per page, this report lists the number of active, new, sold, pending 
and expired property types, along with the ($) volume for each category for the 
month. A total of all columns appears at the bottom of the report.

Home Sales Report

This Real Estate Trend Indicator report displays the number of listings, by number of 
bedrooms, per price class (not user-configurable), along with the average price and 
volume for residential and condominium data as per the criteria specified in the 
search. The report also includes DOM and financing information.

Inventory Report By List Price

This report provides listing information in an inventory format sorted by list price. 
Summary information at the bottom of each report page displays a Price Comparison 
by showing the Average, Median, Minimum and Maximum listing prices, in addition 
to the total number of listings included in the report. 
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Inventory Report By Status

This report provides listing information in an inventory format sorted by property 
status. Summary information at the bottom of each report page displays a Price 
Comparison by showing the Average, Median, Minimum and Maximum listing prices, 
in addition to the total number of listings included in the report.

Inventory List by Expiration Date

The Inventory Report by Expiration Date provides listing information in an 
inventory format sorted by expiration date. Summary information at the bottom of 
each report page displays a Price Comparison by showing the Average, Median, 
Minimum and Maximum listing prices, in addition to the total number of listings 
included in the report.

Inventory List by Office

The Inventory Report By List Broker report provides listing information in an 
inventory format sorted by the listing office. Summary information at the bottom of 
each report page displays a Price Comparison by showing the Average, Median, 
Minimum and Maximum listing prices, in addition to the total number of listings 
included in the report.

Login Summary Report

This report is used to compare the number of user login counts for TEMPO 5 and 
RETS on a monthly basis. This report is not broken down by Association.

Market Activity Report by Area

The MAR report calculates the total number of Active, New, Sold, Expired, Off-
Market and Pending property listings in each area on a monthly basis. 
The report also shows the Average List Price and Average Sales Price for each area.

Market Activity by Sub-Sub-Area

This MAR report calculates the total number of Active, New, Sold, and Off-Market 
property listings in each sub-area per month. The report also shows the Average and 
Median list prices for each property status.

Member Application Usage Report

This report can be used to see who has logged in and when, by month. This report 
contains the Public ID, Member name, date, number of logins, total session time (in 
minutes) and average session time.

Member Login Report 

This report can be used to identify heavy users by month by providing the total login 
count for each user for TEMPO and RETS. The report is broken down by 
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Association and product and contains the Public ID, Office Code, First and Last 
name of the user, E-mail address, and the dates of first and last logins.

MPA Report By Broker & Area

The Market Penetration Report calculates a percentage (of market) based on the 
number of Active or Sold listings per broker vs. the MLS listing database for 
each area. It also calculates a percentage based on the total listing price (broker) vs. 
total listing price (MLS). 

Office Market Penetration Report — Active Listings

This report ranks office performance by calculating the number of active listings for 
each office vs. the MLS. It also calculates office volume listings vs. the MLS listings by 
area (i.e., the office and the MLS are compared on an area-by-area basis). Each office’s 
results appear on a separate page.

Office Market Penetration Report — Sold Listings

This report ranks office performance by calculating the number of sold listings for 
each office vs. the MLS. It also calculates office volume, average sale price, and the 
percentage of the total sales that the office processed by area, for both the List and 
Sell sides. Each office’s results appear on a separate page. 

RETS Member Login Report

This report provides the number of total login counts for RETS and TEMPO 5 on a 
monthly basis, for members, from first login to last login. The report lists the Public 
ID number, Office Code, member name and e-mail address.
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Searching for Tax Information

NOTE! The Tax Search feature or some of its components may not be available in all 
areas.

The TEMPO 5 tax search function lets you find public record information for 
virtually any property. You can define specific criteria to retrieve information for a 
specific property, or you can perform a broad search to retrieve multiple properties.
Obtain land registry information, tax and deed data, as well as property features and 
descriptions for your client. Tax information should be available regardless of 
whether or not a property is currently listed. See “Listing Manager” on page 111.

NOTE! You may see a Tax Search form that operates like any other Search Criteria page 
in TEMPO 5. Enter the search criteria and perform a search. See “Searching” on 
page 63. Or you may have a link to third-party software that has its own search 
functionality. 

To search for tax information using the tax search criteria page:

1. From the main menu, click Public Records.
The Tax Search Criteria page opens. 

2. Click the Search type drop-down list and select a search type consistent with the 
county or area in which you want tax information.
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3. Click the Search template drop-down list and select a search template, such as 
Tax Search.

4. Complete the fields on the Search form. Required fields appear in red text.
• use the footer bar controls to add, remove, move fields on the page. 

See “Using the Search Criteria Page” on page 68.
5. Click the Count button in the sidebar to see how many records match your 

criteria. If there are too many, revise the search criteria. 
6. Click the Tax Search Map tab to perform a map search. See “Searching by Map 

Area” on page 221.
7. Click one of the action buttons to perform a task:

• Search — displays the Search Results page with all matching records. 
Proceed to step #8.

• Save Search — opens the Search Settings page so that you can save the 
search for re-use. See “Saving a Search” on page 73. 

8. From the Search Results page, select one or more tax records, then:
• click the Columns drop-down list to select another format for the data. 

See “Managing Column Reports” on page 318.
• click the Save Grid icon to save any changes you may have made to the search 

grid.
• click the Filter drop-down list to apply a simple filter to the list. See “Viewing, 

Sorting and Filtering” on page 22.
• click the Multi-Field Sort button to apply a filter to the data. See “Viewing, 

Sorting and Filtering” on page 22.
• use the footer bar controls to re-order a selected record in the list or to show 

the search criteria.
9. Click the action buttons to perform more tasks: 

• Revise Search — takes you back to the Search Criteria page so you can 
modify your search criteria.

• Map — opens the Map View page so you can see the property locations. 
See “Viewing a Map of Listing Search Results” on page 223.

• Download — lets you export selected tax records. See “Exporting Data from 
TEMPO 5” on page 330.

• Print — lets you preview and print one or more tax reports. In addition, you 
have the option to save the document in a Portable Document Format (PDF). 
See “Saving a Report as a PDF Document” on page 269.

10. To choose the type of report you want to generate, click the Details tab.
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Viewing Tax Details

From the Search Details page you can choose from several different tax report 
formats, then scroll through multiple tax reports for on-screen viewing. In addition, 
you can preview what the report will look like when printed, then send it to the 
printer or save it as a PDF file.

To view a tax report:

1. If you want to change the type of tax report from the Reports page, click the 
View drop-down list and choose one of the available report types, for example 
Owner Mailing Label.

2. To view reports for multiple properties, click the Previous [ ] and Next [ ] 
arrow buttons at the top of the page to scroll through the different tax records; or 
select an address from the drop-down list in the top left corner.

3. Use the links in the Quick Link Button Bar to perform more tasks:
• Tax — displays the tax reports for the selected listings.
• Map View — displays a map view for the selected listings.
• Driving Directions — displays the Plan Route pop-up dialog box, letting 

you get directions to the selected listings.
• History — displays a property history report (if any) for the selected listings.
• Listing — displays listing details (if any).

4. Use the action buttons to perform more tasks:
• Back to List — takes you back to the Search Results page. 
• Other Tax — if more details are available for the selected tax record, they 

can be accessed from here (may not be available in your area).
5. Click the Print Report button to select which reports (or pages of) to preview, 

print or save as PDF. See “Printing” on page 265.
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Adding Tax Information to a Listing

When you add a new listing from the Listing Manager, you have the opportunity to 
add tax information by:
• using the Tax Autopop Selection pop-up window to search for a tax record based 

on a specified tax provider, county, and Tax ID number; or 
• use the tax search function (as described herein) to search for a record.
Either way, you can complete most of the tax-related fields on the listing property. 
See “Using the Tax Auto-pop Feature” on page 118.
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Financial Functions

TEMPO 5 offers a variety of useful financial tools that make it easy to calculate loan 
payments, as well as estimate closing costs and net proceeds from a sale.

To access the financial functions:

1. From the main menu, click Financials. 

2. Click the menu item you want to work with.

Buyer and Seller Net Sheets

Prepare Net Sheet reports that itemize expenses and calculates the estimated closing 
costs for buyers; or payouts for sellers. From the Buyer and Seller Net Sheets page, 
you can view, add, edit or delete netsheets.

To view or modify an existing Buyer or Seller Net Sheet:

1. From the Buyer and Seller Net Sheets page, click a column to sort the list in 
ascending or descending order. 

2. Select a net sheet from the list.
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3. Click Modify (or simply click the row).
The Net Sheet Information pop-up window opens. 

4. Click the action buttons to add or modify the list of charges and/or defaults 
associated with this net sheet. See “Adding and Editing a New Charge” on page 163.

5. Click Close.

To create a new Buyer or Seller Net Sheet:

1. From the Buyer and Seller Net Sheets page, click the New button in the bottom 
left of the page. 
The New Net Sheet dialog opens. 

2. Choose the Seller or Buyer option.
3. Click the drop-down list and select a client.

• Click the Add a new client link to enter new client information.
4. Click Next.
5. The appropriate Net Sheet Information page opens: Estimated Buyers Closing 

Costs or Estimated Sellers Net Proceeds. See “Estimating Net Proceeds & Closing 
Costs” on page 161.

6. Click Close.
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To edit Net Sheet Default charges:

1. From the Buyer and Seller Net Sheets page, click the Edit Defaults button.
The Net Sheet dialog opens.

2. Select the Net Sheet Type: Seller or Buyer.
3. Click Next.

The Default Net Sheet Information page opens. 
4. Make the necessary changes, whether to the Sellers Net Proceeds — Default 

Settlement Charges, or to the Buyers Net Sheet — Default Closing Costs.
Note: Default costs are discussed in another section. See “Setting Up 
Default Netsheet Information” on page 162.

5. Click Save.

To delete a Buyer or Seller Net Sheet:

1. From the Buyer and Seller Net Sheets page, select one or more items in the list.
2. Click the Delete button.

A message box appears, asking you to confirm the deletion.
3. Click OK.

To print the Buyer or Seller Net Sheet Report:

1. From the Buyer and Seller Net Sheets page, select an item in the list.
2. Click the Report button.

The Print Preview page opens. 
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3. Click the Select a report drop-down list, in the bottom left of the page, and 
choose a report format.

4. Click: 
• Print — A standard Windows Print dialog opens. Choose your printing 

options, then click Print. See “Printing” on page 265.
• E-mail — The Send E-mail pop-up window opens. See “Sending E-mail” on 

page 130.
5. Click Close.

Using the Payment Calculator

The Payment Calculator lets you calculate estimated monthly loan payments as well as 
view and print a complete amortization schedule based on the number of payments 
and start date you specify.

To use the payment calculator:

1. From the main menu, click Financials > Payment Calculator. 
The Payment Calculator page opens.

2. In the Enter Loan Values section, select the Check the value to calculate 
option button next to the field you want to calculate. (For example, if you want to 
know the payment per month based on the loan amount, interest and term, click 
Monthly Payment).
The field turns grey.

3. Enter the remaining values: Loan Amount, Annual Interest Rate, and Term 
fields. 
The monthly payment will be calculated based on these values.

4. Click the Calculate Values Action button, located at the bottom of the page.
The calculated value is displayed.

The calculated value 
appears here. 
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5. In the Display Loan Payments Schedule section, enter the following 
information:
• Show the first [x] payments — enter the number of payments
• commencing on [month] [year] — enter the month and year of repayment
• include a balloon payment after [x] months — enter the number of 

months, after which a balloon payment can be made. If the value is equal to 
the term, then the balloon payment is zero (0).

6. Click View Payment Schedule for Loan to view the related amortization table. 
The Loan Payments Schedule opens in a new Browser page. 

7. Click the Reset Values Action button to clear the calculator so you can enter new 
values.
• a message box opens prompting you to confirm. Click OK.

NOTE! The Print Action button at the bottom of the Payment Calculator page will print 
the page itself, NOT the Loan Payments Schedule report. 

Loan Comparisons

The Loan Comparisons function lets you create and print a custom report showing 
the different loan options available to your client.

To compare loans and calculate the income required to qualify:

1. From the main menu, click Financials > Loan Comparisons.
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The Loan Comparisons page opens. 

2. In the top section of the page, enter:
• Offering Price of Home, Property Address and Area, Annual Property 

Taxes, Monthly Condo/HOA Fee, Annual Insurance, and Est. Closing 
Costs.

3. Use the series of drop-down lists to set up four different Types of Loan 
Programs Available, then enter the loan information for each in the appropriate 
column. 

4. Click the Calculate Values button. 
5. Scroll down to the bottom of the report to see the estimated Total Monthly 

Payment and Income and Cash Required to Purchase Home values.
NOTE! The calculated figures are estimates only and do not constitute a loan 

commitment or guarantee.

6. Enter your name in the Prepared By field.
7. Click Print. 

A standard Windows Print dialog box opens. 
8. Select any additional print options (e.g., number of copies, destination printer, 

etc.), then click OK to print the loan comparisons report. See “Printing” on 
page 265.
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Loan Qualification

The TEMPO 5 Loan Qualification function lets you determine the maximum 
mortgage a buyer can qualify for, based on factors such as income, debt, down 
payment, and mortgage type.

To qualify a buyer for a loan:

1. From the main menu, click Financials > Loan Qualification.
The Loan Qualification page opens. 

2. In the Buyer Information section, enter the Annual Income, Monthly Debt, 
and Cash Available, as well as the Buyer Name.

3. In the Mortgage Information section, select a loan type from the drop-down 
list, then enter the Annual Interest Rate, Loan Term, Down Payment %, etc.

4. In the Property Information (or Estimates) section, enter the Target Sales 
Price, Annual Property Taxes, Annual Insurance, Monthly Condo/HOA 
Fee, Est. Closing Costs, etc. 

5. Click the Calculate Values button.
6. Scroll down to the bottom of the report to see the qualification information.
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NOTE! The Income and Target Price column is blank unless you entered a Target Sales 
Price.

7. Enter your name in the Prepared By field. 
8. Click Print. 

A standard Windows Print dialog box opens.
9. Select any additional print options (e.g., number of copies, destination printer, 

etc.) and click OK to print the loan qualification report.

Rent vs. Buy

Use this financial calculator to compare the cost between renting and buying.

To calculate the difference between renting and buying:

1. From the main menu, click Financials > Rent vs. Buy.
The Rent vs. Buy Calculator page opens. 

2. In the Rental Information section, enter the values for Monthly rent, Monthly 
rental insurance, and Expected annual inflation rate.

3. In the Purchase Information section, enter the values for the purchase price of 
a home, down payment amount, etc.
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4. In the Home Information section, enter the mortgage insurance, homeowner’s 
insurance rate, annual property tax, etc.

5. In the Personal Information section, enter the income tax rate, selling 
commission rate, etc. 

6. Click the Calculate Values button.
The Total estimated cost of renting / buying values are displayed, along with 
the savings (in $) to buy instead of rent. 

7. Click the Print button to print the page (as is).
8. Scroll down to click the View Rent vs. Buy Report button.

A formatted comparison report is displayed in a new Browser window. 
9. Click the Print report link to print the formatted report.

10. Click Close.
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Using Map Controls and Views

The Map Controls Panel

The map controls panel is located in the top left corner of the mapping window. It 
contains the controls that enable you to adjust the map. If a control appears gray, it is 
unavailable and you cannot use it.

To minimize the map controls panel:

Click the minimize button [  ]. The panel will disappear, except for a restore 
button [ ]. Click this button to restore the map controls panel.

Views

Three map views are available:
• Road. A standard road map.
• Aerial. A satellite photo.
• Bird’s Eye. Close-up satellite view using Microsoft’s Virtual Earth™ technology. 

When working in Bird’s Eye View, you can rotate the image (see “Adjusting the Map 
(Pan, Zoom, and Rotate)” on page 217). The draw search tools are not available in 
Bird’s Eye view.

Open minimap buttonMinimize panel button

Map controls 
panel
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To change map views:

From the map controls panel, click Road, Aerial, or Bird’s Eye.

Adjusting the Map (Pan, Zoom, and Rotate)

To pan the map:

Either

• From the map controls panel, click an arrow on the pan control [ ]

• From the map footer bar, click Map Pan and then click and drag the mouse to 
move the map from side to side or up and down

To zoom in and out:

Click the zoom in [  ] and zoom out [ ] controls.

To rotate the image (Bird’s Eye view only):

When you are working in Bird’s Eye view, extra controls are available from the map 
control panel. These controls enable you to rotate the image. Either
• From the map controls panel, click a compass direction (N, S, E, W) on the 

bird’s eye pan control [  ].

• From the map controls panel, click the rotate clockwise [  ] or rotate 

counterclockwise [  ] control (located below the zoom controls).

Map Labels

Map labels identify transportation features (streets, highways, toll highways, railways), 
political features (cities, capitals, state and provincial boundaries) and recreation and 
places of interest (golf courses, sporting venues, parks, shopping).

To turn map labels on or off:

From the map controls panel, click Labels.
Note: You cannot turn off labels in Road view.
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The Locator

The Locator enables you to find specific addresses, MLS numbers, zip/postal codes, 
businesses and points of interest on the map.

To use the locator:

1. Click Locator on the map control panel to open the Locator dialog.

2. From the Search for menu, select the type of search you want to perform.
3. Enter search criteria.
4. Click Search.

Note: to zoom in to a specific county, type the county name (for 
example, “Pierce County”) in the City or State/Prov. field.

The Minimap

The Minimap is a small panel that displays a zoomed-out version of the current map 
view. The current map view is represented in the Minimap as a shaded rectangle. 
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To open the Minimap:

Click the Minimap button [  ] in the upper right corner of the map window.

To close the minimap:

Click the close button [  ] in the lower left corner of the Minimap.

Minimap Views

Two Minimap views are available:
• Road. Traditional road map.
• Hybrid. Road map combined with satellite view.

Minimap
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To change Minimap views:

Click the R button for road view; click the H button for hybrid view.

Navigating with the Minimap

You can rapidly change the current map view by panning the Minimap: click and drag 
the mouse in the Minimap to pan up, down, right, or left. The map view in the main 
map window will move accordingly.

Overlays

If your MLS subscribes to third-party mapping data (such as Thomas Brothers Map 
Data), you may have an Overlays control in the map control panel.

To apply mapping overlays:

1. From the map control panel, click Overlays to open the Overlays dialog:

2. Select the check box next to the overlay(s) you want to apply. To remove an 
overlay, clear its check box.

Road view Hybrid view
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Searching by Map Area

As an alternative to specifying your search area by entering area names or codes, 
TEMPO 5 allows you to graphically define the area you want to search by using a 
dynamic map.

NOTE! If you try to specify an Area using both search criteria and the Map Area 
feature, no matching listings will be found unless the two areas overlap. If you 
are using search criteria, check the map page to ensure there are no defined 
areas you may have forgotten about.

To search by map area:

1. From the Search Criteria page, enter information in the required fields on the 
Search Form, such as List Price, Market Code, etc.

2. Click the Search Map tab to open the search map. 

3. Use the map controls to adjust the size and view until you find the area you want 
to select (see “Using Map Controls and Views” on page 216):

4. To specify a search area, select one of the shape tools:
Note: You can draw up to 3 shapes for a single search (does not apply to 
hotsheet searches).

• Draw Rect — click and drag the mouse to draw a rectangle on an area of the 
map. When you release the mouse button, the boundary line turns blue in 
color.

Map Tools 
include: Map 
Pan, Draw 
Rectangle, 
Circle, or 
Polygon. 
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• Draw Circle — click to establish a focal point, then drag the mouse until the 
radius measurement (distance in miles) is displayed. Click again to set the 
circle. The boundary line turns blue in color.

• Draw Polygon — click to establish the first point. Click for each point you 
want to add to the shape (up to a maximum of 10 points for regular searches 
or 20 points for hotsheet searches). Click the initial point to finish the 
polygon and set the final search area. The boundary line turns blue in color.

Note: If you exceed maximum number of points on the polygon, the 
shape you have just drawn disappears and the process begins again.

• Clear Shape — click the button; or click the [x] on the shape itself to clear 
the shape from the map.

5. Click the Set my view button in the footer bar to save the current map position 
and zoom as a default setting for future searches. 
• click My View to revert back to your default view.

6. Click one of the action buttons:
• Search — performs a search of the specified map area. See “Searching” on 

page 63.
• Statistics — enables you to generate a market analysis report for the 

properties within the search area. See “Running Business & Statistical Reports” on 
page 193.

• Map Results — displays the Search Results page as a double-paned window 
showing a list of matching records on the left, and a corresponding map of 
the properties on the right. For multiple listings, each push pin is numbered to 
coincide with the corresponding address in the list. Click the push pin icon to 
display a detailed Listing Report. See “Reports” on page 175.

• Download — exports the search results data for use in another program, 
such as Excel. See “Exporting Listings Data” on page 332.

• Save Search — saves the search criteria for future searches. See “Saving a 
Prospect Search” on page 99.
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Viewing a Map of Listing Search Results

Listing locations are better imagined by seeing them represented on a map of the area. 
Use the built-in mapping feature to see different views. 

To see a map of the search results:

1. From the Search Results page, click the Show Map button on the footer bar.
A split screen view is displayed. 

2. Work with the search results from either pane: grid or map.
3. Use the Action buttons to perform more tasks. See “Working with the Search Results 

Page” on page 75.

To see a map of a selected listing:

1. From the Search Results page: 
• point to the Information icon of a single listing to display the Quick Access 

menu, then select the Map icon; or
• select one or more listings, then click the Map action button.
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A map of the selected listings opens. 

Each listing is displayed on the map as a push-pin. Each listing’s status is 
indicated by a letter on the head of the push-pin and a specific color. For 
example, active listings are green and show the letter “A”. In addition, for 
multiple listings, each push pin is numbered to coincide with the corresponding 
address in the list.

2. Using the mouse, point to a map pin to see more information about the property. 
3. Click either the push pin icon on the map; or the house icon in the list to generate 

a detailed listing report. See “Reports” on page 175.
4. Use the map tools to adjust the map view (see “Using Map Controls and Views” on 

page 216).
5. Click Print, located in the top right corner of the map, to send the map to the 

printer. See “Printing” on page 265.
6. Click Close.

Using the mouse, point 
to a push pin to view 
property details.
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Creating Driving Directions

TEMPO 5 gives you the power to create step-by-step driving directions that will 
guide you and your clients on a buyer’s tour.

To create a set of driving directions:

1. From the Search Results screen, select up to 10 listings that you want to include in 
the driving directions. 

2. Select Driving Direction from the Action menu, then click the arrow button. 
The Plan Route dialog box opens.

3. If you want to define a starting point other than the first listing (for example, your 
office or your client’s home), click the Add My Office button to enter the address 
to the list as the starting point.

4. Click the Enter Address button to manually add one or more addresses to the 
list. 

5. To arrange multiple listings in the order you plan to see them, highlight a property 
in the Locations list, then click Move Up or Move Down. 
• click Remove Location, to omit a property from the directions.

6. Select the Make this a round trip check box, if applicable.
7. Click the Display Directions as drop-down list and select a format: 
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• Instruction Text Only — this option creates a report with a single large map 
and point-to-point instructions.

• Text w/ Overview Map — this option provides the same information as 
Text Only, plus individual maps for each segment of the trip.

NOTE! The Text w/ Overview Map option takes longer to generate. If you are 
somewhat familiar with the area, the Instruction Text Only option should be 
sufficient.

8. Select the logic you want the program to use when determining the best route 
from the Route Options drop-down list. Choose Shortest Time, Shortest 
Distance, etc. 

9. Display distances in either Miles or Kilometers.
10. Click the Get Directions button at the top of the dialog box.

The driving directions are displayed on a map, along with a time and distance 
estimate, Reverse Direction, E-mail and Print buttons.

11. Confirm that all the properties were located successfully. 
• a list of unmapped properties will appear beneath the main map if there were 

any problems. If you find any problems or want to make changes, click Plan 
Route to return to the previous screen.

Comparing Route Options

With the map of listings displayed, you can compare different mappings by choosing 
the fastest or shortest routes, or routes that avoid highways. To quickly generate turn-
by-turn driving instructions going the opposite direction, start with the last listing, 
first. 
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IDX Configuration

Internet Data Exchange (IDX), sometimes known as Broker Reciprocity, is a way for 
associations to provide a way for their brokers to acquire and display each other’s 
listings on their public web sites. 

To access and configure IDX Permissions:

1. From the main menu, click My Tools > IDX Configuration.
A new browser window opens displaying a list of existing accounts and who the 
respective owners are. 

2. From the Accounts page, select the following links to perform more tasks: 
• Edit IDX Permissions — lets you search the member roster for an MLS 

member, then view/edit Agent/Broker Information and IDX Permissions. 
See “Editing IDX Permissions” on page 229.

• Default Profile Setting — lets you set up a default profile that can be 
applied to new accounts. Use it as a template, modifying specific information 
for each account. See “Setting Up a Default Profile” on page 231.

• Edit — each account has a link in this column that lets you modify account 
information. See “Working with Accounts” on page 232.

• Profiles — each account has a link in this column that lets you manage one 
or more profiles for the selected account, including settings and colors. 
See “Working with Profiles” on page 233.

• Delete — each account has a link in this column that lets you remove an 
account and its profiles. See “Working with Accounts” on page 232.

• Add New Account — lets you add a new account to the list and activate its 
permissions. See “Working with Accounts” on page 232.

Each account has helpful 
links that let you view/edit 
or delete profiles. The 
number of existing 
profiles is shown as a 
number.
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Editing IDX Permissions

Use this tool to search for and change a member’s IDX permissions.

To change a member’s IDX permissions:

1. From the Accounts page, click the Edit IDX Permissions link, located at the top 
of the page.
The following page opens. 

2. Search for an existing member for an MLS by entering: 
• the Agent’s First and Last Name, or partial information, in the fields.
Note: Use the other fields to search by if you know the Office Name, 
Office Code, Lockbox Key#, etc.

3. Click the Search button.
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The search results are listed on the following page. 

4. Click the Public ID link to view the member’s existing permissions, along with 
their Agent/Broker information. 

5. Click the Edit button to modify these settings.
6. Click the Update Information button to save the changes.
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Setting Up a Default Profile

Use this tool to set up a default profile that you can apply to new accounts “as is” or 
use it as a template that you can easily customize for different accounts. 

To set up a default profile:

1. From the Accounts page, click the Default Profile Settings link, located at the 
top of the page.
The Editing Profile Settings page opens. 

2. Set up a generic profile, typing ‘default’ in the Agent ID field, etc. See “Working 
with Profiles” on page 233.

3. Click the Back to Accounts link to return to the Accounts page.
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Working with Accounts

You can easily add new accounts, edit name and owner information, or delete 
unwanted accounts along with their profiles. 

To add a new account:

1. Scroll down to the bottom of the Accounts page, and click Add New Account.
The New Account page opens. 

2. Complete the fields:
• Name — type an account name, whether it’s a person, association, etc.
• Owner — enter one or more agent Login IDs in this field (separated by 

commas) to add the members to the account. Click the find link to search for 
an existing member.

3. Select the Active check box to enable the account.
4. Click Save.

You are returned to the Accounts list where the new account appears at the 
bottom of the list and is assigned an ID number.

To edit account information:

1. From the Accounts page, locate the account you want to modify, then click the 
Edit link. 

The Editing Account [ID#] page opens. 
2. Change the Name and Owner information; select or clear the Active check box.
3. Click Save.

You are returned to the Accounts page.

Click the All Accounts 
link to return to the 
previous page.
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To delete an account and all of its profiles:

1. From the Accounts page, locate the account you want to delete, then click the 
Delete link.
A message box appears asking you to confirm the deletion of the account and all 
of its profiles.

2. Click OK.

Working with Profiles

You can choose to apply a default profile to selected accounts, or you can customize 
one or more profiles for each account. Each account listed on the Accounts page has 
a link in the Profiles column that lets you know how many profiles exist for the 
account. Click the link to manage the profiles for a selected account.

To view the profiles of an existing account:

1. From the Accounts page, locate an account, then click the link in the Profiles 
column.
The Profiles for Account [ID#] page opens. 

Note: If there are no existing profiles for the account, the text “No 
Profiles for this Account” is displayed. 

2. Locate the profile you want to modify, then click one of the links.
3. Click the Back to Accounts link to return to the Accounts page.

To add a new profile:

1. From the Profiles for Account [ID#] page, click the Add New Profile link.

You can see the 
ID, Name, and 
Server 
information for 
any existing 
profiles. 
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The New Profile page opens. The default settings will be loaded which you can 
change to suit this particular account. See “Setting Up a Default Profile” on page 231. 

2. Accept and apply the default settings and permissions, or make changes to 
customize the profile including:
• Edit Colors — choose a color to apply to each of the listed screen elements, 

from page background color to text and table cell color. See “Editing Colors” on 
page 235.

• Agent ID — click the find link to search for a member.
• Logo — click the Browse button to search for a saved logo on your 

computer.
• Allowed Property Types — select one or more from the list.
• List Type Options — select one or more from the list.
• Allowed Regions — click the Select link to choose specific regions for the 

profile, or click the All link.
3. Click Save.
4. Click the Edit Settings link, at the top of the page, to return to the Editing 

Profile Settings page.

To edit a profile:

1. From the Profiles for Account [ID#] page, locate the profile you want to modify, 
then click the Settings link.
The Editing Profile Settings page opens.



Web Site Management

TEMPO 5 User Guide 235

2. The fields are the same as on the New Profile page. See “To add a new profile:” on 
page 233.

To delete a profile:

1. From the Profiles for Account [ID#] page, locate the profile you want to delete in 
the list, then click the Delete link.
A message box appears asking you to confirm the deletion of the profile. 

2. Click OK.

Editing Colors

Use the Editing Profile Colors page to preview the appearance of the Search, List and 
Detail pages with different colors.

To edit a profile’s colors:

1. Locate the profile you want to customize, then click the Colors link.
The Editing Profile [#] Colors page opens. 

2. Use the controls to do the following:
• click on the color swatches to display a palette, from which you can choose a 

different color. 

Click here to view 
page previews.
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• click the drop-down lists to select an option, for example the Table Cell 
Border Type appearance can be Solid, Double or Groove.

3. To see what your color choices will look like, click one of the Preview links: 
Search, List, or Detail.
The corresponding page appears in a new browser window. 

4. Close the browser window to return to the Editing Profile Colors page.
5. Click Save to keep your changes.
6. Click the Back to Accounts link.
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Using the Website Manager

The Website Manager page lists the site currently available to you. Configure new or 
existing sites, or delete unwanted sites from the list.

To access the Website Manager:

1. From the main menu, click My Tools > Preferences > Website Management.
The Website Manager page opens with a list of available sites. 

2. From this page, do the following: 
• click the Domain link; or select the adjacent check box, then click Edit to 

display the [System/Agent] Website Configuration page for the selected site. 
Follow the instructions for configuring a new website. See “Creating a New 
Website” on page 238.

• select the check box next to one or more unwanted websites in the list, then 
click Delete. When the message box appears prompting you to confirm the 
deletion, click OK.

• click the New button to add a new website domain to the list. See “Creating a 
New Website” on page 238.

3. Click Close.

Look in the 
Level column to 
see if the site is 
System level or 
Agent level.
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Creating a New Website

TEMPO 5 enables you to easily set up and manage the appearance and content of 
Agent and Broker websites using the built-in features and controls.

To add a new website:

1. From the Website Manager page, click the New button.
The Create New Website dialog box opens. 

2. From the Select a new Website to create drop-down list, choose a type, for 
example Agent or Broker, then click OK.
The Website Configuration page opens. 

3. Click the Site Builder button (or link).
The first page of the Setup Wizard opens. 

4. Click on one of the available design templates. 
Note: You can change the fonts, colors, photos later.

Click the Preview 
links to see a 
larger view of the 
templates.
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A frame highlights your selection, and when you click, the second page opens. 

5. Select one or more of the check boxes indicating which web pages you want to 
add to the site, then click Next Step.
The third page of the wizard opens. 

6. Enter as much contact information as you can.
Note: Fields marked with an asterisk (*) are required.

7. Click the Build Site button.
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The [Agent/Broker] Website Configuration page opens. 

8. Click on a button to set up the area. See “Configuring an Agent or Broker Website” on 
page 241.
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Configuring an Agent or Broker Website

TEMPO 5 enables you to easily set up and manage the appearance and content of 
your Web site using the built-in features and controls.

NOTE! The Agent Website Configuration page has an additional Team Settings 
section, not found on the System Website Configuration page.

To configure a Website:

1. From the Website Configuration page, click on the icons to view additional detail 
or to change the site’s configuration.  

NOTE! The clock icon appears adjacent to some sections, indicating that any changes 
made there may take up to one hour before taking effect.

2. From this page, click on the following icons to customize your TEMPO 5 
Website:
• Preview Website — See “Previewing Your Website” on page 242.
• Website Style — See “Changing Your Site Style” on page 242.
• Site Rules — See “Viewing the Site Rules” on page 243.
• Website Domain — See “Website Domain Setup” on page 244.
• Team Management — This option is only available on an Agent Website 

Configuration page. See “Team Settings for Agents” on page 246.
• Manage Web Pages — See “Managing Your Web Pages” on page 247.
• My Profile — See “How Prospects Contact You” on page 254.
• Image Library — See “Managing Website Images” on page 255.

Team Settings 
is only found on 
the Agent 
website 
Configuration 
page.
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3. Click the Back to Website Manager link in the top right corner to return to the 
previous page.

Previewing Your Website

To view your Agent or Broker Website as your clients would see it, and to see how 
new changes affect its appearance, you can preview your Web site at any time. This is 
particularly useful when you are updating the site.

NOTE! A Preview button is located in the top and bottom corners of every page.

To preview your Agent Web Site:

• From the Website Configuration page, simply click the Preview Website button.
The website opens in a new browser window.

Changing Your Site Style

TEMPO 5 provides several attractive Web site templates to choose from. Keep your 
site looking fresh by changing the theme every once in awhile.

To change your site style:

1. From the Website Configuration page, click the Website Style button. 
The Style Selection page opens.

2. To browse a style category, click the category name in the Templates list on the 
left side of the page.

Click Preview 
to view a 
selected 
template 
before you 
save it.
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The available templates appear on the right.
3. Click on a template to select it.

A colored frame outlines a selected template.
4. Click the Preview button to view the template before you save it.
5. Click the Custom Settings link on the left side of the page to specify basic color 

selections for certain components, such as Main Text Color, Heading Color, 
etc.

6. If you’re happy with the look of the selected template, click Save.
Note: This section has the clock icon in the top right corner, meaning 
that it may take up to one hour for your site style to take effect.

A message dialog box appears to confirm that your changes have been saved.
7. Click OK.

You are returned to the Website Configuration page.
8. Click Preview Website to view your updated site.

Viewing the Site Rules

TEMPO 5 automatically follows your MLS Board’s rules and regulations regarding 
the display of online listing information. For example, regarding property searching 
on your site, the Property Search button may or may not be available.

To view the site rules:

1. From the Website Configuration page, click Site Rules button.
The Site Rules page opens.

2. Read the information in the Rules set by your MLS section at the top of the 
page.

3. In the Settings that you can override section near the bottom of the page, select 
one or more of the check boxes to enable the site rules that you are allowed to 
override. For example, Show Property Address, or Show other agents’ Virtual 
Tours.

4. You can change the Send External Leads to e-mail address by clicking the 
Change button.

5. Choose an option for the Send Internal Leads to section.
6. Click the drop-down lists and select one or more items for each of the property 

types.
7. Click Save.

A message dialog box appears to confirm that your new site rules settings have 
been saved. 

8. Click OK.
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9. Click Close. 
You are returned to the Website Configuration page.

Website Domain Setup

The URL for your Agent Web Site is comprised of a secondary domain that prefixes 
your Board’s primary TEMPO 5 domain. For example, if the Web address (URL) for 
your Board’s TEMPO 5 domain is “http://mls.tempo.com,” then the address for 
your Agent Web Site will look like this: “http://StaceyJones.mls.tempo.com.” 

NOTE! To help drive traffic to your site, it is a good idea to include your site’s URL on 
all business communications, including yard signs, flyers, ads, business cards, 
and e-mails. It is important to make sure you choose a URL that you are happy 
with because if you change your URL after using it for a period of time, people 
will be unable to find your site and any links to your site will be broken.

To activate your Website:

1. From the Website Configuration page, click the Website domain button.
The Domain Setup page opens.

2. Read the Rules before you choose your Web page URL prefix. For example, you 
cannot exceed 40 characters in total.

3. In the Web page URL Prefix text box, enter the personal portion of the URL. 
For example type your name, or something distinctive and easy to remember: 
http://stacey.mls.tempo.com

4. Take note of the following lead management information:
• IDX SearchLink — place this link on any web site to make that site capable 

of accessing your IDX search screen. See “Using the IDX Search Link” on 
page 245See: “Using the IDX Search Link”.

• “Contact Me” Web Inquiry Form link — use this link on other web sites 
instead of an e-mail link, to funnel leads to the TEMPO 5 lead management 
tools. See “Using the “Contact Me” Link” on page 246See: “Using the “Contact Me” 
Link”.

5. Click Advanced Options to expand the section and access features that will 
make it easier for Internet search engines to find your site and/or to redirect 
traffic from an existing site to your TEMPO 5 Agent Web site.  

6. Under Search engine tools, enter the following:
• Website Title — enter your chosen title, which will appear on the title bar, 

up to 64 characters or less.
• Description — enter a description of your website in 25 words or less.
• Keywords — the words you enter here will be used as meta tags within the 

HTML code of your website.
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7. If you currently have an existing website and you want to automatically redirect 
traffic from it to your TEMPO 5 Agent website, enter the URL in the field 
provided. 

NOTE! You must also ask your domain registrar to redirect visitors from your domain to 
your TEMPO 5 Agent website. (Your domain registrar is the company that sold 
you your domain name.) If you administrate your own domain, you can set up 
the redirection yourself using one of three methods. See “About Self-Administrated 
Web Domains” on page 245.

8. Click Add Site.
The URL appears under Existing sites that are being redirected.
• Click delete this site to remove the redirected site’s URL.

9. When you have finishing entering your domain information, click Save. 
You now have a Web site!

Using the IDX Search Link 

NOTE! If available, the IDX Search Link feature may require an additional monthly or 
annual fee. Contact your MLS to check for availability.

If your Board has enabled this option for TEMPO 5 users, you or your Webmaster 
can easily add a listing search to any Web site (not just your TEMPO 5 Agent Web 
Site) that will automatically direct leads to your TEMPO 5 inbox.
If you know a little HTML, you can add the IDX search to a Web site by using the 
IDX SearchLink URL provided by TEMPO 5. For example: 

<a href=“http://search.yourname.mls.tempo.com”>
Click here to Search the MLS!
</a>

Anyone who clicks the link will see the full IDX search interface, and if they ask for 
more information, the request will end up in TEMPO 5 as a new lead.

About Self-Administrated Web Domains

If you administrate your own Web domain, you can set up the redirection to the 
TEMPO 5 site yourself, using one of the following methods:
• The preferred method is to add a CNAME record to your zone file that points to 

your subdomain (e.g., “www.realtysuperstar.com”) to the TEMPO 5 Web Site 
“mls.tempo.com.” Do NOT point to your secondary domain (e.g., 
“alanthompson.mls.tempo.com”). This option can usually be found under 
advanced domain settings. Please contact your registrar if you cannot locate this 
option.
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• If the above preferred method is not available to you, then you should be able to 
simply forward your own domain to your Agent Web Site at 
“alanthompson.mls.tempo.com” (for example). The disadvantage of this method 
is that “alanthompson.demo.tempo.com” will appear in the browser address bar, 
not your own domain name.

• Some domain registrars offer the option to “frame” your domain forwarding so 
your domain name (e.g., “www.realtysuperstar.com”) will appear in the browser 
address bar. In other respects, this option is essentially the same as option 2. This 
is not a desirable method, however, because it prevents site visitors from book 
marking specific pages within your site.

Using the “Contact Me” Link

The “Contact Me!” link is designed to replace your e-mail links on any other Web 
sites that you may have in order to capture new leads.
The difference between the “Contact Me!” link and an ordinary e-mail link is that 
every e-mail sent via the “Contact Me!” link will be funneled directly into your 
TEMPO 5 inbox and result in the automatic creation of a new client record.
Your personal “Contact Me!” link can be added to any Web page using very simple 
HTML like this:

<a href=“http://lead.yourname.mls.tempo.com”>
Click here to send me an E-mail!
</a>

Team Settings for Agents

You can identify up to four members in the office to be your team members. All 
listings for which any of the team members are the listing agent, will be included on 
the My Listings page. 

To select team members:

1. From the Website Configuration page, click the Team Management button.
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The Team Settings page opens. 

Your office members must first give their permission to be selected as 
teammates. Those who have granted you permission, are listed in the top list 
box.

2. To grant permission to other members in your office to add you as a teammate, 
click the Add Team Permission link.
The Member Lookup dialog box opens.

3. Enter the Agent’s First or Last Name (in total or in part) in the text boxes, then 
click the Find button.

4. Highlight the member from the search results in the list, then click OK.
The name appears in the bottom list box.

5. To remove permission from an Agent to use you as a teammate, highlight the 
Agent name in the bottom list, then click the Delete Team Permission link.

6. Click Close.

Managing Your Web Pages

Your Agent Website consists of a number of pages that can be renamed, displayed, 
hidden, and individually customized to your liking. Each page has several sub-
sections, that can also be edited and displayed.
There are two mode for editing the Home page: Easy mode and Advanced mode. 
Until you choose otherwise, you are working in Easy mode. See “Using Advanced 
Editing Mode” on page 250.
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To use the Agent web page manager:

1. From the Website Configuration page, click the Manage Web Pages button.
The Manage Pages page opens. By default, the Home page is displayed. 

2. Click on a page name in the navigation menu, located in the upper left corner, to 
display the web page you want to edit. 

NOTE! Since each page title is completely customizable, the page titles listed in the 
navigation menu can change accordingly. Only the Home page remains 
unchanged.

3. When you make changes to the pages, click:
• Save — to save the settings.
• Preview — view the changes as they will look on the web site.

NOTE! Every page has a Page Properties and Tag Line section. The remaining 
sections differ for each page and will be described separately. 

Customizing the Home Page

Editing the Home page is slightly different than editing the rest of the pages. Since it 
is accessed by an icon embedded on your Web site, certain elements cannot be 
changed. For instance, you can never rename the Home page or disable it. For that 
reason, the Page Properties section of the Home page is NOT available to you. 

Showing a Feature Property

You can display one or more featured properties on your website, along with a 
personalized sales pitch, to entice interested buyers. 

To show a featured property on the Home page: 

1. Select the Feature this property check box in the section header.
2. Click one of these options:

• ML Number — enter a single listing’s ML number in the text box.
• Cycle through Featured Properties — enter an ML number for multiple 

listings in the text box; one per row.
Note: The MLS numbers must be actively on the market in order to be 
displayed on your Agent website. If an ML number is not valid, or the 

Pages that are 
included, show a 
green check mark.
Pages not currently 
displayed on your 
Web site, show a red 
“X” beside the page 
name. 
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property comes off the market, the property will no longer be displayed 
on your site.

The featured listing will be displayed on your website. For multiple listings, a 
random shuffle of the featured properties list will occur each time the Home 
page loads. 

3. To add your personal Sales pitch text beneath the featured property, type it in the 
text box. 
• click the Spell Check icon to check for possible errors.

4. Click Save.

Customizable Sections on the Home Page

The bottom part of the Home page consists of a number of unnamed sections 
reserved for entering free-form text. You can enter your own text or choose from the 
lists of pre-written content, letting TEMPO 5 take care of the formatting for you.

To display a customized section on your Web site:

1. Select the Section [#] check box in the section header.
This ensures the content will be displayed on the Home page. 

2. Type a section sub-heading in the text box.
3. Enter your own Body text; or choose a pre-written paragraph from the drop-

down list to the right.
• click < Prev and Next > to browse through the list of pre-written content.

4. To apply formatting to the free-form text, such as bolding, italics, etc., use the 
cursor to highlight a section of text, then click the appropriate formatting tool bar 
button above the text box. 
• To undo the applied formatting, click the button again.

5. Click Save.

Adding a Call-out

A call-out is a short paragraph that appears in a slightly different style or format from 
the rest of the body text in order to draw the reader’s attention to it. The call-out may 
be a favorite quote, your business philosophy, etc. 

To add a custom Call-out to the Home page:

1. Select the Call-out check box in the section header.
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This ensures the content will be displayed on the Home page.
2. Type a section sub-heading in the text box. 
3. Enter your own Body text; or choose a pre-written paragraph from the drop-

down list to the right.
• click < Prev and Next > to browse through the list of pre-written content.
• click the Spell Check icon to check for possible errors.

4. Click Save.

Using Advanced Editing Mode

When formatting sections of the Home page, you can use a more sophisticated 
formatting tool, called the Advanced Home Page Editor, to achieve a completely 
customized look. Similar to a true word processor, this feature lets you control the 
formatting. For even greater control, you can even edit the Home page’s HTML code.

NOTE! It is assumed you are familiar with the use of formatting styles using a word 
processor like Microsoft Word. Therefore, this section will not go into detail.

To use the Advanced Home page editor:

1. In the right corner of the Page Properties section of the Home page, click the 
Show Advanced mode link.
The Website Manager reloads to show the page in Advanced editing mode.

2. To create or edit the page, click the Design button at the bottom of the text 
frame (by default it should already be selected).

3. Use the Editor Features menu to insert new items, such as tables, images, URL 
links and lines; and to define formatting attributes for selected text. The toolbar 
above the text box frame performs the same function.
For example, click the Paragraph Style icon to specify alignment, color and text 
display attributes from the Paragraph Style Selection dialog. 
• click the Features button to return to the Editor Features main menu.

4. Click the toolbar icons above and below the body text frame to apply formatting 
styles to selected text, cut, copy, paste, etc.

5. Click HTML at the bottom of the body text frame to edit the Home page’s 
HTML code directly.
• click Preview to view the results.
• click Design to return to the original body text view.

6. Click Save.
7. Click Use Easy mode to return to the original view of Home page.
8. Click Save.
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Customizing the Featured Property Page

NOTE! Pages that are not currently included on your Web site, show a red “X” beside 
the page name in the navigation menu. 

Use the Featured Property page to feature current listings and recently sold properties 
on your Web page, with relevant tag lines. 

Changing Page Properties

The Page Properties section lets you change a selected page’s menu title and specify 
whether it can be accessed from the Home page or not.

NOTE! You have NO access to the Page Properties section for the Home page. 
The menu title and its availability from the main menu are permanently defined. 

To change the page properties:

1. From the Page Properties section of the selected page:
• type a new name in the Menu title text box.
• select the Make this page available from the main menu check box to 

display this page on the main menu of the web site’s Home page; or clear the 
check box to hide the page entirely.

Note: If the selected page is NOT being displayed on the Home page, 
the navigation list displays a red “ ” next to the page’s name. If the 
selected page IS available from the Home page, the navigation list 
displays a green “ ” next to the page’s name.

2. Click Save.
3. Click Preview to review these changes.

Displaying Tag Lines

Customize each page by adding a “catch-phrase” at the top of the page, called the Tag 
Line, or hide it altogether. An example is “Excellence in Real Estate”. You can choose 
what the tag line says and whether or not to display it.

To specify a tag line to display on a selected page:

1. Select the Tag Line check box in the section header.
The other options are enabled.

2. Use the drop-down list to select the name of a pre-defined tag line, such as 
Excellence; or click the < prev or next > links to scroll through the available tag 
titles, when you have several.

3. Create your own Tag Line by typing in the text box. 
• Click the Spell Check icon to check for possible errors.

4. Click Save.
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Title for On Market and Off Market Featured Properties

Add a section title to accompany the featured listings and recently sold properties on 
your Web site. For example, you may entitle the active listings “For Sale” and the 
properties with a Sold status, “Recently Sold”.

To add featured listings and sales currently available:

1. Select the Title for [On-Market/Off-Market] Featured Properties check box 
in the section header to display this section on the Featured Property page.

2. Type a section title in the text box. 
3. In the Title for On-Market section, add the ML numbers of the active listings 

you want to feature in the list: (one number per row).
• if there are no featured listings currently available, enter some explanatory text 

in the No properties found text box. 
4. In the Title for Off-Market section, add the ML numbers of the sold properties 

you want to feature in the list: (one number per row).
• if there are no featured sales currently available, enter some explanatory text 

in the No properties found text box.
5. Click Save. 

Customizing the Property Search Page

NOTE! Pages that are not currently included on your Web site, show a red “X” beside 
the page name in the navigation menu. 

You can display several types of search templates on the Property Search page of your 
Web site. Each search link lets a client search for a specific property type, revising the 
criteria if necessary, to find meaningful results. Also, they can be tagged to show on 
the Home page. 

To customize the Property Search page:

1. From the Page Properties section change the name of the page, or hide this page 
from being displayed on your website.

2. In the Tag Line section, change the title at the top of the page, or hide this page. 
See “Customizing the Featured Property Page” on page 251.

3. In the Property Search section, select the check box in the header to display this 
section on the Property Search page. 

NOTE! The search types featured on this page are determined by your MLS Board. 

4. Click Save.

Customizing the Listings Pages

NOTE! Pages that are not currently included on your Web site, show a red “X” beside 
the page name in the navigation menu. 
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The My Listings page lets you display the on-market listings that belong to you; and 
the Office Listings page lets you display the properties that have been listed with your 
office.

To customize the Listings pages:

1. From the Page Properties section, change the name of the page or hide this 
page from being displayed on your website. See “Configuring an Agent or Broker 
Website” on page 241.

2. In the Tag Line section, change the title at the top of the page, or hide this page. 
See “Customizing the Featured Property Page” on page 251.

3. In the My Listings or My Office Listings section, select the check box in the 
header to display the section on the My Listings and My Office Listings pages. 

4. Add the ML numbers of the sales you want to feature in the list (one number per 
row).
• if there are no featured sales currently available, enter some explanatory text 

in the No properties found text box.
5. Click Save. 

Customizing the Buying/Selling Page

The bottom part of the Buying/Selling page consists of a number of unnamed 
sections reserved for entering free-form text. You can enter your own text or choose 
from the lists of pre-written content, letting TEMPO 5 take care of the formatting for 
you. 
Perhaps you might want to offer hints about buying or selling, or why a client should 
use a Realtor®, etc. 

To customize the Buying/Selling page:

1. From the Page Properties section, change the name of the page or hide this 
page from being displayed on your website. See “Configuring an Agent or Broker 
Website” on page 241.

2. In the Tag Line section, change the title at the top of the page, or hide this page. 
See “Customizing the Featured Property Page” on page 251.

3. Select the Section [#] check box in the section header.
This ensures the content will be displayed on the Buying/Selling page.

4. Type a section sub-heading in the text box and enter your own body text; or 
choose a pre-written paragraph from the drop-down list to the right of the text 
box.
• click < Prev and Next > to browse through the list of pre-written content.

5. To apply formatting to the free-form text, such as bolding, italics, etc., use the 
cursor to highlight a section of text, then click the appropriate formatting toolbar 
button above the field. 
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• To undo the applied formatting, click the button again.
6. Click Save.

Setting Up the ‘Contact Me’ Form

The Contact Form is a page that facilitates your clients getting in touch with you. 
They complete the form with their contact information and property details. A click 
of the Send E-mail button sends the information directly to you. While you cannot 
edit the form, you can add a subtitle and introductory paragraph.

To set up the Contact form:

NOTE! Pages that are not currently included on your Web site, show a red “X” beside 
the page name in the navigation menu. 

1. From the Page Properties section, change the name of the page or hide this 
page from being displayed on your website. See “Configuring an Agent or Broker 
Website” on page 241.

2. In the Tag Line section, change the title at the top of the page, or hide this page. 
See “Customizing the Featured Property Page” on page 251.

3. In the Contact Form section, select the check box in the header to display this 
section on the Contact Me page.

4. In the Body text box, add an introductory paragraph.
5. Click Save.

How Prospects Contact You

TEMPO 5 makes it easy to add your contact information, such as an e-mail signature, 
to your Website profile. Specify an alternate “Reply To” e-mail address and set up 
your e-mail enabled cell phone or pager to receive new prospect matches. 

To change your contact information:

1. From the Website Configuration page, click the My Profile button.
The My Profile page opens. 

2. Make the necessary changes or additions to your contact information:
• Primary e-mail address
• Pager/Cell e-mail
• Reply to e-mail address
• E-mail signature
• Name, Address and Company information
• Primary, cell phone, 1-800, fax, numbers, web URL and Pager and PIN 

numbers
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3. Make sure the information is complete and accurate.
4. Click Save.

A message dialog confirms that the changes have been saved.
Click OK. 

Managing Website Images

Use the My Image Library page to add a personal image or company logo to your 
website.

NOTE! Most styles of website look best using the Agent Photo and/or Office Photo.

To add images to your website:

1. From the Website Configuration page, click the Image Library button.
The My Image Library page opens.

2. Click the Headshot and Company Logo drop-down lists and choose 
appropriate images to use.

3. Click the Manage Images links to display the Manage Images page, where you 
can add, edit and delete a wider range of images.

4. Click Preview to view what the image will look like on the web page.
5. Click Save.
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Setting Up Branding Preferences

TEMPO 5 enables you to easily set up and manage the appearance and content of the 
Client Gateway for your prospects. From this page, you can specify your branding 
content, then preview it as your prospects would see it.

To set up Client Gateway branding preferences:

1. Click My Tools > Preferences > Client Gateway. 
The Client Gateway Branding Content page opens.  

2. Select the check boxes for the items you want included, such as a photo, logo or 
company information.

3. Click Save.
NOTE! The clock icon indicates that any changes made may take up to one hour 

before taking effect.

4. Click the drop-down list box and select a client to preview these settings.
The Personalized Real Estate Site for [client name] opens automatically in a new 
browser window. See “Viewing in Agent Access Mode” on page 259.

5. Close the browser window when you are done.

From the My 
Preferences & 
Settings page, 
click My Photos 
to add or change 
your photo 
selection.
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Viewing in Agent Access Mode

You can preview the Client Gateway as your prospects would see it, but with a few 
differences in functionality:
• The Reject tab is only available in Agent Access Mode.
• Saving a property as a Favorite or Possibility is not available in Agent Access 

Mode.
• Deleting a property (which moves it to the Rejects folder) is not available in 

Agent Access Mode.
• Adding notes to saved listings is not available in Agent Access Mode.
While you cannot save or delete listings, or add notes, in Agent Access Mode, this 
functionality is available within Tempo from the Prospect Manager and the hover bar 
in all search results lists.
The branding content you specified is displayed. 

To view the Client Gateway in Agent Mode:

1. From the main menu, click Prospects, and then click Prospect Manager.
The Prospect Manager page opens. See “Working with the Prospect Manager” on 
page 87.

2. Click the [ ] icon that appears in the last column of a prospect on the Prospect 
Manager page. 
Note: The icon is displayed only for those prospects who have access to 
a personalized page on your web site. 

The Personalized Real Estate Site for [Prospect Name] page opens in a new 
Browser window. 

3. The following hyperlinks are available:
• View My Listings — opens the Search Results page of your current 

inventory.

TIP ... You can 
also click the 
Prospect Name 
hyperlink to open 
the contact 
record. Then, 
click the Client 
Gateway tab.

Message 
indicates that the 
view is in “Agent 
Mode”.
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• Email Me — opens an Email pop-up window, addressed to you from the 
prospect.

4. Click each of the tabs to view property details within the category.

My Searches Tab

This page lists all defined searches that are associated with the prospect, provided 
auto-notification is turned ON and hasn’t expired. See “Setting Up Notifications” on 
page 101. The prospect can view properties, saving those they like as Favorites or 
Possibilities. 

To view search details:

1. Click the View Properties link of the search you want to see.
A list of search results opens. 

2. Review the property information, including notes. Click the photo to see an 
enlargement.

3. Click the Sort by drop-down arrow and choose a category to sort by: Match 
Date, Address, List Price, etc.

4. Select either the Ascending or Descending sort option button.
5. Click Map Properties to view a map of the property.
6. If there are multiple pages, click either the Page or Next links on the right side.
7. For each property, click the View Details link to request more information, view 

photos, print a flyer, map property, request more information etc. 

My Favorites Tab

This page lists properties you save as your “favorites”, along with any associated 
comments. New comments are indicated by a yellow New icon.

To view favorite properties:

• View the details of your favorite properties using the same sorting, mapping tools 
as found on the My Searches tab. See “My Searches Tab” on page 260.

Click the Sort by 
drop-down list and 
select the 
Ascending or 
Descending option 
buttons to list the 
properties 
accordingly.
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My Possibilities Tab

This page lists properties you saved as “possibilities”, along with any associated 
comments. 

To view possible properties:

• View the details of the possible properties using the same sorting, mapping tools 
as found on the My Searches tab. See “My Searches Tab” on page 260.

Agent Recommendations Tab

This page lists agent recommended properties, along with any associated comments.

To view agent recommendations:

• View the details of Agent recommended properties using the same sorting, 
mapping tools as found on the My Searches tab. See “My Searches Tab” on 
page 260.

Rejects Tab

Note: This tab is only available to the Agent when viewing the Client 
Gateway in Agent Mode. Prospects do not see this tab.

This page displays the properties that have been rejected by either you or your 
prospect.

To view rejected properties:

• View the details of rejected properties using the same sorting, mapping tools as 
found on the My Searches tab. See “My Searches Tab” on page 260.

Additional Properties

This page displays listings that were manually e-mailed to your prospect.

To view additional properties:

• View the details of additional properties using the same sorting, mapping tools as 
found on the My Searches tab. See “My Searches Tab” on page 260.
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Viewing in Prospect Mode

When you e-mail selected properties of interest to a prospect, you can add them to 
the Client Gateway as Agent Recommendations. This means that when your prospect 
clicks the personal property search web site link from your e-mail message, they can 
view property details, your comments and ratings. In addition, they can add properties 
to their Favorites or Possibilities categories, or delete them.
When your prospect receives listings through e-mail, the Gateway link in the message 
will take the prospect directly to those listings. Links in autonotification e-mails open 
the Gateway page for the custom search that returned the listings (with the new or 
changed properties at the top of the list); links in manually-sent e-mails link directly to 
the Additional Properties tab, where the listings you sent are displayed first.

To view the Client Gateway in Prospect Mode:

1. Perform a property search, then click the Email button.
2. Select the Send link to Client Gateway option button.
3. From the e-mail message, click the Click here to view your personal property 

search web site link.
A new browser window opens displaying the selected search results. The 
column header will say New Emailed Property. 

4. On the My Searches tabbed page, click the Sort by drop-down arrow and choose 
a category to sort by: Match Date, Address, List Price, etc.

5. Select either the Ascending or Descending sort option button.

Your personal 
greeting is 
displayed here.
Notice that the 
Rejects tab is not 
available in 
Prospect Mode.
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6. If there are multiple pages, click either the Page or Next links on the right side.
7. For each property, click the View Details link to see more information, view 

photos, print a flyer, etc.
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Printing Contact Information

The Print feature lets you print contact information in a variety of different formats, 
from contact lists to custom-designed reports and mailing labels. 

Client Lists

The Contact Manager page displays a list of client records. Depending on the Display 
filter chosen, you can list only specific types of contacts. 

To print a client list:

1. From the Contact Manager page:
• select a single client record from the list, point to the Information icon to 

display the Quick Access menu, then click the Print icon; or
• select multiple client records in the list, then click the Print button in the 

bottom right corner of the page.
The Print dialog box opens. 

NOTE! Regardless of which clients you selected in the Contact Manager list, you can 
still change your selection directly from the Print dialog.

2. Choose one of the client option buttons:
• Single Client — click the drop-down list and select an individual client by 

name. This selection can be different from the one you selected earlier.
• Selected Clients (#) — click this option to print the client records you 

selected on the Contact Manager page. 
• All Clients (#) — select this option to print a list of all client records in the 

TEMPO 5 database. The total number is displayed in brackets.
3. Select the Print the Clients Grid option. 
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Note: If you are printing a report or labels, see “Client Reports” on page 267 
and “From the security settings panel, click the Trusted Sites icon.” on page 271.

The Grid Print Options appear in the bottom section of the dialog. 
4. Select a Paper size option: Letter or Legal.
5. Select the Layout or orientation option: Portrait or Landscape.

NOTE! If you choose Landscape orientation for your page Layout, you may also have 
to set your printer’s paper orientation to Landscape. To do this, click Properties 
on the Print dialog box before starting the print job.

6. Click Preview to see what the report will look like.
Note: The Save as PDF button is not available for this report.

7. Click Print. 
A standard Windows Print dialog box opens.

8. Choose any additional options (e.g., number of copies, destination printer, etc.).
• click Properties to specify your printer’s Layout and Paper/Quality 

settings.
9. Click OK.

Client Reports

A client report is more than just the grid list of column information. It shows the 
details of each of the selected client records, depending on the report layout you have 
applied.

To print a detailed client report:

1. From the Contact Manager page:
• select a single client record from the list, point to the Information icon to 

display the Quick Access menu, then click the Print icon; or
• select multiple client records in the list, then click the Print button in the 

bottom right corner of the page.
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The Print dialog box opens. 

2. Select the Print report(s) option, if it is not already selected.
Note: If you are printing a client grid list or labels, see “Client Lists” on 
page 266 and “From the security settings panel, click the Trusted Sites icon.” on 
page 271.

The report page options appear in the top of the dialog, and the Report 
Printing Selections appear in the bottom of the dialog.

3. In the Report Printing Selections section, select one or more reports you want 
to print from the list. 
• to select multiple reports, hold down the CTRL key and click.

4. In the top section of the dialog, the report page options are displayed, depending 
on the types of reports you selected:
• Single Page — click the drop-down list and select the page you want to print, 

e.g. Page 1 of 2.
• Selected Clients (#) — click this option to print the selected reports for the 

clients currently selected on the Contact Manager page.
• All Pages (#) — select this option to print all pages of the report. The total 

number is displayed in brackets.
5. Click Preview to see what the report will look like.
6. Click the Save as PDF button to save the report in Portable Document Format. 

See “Saving a Report as a PDF Document” on page 269.
7. Click Print. 

A standard Windows Print dialog box opens.
8. Choose any additional options (e.g., number of copies, destination printer, etc.).

Make sure you select the 
client(s) from the grid before 
you select the Print report 
option. The top section of the 
Print dialog replaces client 
selection with report page 
selection.
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• click Properties to specify your printer’s Layout and Paper/Quality 
settings.

9. Click OK.

Saving a Report as a PDF Document

Instead of printing a hard copy of the report, you can save it as an electronic copy. 
Portable Document Format (PDF) is a very useful way to save and store documents.

Note: The Save as PDF option is not available for client list reports, or 
mailing labels.

1. From the Print dialog box, click the Save as PDF button.
The Save Report as PDF dialog opens. 

2. Enter a File name in the field.
3. In the Select your PDF quality section, choose the option that best suits your 

needs:
• Low — maximum file compression means a smaller file size for the fastest 

download time. Quality is low.
• Medium — average file compression means a medium file size for an average 

download time. Quality is average. 
• High — minimum file compression means a larger file size for the slowest 

download time. 
4. Click OK.

Click this link for 
important Browser 
information.
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The File Download dialog opens, asking if you want to open or save the file. 

5. Click Open to see the document in Adobe® Reader®.
Note: If you don’t have Adobe Reader, you can download it for free 
from the Adobe Web site. 

6. Click Save to store the document on your computer. 
The Save As dialog opens.

7. Navigate to a location on your computer, then click Save.

Internet Explorer Settings for Saving Reports as PDF Documents

When you try to save a report as a PDF document, Internet Explorer may prompt 
you to allow the download. You may be able to eliminate these prompts by changing 
your browser settings.

Note: Before you begin, your Tempo site must be included in your list of 
Internet Explorer trusted sites. See the Internet Explorer help files, or 
click the browser information link in the Save Report as PDF dialog, for 
instructions on how to add Tempo to your trusted sites list.

To change your browser settings:

1. Double-click the Trusted Sites icon in the browser’s status bar [ 

]. The Internet Explorer security settings panel will open:
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2. From the security settings panel, click the Trusted Sites icon.
3. Click the Custom Level button to open the trusted sites security settings panel. 

4. Scroll down to the Downloads section and enable the Automate prompting for 
file downloads setting.

5. Click OK.
6. When prompted to confirm the change, click Yes. The trusted sites security 

settings panel will close.
7. Click OK to close the Internet Explorer security settings panel.
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Client Labels

Client labels are mailing labels set up in a report format.

To print client mailing labels:

1. From the Contact Manager page:
• select a single client record from the list, point to the Information icon to 

display the Quick Access menu, then click the Print icon; or
• select multiple client records in the list, then click the Print button in the 

bottom right corner of the page.
The Print dialog box opens. 

2. Select the Print labels option, if it is not already selected. 
Note: If you are printing a client grid list or a report, see “Client Lists” on 
page 266 and “Client Reports” on page 267.

The label report page options appear in the top of the dialog, and the Label 
Printing Selection options appear in the bottom of the dialog.

3. In the Label Printing Selection section in the bottom of the dialog, click:
• the Select a label to print drop-down list and choose the label report, such as 

Client Label.
• the Label style drop-down list and choose the Avery number that matches 

the kind of labels you are using.
4. In the top of the dialog, choose one of the label page options:

• Single Page — click the drop-down list and select a label page(s) to print, e.g. 
Page 1 of 1.

Select Print labels.
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• Selected Clients (#) — click this option to print labels for the clients 
currently selected on the Contact Manager page.

• All Pages (#) — select this option to print all pages of the label report.
5. Click Preview to see what the report will look like.

Note: The Save as PDF button is not available for this report.

6. Click Print. 
A standard Windows Print dialog box opens.

7. Choose any additional options (e.g., number of copies, destination printer, etc.).
• click Properties to specify your printer’s Layout and Paper/Quality 

settings.
8. Click OK. 
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Printing Listing Search Results

The Print feature lets you print property listing information in a variety of different 
formats, from property lists to custom-designed detailed reports. 

Property Lists

The Search Results page displays a list of property records that match a query. 
The property lists can be printed from the Search Results or Search Details pages. 

To print a list of search results:

1. From the Search Results page:
• select a single listing record from the list, point to the Information icon to 

display the Quick Access menu, then click the Print icon; or
• select multiple listing records, then click the Print button in the bottom right 

corner of the page.
Note: To print all of the records, do not select any of them.

The Print dialog opens. 

NOTE! Regardless of which properties you selected on the Search Results list, you can 
still change your selection directly from the Print dialog.

2. Select the Print the Search Results Grid option if it is not already selected.
Note: If you are printing a listing report, see “Detailed Listing Reports” on 
page 275. Label printing is not available for listing reports.

3. In the top of the dialog, choose one of the options:
• Single Property — click the drop-down list and select a property listing to 

print.

Select Print the 
Search Results 
Grid option.
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• Selected Properties (#) — click this option to print the listing records you 
selected on the Search Results page.

• All Properties (#) — select this option to print all listings.
4. In the Grid Print Options section, select:

• a Paper size option: Letter or Legal.
• the Layout or orientation option: Portrait or Landscape.

NOTE! If you choose Landscape orientation for your page Layout, you may also have 
to set your printer’s paper orientation to Landscape. To do this, click Properties 
on the Print dialog box before starting the print job.

5. If you want the report to show the search criteria you used to find the listings, and 
their search statistics (e.g., average list price, average sale price, days on market, 
etc.), select the Print search criteria and statistics check box.

6. Click Preview to see what the report will look like.
Note: The Save as PDF button is not available for this report.

7. Click Print. 
A standard Windows Print dialog box opens.

8. Choose any additional options (e.g., number of copies, destination printer, etc.). 
• click Properties to specify your printer’s Layout and Paper/Quality 

settings.
9. Click OK.

Detailed Listing Reports

The detailed listing reports can be printed from the Search Results or Search Details 
pages. If you choose Print from the Search Details page, there may be additional print 
options, such as the ability to print a Tax report.

To print a detailed listing report:

1. From the Search Results page: 
• select a single property listing from the list, point to the Information icon to 

display the Quick Access menu, then click the Print icon; or
• select multiple property listings in the list, then click the Print button in the 

bottom right corner of the page. 
Note: To print all of the records, do not select any of them.
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The Print dialog box opens. 

2. Select the Print report(s) option, if it is not already selected.
Note: If you are printing a property list, see “Property Lists” on page 274.

The report page options appear in the top of the dialog, and the Report 
Printing Selections appear in the bottom of the dialog.

3. In the Report Printing Selections section, select one or more reports you want 
to print from the list. 
• to select multiple reports, hold down the CTRL key and click.
Note: The reports highlighted in yellow are your favorite reports. 
See “Choosing Your Favorite Reports” on page 46.

4. In the top section of the dialog, the report page options are displayed, depending 
on the types of reports you selected:
• Single Page — click the drop-down list and select the page you want to print, 

e.g. Page 1 of 6.
• Selected Properties (#) — click this option to print the property listings you 

selected on the Search Results page.
• All Pages (#) — select this option to print all pages of the report. The total 

number is displayed in brackets.
5. To include a tax report (not available in all areas), select the Tax Report check 

box, then use the drop-down list to select the name of a report.
6. To include a history report, select the Property History check box, then use the 

drop-down list to select the name of a report. 
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7. If you want the report to show the search criteria you used to find the listings, and 
their search statistics (e.g., average list price, average sale price, days on market, 
etc.), select the Print search criteria and statistics check box.

8. Click Preview to see what the report will look like.
9. Click the Save as PDF button to save the report in Portable Document Format. 

See “Saving a Report as a PDF Document” on page 269.
10. Click Print. 

A standard Windows Print dialog box opens.
11. Choose any additional options (e.g., number of copies, destination printer, etc.). 

• click Properties to specify your printer’s Layout and Paper/Quality 
settings.

12. Click OK.
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Printing Hotsheet Reports

The Hotsheet Search Reports page displays a list of property records that match a 
specific Hotsheet query. Using various filters you can narrow the list of information. 
Using the Displays drop-down list you can apply a number of different column 
layouts and print the resulting report. 
When you click the Reports tab to view the listing details, there are multiple tabs 
containing different types of data, for example, MLS Data, Tax Data, etc. Print a 
detailed report no matter which tab you are viewing. Reports include MLS Data, 
Property History and Tax information.

Hotsheet Lists

The Hotsheet Search Results page displays a list of records, also known as the results 
grid, that match the search criteria. The grid is a summary view, which you can print 
or e-mail, using the Default hotsheet display layout or other column reports. 
See “Managing Column Reports” on page 318.

To print a list of hotsheet search results:

1. From the Hotsheet Search Results page, select one or more listings in the list, 
then click the Print button in the top, right corner of the page. 
The Print dialog opens. 

NOTE! Regardless of which hotsheets you selected on the Results list, you can still 
change your selection directly from the Print dialog.

2. Select the Print the Search Results Grid option if it is not already selected.

Select the 
Print the 
Search 
Results Grid 
option.
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Note: If you select the Print report option, the details from the MLS 
Data tab of the listing record is printed. see “Detailed Hotsheet Reports” on 
page 279. Label printing is not available for hotsheet reports.

3. In the top of the dialog, choose one of the options:
• Single Section — click the drop-down list and select a type of property to 

print. 
• All Sections — click this option to print all hotsheet sections.
• Selected Properties (#) — click this option to print only those listing 

records you selected on the Hotsheet Search Results page.
• All Properties (#) — select this option to print all listings on the Hotsheet 

Search Results page.
4. In the Grid Print Options section, select:

• a Paper size option: Letter or Legal.
• the Layout or orientation option: Portrait or Landscape.

NOTE! If you choose Landscape orientation for your page Layout, you may also have 
to set your printer’s paper orientation to Landscape. To do this, click Properties 
on the Print dialog box before starting the print job.

5. If you want the report to show the search criteria you used to find the listings, and 
their search statistics (e.g., average list price, average sale price, days on market, 
etc.), select the Print search criteria check box.

6. Click Preview to see what the report looks like.
Note: The Save as PDF button is not available for this report.

7. Click Print. 
A standard Windows Print dialog box opens.

8. Choose any additional options (e.g., number of copies, destination printer, etc.). 
• click Properties to specify your printer’s Layout and Paper/Quality 

settings.
9. Click OK.

Detailed Hotsheet Reports

The Hotsheet Reports page displays the detailed property information for the listings 
that match the search criteria. If you choose Print from the Reports page, you can 
generate additional types of detailed reports, such as a Tax report, depending on 
which of the tabs you have selected.

To print one or more detailed Hotsheet reports:

1. From the Hotsheet Reports page, scroll through the properties and select one or 
more listings. 
• click the drop-down list, highlight a specific address, and select the check box.
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2. Click the View drop-down list in the top right corner and select the type of report 
you want.

3. Click the Print button in the bottom right corner of the page. 
The Print dialog opens. 

NOTE! Regardless of which properties you selected on the Search Results list, you can 
still change your selection directly from the Print dialog.

4. Select the Print report(s) option if it is not already selected.
Note: If you selected the Print the Search Results Grid option, the grid 
list is printed. See “Printing Hotsheet Reports” on page 278. Label printing is not 
available for hotsheet reports.

5. In the top of the dialog, choose one of the options:
• Single Property — the field displays the address of the record you are 

currently viewing. Click the drop-down list to select a different address.
• Selected Properties (#) — click this option to print the property listings you 

selected on the Hotsheet Search Results page.
• All Properties (#) — select this option to print all pages of the selected 

reports. The total number is displayed in brackets.
6. In the Report Printing Selections section, select one or more reports to print 

from the drop-down list.
• hold down the CTRL key and click to select multiple reports.

Remember, your 
favorite reports are 
marked in yellow and 
appear at the top of 
the list. 
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Note: When you select a report with multiple pages, the options in the 
top part of the dialog change to allow you to print specific pages. 

7. Click one or both of the check boxes, if you want to print these additional reports:
• Tax Report — click the drop-down list and choose a report.
• Property History — click the drop-down list and choose a report.

8. If you want the report to show the search criteria you used to find the listings, and 
their search statistics (e.g., average list price, average sale price, days on market, 
etc.), select the Print search criteria check box.

9. Click Preview to see what the report looks like.
10. Click the Save as PDF button to save the report in Portable Document Format. 

See “Saving a Report as a PDF Document” on page 269.
11. Click Print. 

A standard Windows Print dialog box opens.
12. Choose any additional options (e.g., number of copies, destination printer, etc.). 

• click Properties to specify your printer’s Layout and Paper/Quality 
settings.

13. Click OK.
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Printing a CMA Presentation

Once the CMA presentation is complete, there are a couple of ways to present the 
final report to your client. You can save the presentation as a PDF file, which can be 
easily distributed. The recipient requires Adobe® Reader (available for free from the 
Adobe web site) to open and read a PDF file. 
You can print a CMA presentation, in its entirety or one page at a time. 

To print a selected CMA:

1. From within the CMA Report Wizard, click step #8 — View Report, to go to 
the View Report page. 

2. To add, remove and/or change the order of the pages in the CMA presentation, 
click step #7 — Select Pages in the CMA Report Wizard side panel. 
See “Selecting Pages for the CMA Presentation” on page 164.

NOTE! Adding, removing, and changing the order of the reports in this way does NOT 
change the presentation template, only this particular CMA presentation.

3. Click one of the print buttons: 
• Print Current Page — lets you print a single selected page of the CMA.
• Print — lets you print the entire CMA presentation. 
A standard Windows Print dialog opens. 

4. Choose any additional report options (e.g., number of copies, destination printer, 
etc.), then click Print.

5. Click Close. 
You are returned to the CMA Manager.
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Overview

TEMPO 5 contains a variety of tools for performing maintenance in the following 
areas: 
• Preferences — Use the My Preferences & Settings page to customize a wide 

range of program settings, including your contact information, photos, favorite 
reports, e-mail preferences, default prospecting templates, website management 
and Home page resource links to reflect your personal preferences. This 
functionality is described in another section. See “Personalizing Settings for the Way 
You Work” on page 34.

• Staff Tools — These tools include the Listing Manager, Hotsheet Manager, 
Membership/Office maintenance, Images, Message of the Day, Third Party 
Maintenance and System Tools. Listing Manager is discussed in another section. 
See “Listing Manager” on page 111.

• Change Password — Use the Change Password and Secret Question page to 
change your password for logging in to TEMPO 5. If you should forget your 
password, you can enter your secret question and answer as a way for the system 
to identify you. This functionality is described in another section. See “Changing 
Your Password and Secret Question” on page 306.

• IDX Configuration — Access a list of accounts and owner profiles.
• IDX Member Permissions — Search for and modify member permissions. 
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Staff Tools

TEMPO 5 contains a variety of staff tools for performing membership and office 
maintenance, as well as links to Listing Manager, Hotsheet Manager, Images, Message 
of the Day, Third Party Maintenance and System Tools. 

NOTE! The Staff Tools area is reserved for those who have the necessary access 
privileges to set up and manage membership and office information, including 
images and Message of the Day content.

To access Staff Tools:

1. From the main menu, click My Tools > Staff Tools. 
The Tools page opens. 

2. Click the desired menu item in the sidebar. 
The corresponding page opens.

Listing Manager is discussed in 
another section. 
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Hotsheet Manager

The Hotsheet Manager lets you specify what report to use for each Hotsheet section 
on the home page, based on the property type.

NOTE! This is a system-wide area of the program. Any changes you save in this area 
will affect the entire site.

To specify default hotsheet reports: 

1. From the Tools page sidebar, click Hotsheet Manager.
The Hotsheet System View Defaults page opens. 

2. Click the Select a Property Type drop-down list and choose a category, for 
example, Residential/Condo.
The bottom section of the page displays the corresponding hotsheet sections 
within the selected property type and the currently selected report. The System 
Default column reminds you of the name of the system default report.

3. For each Hotsheet Section, click the corresponding Report drop-down list and 
choose the name of the report you want to load automatically.

4. Click the Save button.
5. Repeat steps 3-4 for each property type.
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Membership and Office Maintenance

Use the Membership/Office area to search for and find members or offices, manage 
existing user/office records, as well as to associate offices with firms. This is also 
where you can change a member’s professional e-mail address and manage member 
images.

Membership Maintenance

The Membership Maintenance tab is where you can look for a member by 
searching by name, Office ID, etc. If you know the agent Public ID number, perform 
a quick search to retrieve the member’s record. If there is no member record, add one 
and complete it now or later.

To search for a user:

1. From the Tools page sidebar, click Membership/Office.
2. Click the Membership Maintenance tab. 

3. Click the Search for user button.
A Search page with Member System Search criteria fields opens.

4. Enter the search criteria, then click Search (or the Search Results tab). 
See “Using the Search Criteria Page” on page 68.

5. From the Search results, select a record, then click Edit Selected User.
The user’s record opens for viewing. 

Any 
incomplete 
member 
records will be 
listed here.
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6. Click the links on the left side to expand each section and view the contents. 
For example, click Summary Report to view member information.
• click the link again to collapse the section.

7. Click the action buttons to perform more tasks: 
• Edit — retrieves the user’s record, letting you modify information.
• New — creates a new user record to submit or save as incomplete. 

See “Adding a New Member Record” on page 289.
• Copy — creates a new user record, by making a copy of this one.
• Delete — deletes the record.
• Print — lets you preview and print one or more member reports.

8. Click Close.

To search for a user by Public ID number:

1. From the Membership Maintenance page, enter the user’s PublicID number in 
the field.

2. Click the arrow [ ] button.
The user’s record opens for viewing. 

3. Follow step #6 - 8 above.

Member Images

You can only add and delete the images for one member record at a time.

To access the images for a selected member record:

1. From the Tools page, click Images to expand the section, then click Member 
Images.
The User Inventory > User Summary page opens.

2. Search for a member:
• click on the Search for Member link and perform a search. See “Using the 

Search Criteria Page” on page 68.
• enter the member’s ID number in the Lookup by User ID field, then click 

the arrow button. 
3. From the Search Results page, select one member then click the List Images 

with Selected Record button.
The images (if any) are loaded in the Images section of the Listing Summary 
page. The Record Type, Member Name, and Public ID for the selected 
member are displayed in the top left corner of the page. 
Note: You may find the Images are Locked, which means you do not 
have sufficient administration rights to edit them. 

4. Click on a frame to highlight it.
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A blue outline appears around the selected frame.
5. Do one of the following:

• click the Add New Image link
• click the Edit link.
• click the Delete link.
• click the Reorder Image arrow buttons to rearrange the position of the 

selected frame in the series.

To change the user’s professional e-mail address:

1. Search for and retrieve the member record which you want to edit.
2. Click the Professional Email Address link to expand the section.

The current e-mail address is displayed.
3. Click the Change link.

The Change Professional Email Address dialog box opens. 

4. Use the text box to type the new prefix to the e-mail address.
5. Click OK.

Adding a New Member Record

When you create a new user record, you can submit all the details, or enter only 
essential information, such as the name, and save it as “Incomplete”. Incomplete 
records are listed on the Membership Maintenance page until they have been 
completed and submitted. See “Completing an Incomplete Record” on page 290.

To create a new user record:

1. From the Tools page sidebar, click Membership/Office.
2. Click the Membership Maintenance tab. 
3. Click the Enter a new User button, located at the top of the page.
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The Add New User page opens. 

4. Enter the user’s information in the fields.
Note: All of the red fields [ ] are required and must be completed in 
order to submit this form.

5. Click one of the following action buttons: 
• Save as Incomplete — saves the unfinished record “as is” and lists it in the 

Incomplete User list on the main Membership Maintenance page.
• Submit — saves the user record with a valid Public ID number to the 

database.
• Cancel — cancels the current record. When the message box appears 

prompting you to confirm deletion, click OK.
• Print — previews and prints a Member Information report based on the 

existing amount of information.

Completing an Incomplete Record

Incomplete records are unfinished user records that have not yet been submitted to 
the database and, therefore, has been assigned a Temp number. If not completed by 
the 30-day Purge Date shown in the last column, an incomplete record will be 
automatically deleted.

To complete an incomplete record:

1. From the Tools page sidebar, click Membership/Office.
2. Click the Membership Maintenance tab. 

Click the Option List 
Display drop-down list 
to specify how the pick 
list fields display 
information: Default, 
All as Short Code or 
All as Long 
Description. 
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The Incomplete Users list is displayed. 

3. Click an item in the list. 
The corresponding user record opens.

4. Complete the fields are required, then click Submit. See “Adding a New Member 
Record” on page 289.
The item is no longer displayed in the Incomplete Users list.

Office Maintenance

The Office Maintenance tab is where you can perform a Search for office, or if you 
know the Office Code, perform a quick search to retrieve the office record. If there 
is no record, add a new office and complete it now or save it as incomplete for later.

To work with Office Maintenance:

1. From the Tools page sidebar, click Membership/Office.
2. Click the Office Maintenance tab. 

NOTE! The Office Maintenance area functions the same as the Member Maintenance 
area, from searching to saving incomplete records. Please follow the 
instructions in “Membership Maintenance” on page 287.

Office Images

You can only add and delete the images for one office at a time.

To access the images for a selected office:

1. From the Tools page, click Images, then click the Office Images tab.
The office record opens. 

2. Search for an office:
• click the Search for office button and perform a search. See “Using the Search 

Criteria Page” on page 68. From the Search Results page, select one property 
then click the List Images with Selected Record button.

• enter the office number in the Find an Office by Office Code field, then 
click the arrow button. 

The images (if any) are loaded in the Images section of the record. The Record 
type, Office Name and Office Code are displayed in the top left corner of the 
page. 
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Note: You may find the Images are Locked, which means you do not 
have sufficient administration rights to edit them. 

3. Click a frame to highlight it.
A blue outline appears around the selected frame.

4. Do one of the following:
• click the Add New Image link.
• click the Edit link.
• click the Delete link.
• click the Reorder Image arrow buttons to rearrange the position of the 

selected frame in the series.

Firm Maintenance

The Firm Maintenance tab is where you can manage the offices associated with 
specific firms. 

To work with Firm Maintenance:

1. From the Tools page sidebar, click Membership/Office.
2. Click the Firm Maintenance tab. 

3. Click the Available Firms drop-down list and select a firm.
• to add a firm, click the Add Firm button, enter the name and a description, 

then click Save.

4. Highlight an office in the Available Offices list, then click the left arrow [ ] 
button to move it to the Offices associated to above firm list.

5. Click Save.
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Managing Images

The TEMPO 5 image managing feature lets you add images directly to listings or to 
your MLS. In addition, you can upload images in bulk and generate a summary or 
detailed Image Report.

Listing Images

You can only add or edit the images for one listing at a time. 

To access the images for a selected listing:

1. From the Tools page sidebar, click Images. 
The Listing Images tab opens (default selection). 

2. Search for a listing:
• click on the Search for a listing link and perform a search. See “Searching” on 

page 63; or 
• enter the MLS number in the Find a listing by ML # field, then click the 

arrow button.
3. From the Search Results page, select one property then click the List Images 

with Selected Record button.
The property listing opens, displaying the listing’s images (if any). 

4. In the Images section, click on a frame to highlight the image.

The Property 
Type, 
Address, ML# 
and Status of 
the listing are 
displayed 
here.
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A blue outline appears around the selected frame.
Note: You may find the Images are Locked, which means you do not 
have sufficient administration rights to edit them. 

5. Do one of the following:
• click the Add New Image link.
• click the Edit link.
• click the Delete link.
• click the Reorder Image arrow buttons to rearrange the position of the 

selected frame in the series.
6. Use the Action buttons at the bottom of the page to perform more tasks on the 

selected listing. See “Listing Maintenance” on page 112.

MLS Images

This tab enables you to upload images to be used on your MLS Board, for example, 
logos, MLS staff, maps, letterhead, for sale sign images, etc.

To access the images for your MLS:

1. From the Tools page, click Images, then click the MLS Images tab.
The MLS Images page opens.
The images (if any) are loaded in the Images section of the record. 
Note: You may find the Images are Locked, which means you do not 
have sufficient administration rights to edit them. 

2. Click a frame to highlight it.
A blue outline appears around the selected frame.

3. Do one of the following:
• click the Add New Image link.
• click the Edit link.
• click the Delete link.

Bulk Image Upload

This tool lets you upload multiple images to multiple listings at one time. You should 
have a folder on your computer that contains all the image files you want to import to 
the server.

To access the Bulk Upload feature:

1. From the Tools page, click Images to expand the section, then click the Bulk 
Image Upload tab.
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NOTE! Active X controls must be installed for this option to work properly. You may 
see an ActiveX Install dialog box open with several options. Choose the option 
that matches your operating system and follow the on-screen instructions.

The Bulk Image Upload page opens. 

2. Click the Image File Directory drop-down list.
The Select Input File Specification dialog box opens. 

3. Navigate to where the images are saved on your computer, then select the ones 
you want to upload.
• hold down the CTRL key to select multiple images.

4. Click Open.
The Image File Directory field displays the file location, and a thumbnail view 
of the first image is displayed in the preview frame. The name of the image is 
displayed in the field adjacent to the Lookup button (Step 1 on the screen). 

Click the drop-
down list box to 
navigate to the 
images you want 
to upload.

Look here to see 
the image file name 
and path. 
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5. Click the Start button to begin the import process. 
• select the Auto process check box to upload all images automatically.

6. In the Enter ML Number of Listing field (Step 1 on the screen), type the ML 
number of a property to which you want to add the images, then click Lookup.
Note: You’ll have to type over the name of the image, which is currently 
displayed here.

Once the listing is found, the Address, Agent and Office information of the 
specified property is displayed. 

7. The images for the specified property can now be reviewed using the slots. 

• click on an image slot (row) to highlight it.
• click on the a highlighted row again to view the image. 

8. Click the Name drop-down list to select an image name (Step 3), such as 
Exterior Front.

9. To edit or crop the image, right-click on the preview (Step 4). 
A shortcut menu is displayed with the following commands:
• Crop Image As Displayed — if you’ve changed the image using the pan or 

zoom tools, choose this command to use the resulting image. 
• Convert To Grayscale — changes the image to grayscale.
• Enhance As Photograph — sharpens the image detail and sets the color 

contrast to look more like a photograph. 
• Make No Enhancements — click this command to undo any of these 

image effects you may have applied. The image is returned to its original state.
• Enhance As Drawing — changes the image to look like a drawing. 
• Display Popup Image — opens the full image in a separate window and 

displays it at 100%.
10. To change the size of the image, hold the right mouse button over the preview 

(Step 4) until the cursor changes to a four-headed arrow inside a square [ ], then: 
• move the mouse up to zoom in
• move the mouse down to zoom out

11. To pan the image from left to right or up and down, hold the right mouse button 
over the preview (Step 4) until the cursor changes to a four-headed arrow [ ], 
then:
• move the mouse up and down or left and right to pan in that direction.

12. Click the Save Your Changes check box (Step 5), then click Next. 

This slot is highlighted. 
Click it again to open the 
property image.

TIP ... To undo any 
of the image 
effects, simply 
click on the Make 
No Enhancements 
command.
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The image is uploaded into the property listing and the program advances to the 
next picture you uploaded.

13. Repeat steps #6-12 for each image you want to upload to the specified listing.
14. Once you’ve advanced through all the pictures, click the Finish button.

A Done folder is created in the original folder where the images were stored on 
your computer. Inside are the images that were successfully uploaded.

Image Report

You can generate either a detailed image report, or a summary report. View the 
report in your Browser or export the text.

To run an Image Report:

1. From the Tools page, click Images, then click the Image Report tab.
The Image Report page opens. 

2. Specify a date range for the report, using the suggested format; otherwise leave 
the fields blank:
• [Start/End] date/time — enter the date and time (mm/dd/yyyy) or (mm/

dd/yyyy/hh).
3. Select the Report Format: 

• Summary — gives an overview of image submittal by listing office code, 
login name, count and subtotal.

• Detailed — lets you generate more detailed reports. A secondary Subject 
drop-down list becomes available. Select a specific image report from the list. 
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4. Select the Report Medium:
• Browser View — displays the formatted report on the Image Report page of 

the application.
• Exported Text — saves the report as a text (.txt) file that can be imported 

into another program, such as Excel.
5. Click the Image Report button.
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Message of the Day

The Message of the Day enables you to read up on any new TEMPO 5 related news, 
as well as System, Broker, or Office news. Even thought the Message of the Day pops 
up after log-in, you may want to review the news later without having to log in again.

To view the Message of the Day:

1. From the Tools page, click Message of the Day, then click the View the 
Message of the Day tab.
The Message of the Day page opens, displaying several tabs: System, Broker 
and Office.

2. Click the tab of the type of news you want to read.
3. Scroll down or use the header bar along the top right corner to navigate to other 

sections of the page. 
Note: Each header bar within the dialog box has links that represent a 
different news category. Click a link to read the text message contained 
in the selected news category.

4. Click Print. 
A standard Windows Print dialog box opens.

5. Select any additional print options (e.g., number of copies, destination printer, 
etc.) and click OK to print the report.

6. Click Close.

Editing Message of the Day

In order to edit the message of the day, you need to have sufficient administrative 
access. See your System Administrator for more information.

To edit the Message of the Day:

1. From the Tools page, click Message of the Day, then click the Edit the 
Message of the Day tab.
The portion of the Message of the Day to which you have editing rights is 
displayed in edit mode. 

2. Enter or edit the comments in the message box.
3. Click the Spell Check button to search for any typos or spelling errors.
4. Click Preview to see how the message will look when saved and posted.
5. Click Save.

You are returned to the Tools page.
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Editing Terms of Use

The Terms of Use pop-up window is displayed when a user first logs in to TEMPO 5. 
These terms must be accepted by selecting an option button before the user can use 
TEMPO 5.

To edit the Terms of Use:

1. From the Tools page, click Message of the Day, then click the Edit the Terms 
of Use tab.
The Terms of Use message box is displayed.

2. Enter the message using basic HTML commands to format it.
3. Click Preview to see how the message will look when saved and posted.
4. Click Save.
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Third Party Maintenance

The Third Party Maintenance area lets you manage the third-party vendors and 
services that are currently available within TEMPO 5. You can add new providers 
(e.g. Google), specify an icon to be used to represent the service within TEMPO 5, 
set up logins and deny access.

To access third party maintenance:

1. From the Tools page sidebar, click the Third Party Maintenance link.
The Third Party Maintenance page opens. 

2. Click the drop-down list and select one of the following:
• Service Maintenance — add and set up a third-party service provider, 

choosing from a list of available services. Assign a SmartLink icon and add the 
URL, if required.

• Access Exclusions — maintain a list of Excluded User Classes to each of 
the available third-party providers. You can also delete a service provider 
from the list.

• Third Party Logins — assign public and private IDs for each available 
service.

3. Click OK.
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System Tools

The System Tools include MLS-related functions that let administrators manage the 
Home page links, generate database transaction reports, track field change history and 
add or edit field-specific Help instructions. 

NOTE! Not everyone will have access to this area.

Search IIS Logs

Enter search criteria to retrieve the server list, based on Client IP address, date, start 
and end times.

Copyright Configuration

Add or update copyright text, then preview it for accuracy.

Fax Attachment Status Manager

Enter the search criteria (Public and Transaction IDs) to retrieve the results as to the 
fax attachment status.

Edit Global Home Page Links

Use this system tool to add or edit the links found in My Sidebar. The changes take 
effect globally.
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To add or edit the links in My Sidebar:

1. From the Tools page, click System Tools, then click the Edit Global Home 
Page Links tab. 

2. In the Select a category list box, highlight:
• an existing category to see a list of resource links currently available.
• [New Category] to add a new resource link.

3. In the Category Name field, type a new name or edit the existing one.
4. In the Resource Link area, add or edit links, including a Description and the 

URL.
5. Click the Test Link link to verify that the URL is valid.
6. Scroll down and click the Apply button.

The changes will be made globally.

Database Transaction Report

Us this system tool to search for database transactions, such as list and sell transfers, 
then generate either a Database Transaction report or a Field Change History Report.
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To generate a Database Transaction report:

1. From the Tools page, click System Tools, then click the Database Transaction 
Report tab. 

2. Enter the search criteria and perform a search. See “Using the Search Criteria Page” 
on page 68.

3. Click the Data Transaction Report button.
A message box appears, displaying the number of matching records and asking if 
you want to execute the search.

4. Click OK to continue.
The Database Transaction Report is displayed.

5. Click Print.

To generate a Field Change History report:

1. From the Database Transaction Report tab, enter the search criteria and 
perform a search. See “Using the Search Criteria Page” on page 68.

2. Click the Field Change History Report button.
A message box appears, displaying the number of matching records and asking if 
you want to execute the search.

3. Click OK to continue.
The Field Change History Report is displayed.

4. Click Print.



My Tools

TEMPO 5 User Guide 305

Listing Maintenance Help Editor

Use this system tool to specify the field-specific help text that is available on Search 
Criteria forms. Text can provide guidance for completing the field correctly.

To add or modify Help text at the field level:

1. From the Tools page, click System Tools, then click the Listing Maintenance 
Help Editor tab. 

2. Highlight a field in the list.
Any existing instructions will appear in the Help Text box to the right.

3. Add or modify the text (up to 1,000 characters). 
• use the toolbar buttons to apply attributes to the text, such as bolding.

4. Click the Preview button to see what the help text will look like.
5. Click Save.
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Changing Your Password and Secret Question

If enabled by your MLS administrator, TEMPO 5 provides a feature that lets you 
change your password and/or secret question any time you want.

To change your password or secret question:

1. Click My Tools, and then click Change Password. 
The Change Password and Secret Question page opens.  

2. To make any changes to the settings on this page, you must type your Current 
Password.

3. Enter your New Password and then retype it for confirmation.
Note: Passwords are case sensitive.

4. To change the secret question and answer that you can use to retrieve your 
password should you ever forget it, click the Secret Question drop-down list and 
select a question. See “Signing In and Out” on page 4.

5. Enter your Secret Answer (maximum of 25 characters).
NOTE! Try to choose a secret answer that no one else will know or be able to guess 

easily. For example, if your last name is the same as your mother’s maiden 
name, that would NOT be a good secret question to select.

Click Save. 
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IDX Configuration and Member Permissions

The IDX Configuration and IDX Member Permissions dialogs are staff-only 
functions that allow users (who have sufficient access rights) to configure IDX 
profiles and edit IDX permissions for members.

To access the IDX Configuration page:

1. From the main menu, click My Tools > IDX Configuration.
Note: You must have proper IDX configuration permissions detected for 
this dialog to be displayed.

To access IDX Member Permissions:

1. From the main menu, click My Tools > IDX Member Permissions.
The Roster Search pop-up window opens.

2. Search for a member by using the available fields. For example, enter the agent’s 
name or office code (in whole or in part), then click Search.
A list of member information appears, including Public ID #, Name, Office 
and Key #.

3. Click on the blue hyperlink for a member.
The Member Information pop-up window opens, letting you view the member’s 
Agent, Broker and Permissions information.

4. Click the Edit button to make changes to this information.
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Member Search

Use the Member Info area to search for members using their name, Agent Public ID, 
Office ID or Email address. Once selected, the search results can be exported for use 
in another application, such as Excel; or printed as one of several types of report.

To search for one or more members:

1. From the main menu, click Member Info > Member Search. 
The Member Search Criteria page opens. 

2. Complete the fields on the Search form.
• use the footer bar controls to add, remove, move fields on the page. 

See “Using the Search Criteria Page” on page 68.
3. Click the Count button in the sidebar to see how many records match your 

criteria. 
4. Click one of the action buttons to perform a task:

• Download — opens the Data Export page so you can download the 
information. See “Exporting Data from TEMPO 5” on page 330.

• Save Search — opens the Search Settings page so that you can save the 
search for re-use. See “Saving a Search” on page 73.

5. Click the Search button or Search Results tab.
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The Search Results page opens. 

6. From the Search Results page, select one or more member records, then:
• use the footer bar controls to re-order a selected record in the list or to show 

the search criteria.
• click the Multi-Field Sort button to apply a filter to the data. See “Viewing, 

Sorting and Filtering” on page 22.
• click the Columns drop-down list to select another format for the data. 

See “Managing Column Reports” on page 318.
• click the Save Grid icon to save any changes you made to the column grid.

7. Click the action buttons to perform more tasks: 
• Revise Search — takes you back to the Search Criteria page so you can 

modify your search criteria.
• Print — lets you preview and print one or more member reports. In addition, 

you have the option to save the document in a Portable Document Format 
(PDF). See “Saving a Report as a PDF Document” on page 269.

• Download — opens the Data Export page so you can export the 
information. 
See “Exporting Member or Office System Data” on page 334.

• Transfer Members — lets you transfer one or more member records to a 
different office.

• Set Member Login Limit — lets you specify the number of logins allowed 
for a selected member, including unlimited logins.
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8. To choose the type of report you want to generate now, click the Reports drop-
down list, then click the Go button; or click the Details tab.

9. Proceed to the “Viewing Member Details” section.

Viewing Member Details

From the Search Details page you can choose from several different report formats, 
then scroll through multiple reports for on-screen viewing. In addition, you can 
preview what the report will look like when printed, then send it to the printer or save 
it as a PDF file.

To view a member report:

1. From the Member Search Results page, click the Details tab. 
2. If you want to change the type of member report from the Details page, click the 

Reports drop-down list and choose one of the available report types, for example 
Member Details.

3. To view multiple reports, click the Previous [ ] and Next [ ] arrow buttons 
at the top of the page to scroll through the different member records.

4. Click the Print Report button to select which reports (or pages of) to preview, 
print or save as PDF. See “Printing” on page 265.
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Office Search

Use the Office Search feature to search for offices using the Office Name, Office 
ID, etc. Once selected, the search results can be exported for use in another 
application, such as Excel; or printed as one of several types of report. 

To search for one or more offices:

1. From the main menu, click Member Info > Office Search. 
The Office Search Criteria page opens. 

2. Complete the fields on the Search form.
• use the footer bar controls to add, remove, move fields on the page. 

See “Using the Search Criteria Page” on page 68.
3. Click the Count button in the sidebar to see how many records match your 

criteria. If there are too many, revise the search criteria. 
4. Click one of the action buttons to perform a task:

• Search — displays the Search Results page with all matching records. 
Proceed to step #5.

• Download — opens the Data Export page so you can export the 
information. See “Exporting Member or Office System Data” on page 334.

• Save Search — opens the Search Settings page so that you can save the 
search for re-use. See “Saving a Search” on page 73. 

5. From the Search results page, select one or more office records, then:
• use the footer bar controls to re-order a selected record in the list or to show 

the search criteria.
• click the Multi-Field Sort button to apply a filter to the data. See “Viewing, 

Sorting and Filtering” on page 22.
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• click the Columns drop-down list to select another format for the data. 
See “Managing Column Reports” on page 318.

• click the Save Grid icon to save any changes you made to the column grid.
6. Click the action buttons to perform more tasks: 

• Revise Search — takes you back to the Search Criteria page so you can 
modify your search criteria.

• Print — lets you preview and print one or more office reports. In addition, 
you have the option to save the document in a Portable Document Format 
(PDF). See “Saving a Report as a PDF Document” on page 269.

• Download — opens the Data Export page so you can export the 
information. 
See “Exporting Member or Office System Data” on page 334.

7. To choose the type of report you want to generate now, click the Reports drop-
down list, then click the Go button; or click the Details tab.

8. Proceed to the “Viewing Office Details” section.

Viewing Office Details

From the Search Details page you can choose from several different report formats, 
then scroll through multiple reports for on-screen viewing. In addition, you can 
preview what the report will look like when printed, then send it to the printer or save 
it as a PDF file.

To view an office report:

1. From the Office Search Results page, click the Details tab.
2. If you want to change the type of office report from the Details page, click the 

Reports drop-down list and choose one of the available report types, for example 
Office Roster.

3. To view multiple reports, click the Previous [ ] and Next [ ] arrow buttons 
at the top of the page to scroll through the different office records.

4. Click the Print Report button to select which reports (or pages of) to preview, 
print or save as PDF. See “Printing” on page 265.
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MLS News

Although you can read the MLS, Broker and Office news on the Home page, you may 
want to print it. Use the MLS News page under Member Info to print the 
information. See “Using the MLS, Broker and Office Tabs” on page 12.

To print MLS, Broker or Office news:

1. From the main menu, click Member Info > MLS News.
The Message of the Day opens in a pop-up window.

2. Click the tab of the type of news you want to see: System, Broker or Office.
3. Click the Print button. 

A standard Windows Print dialog box opens. See “Printing” on page 265.
4. Choose all your print options, and click OK.
5. Click Close to exit the Message of the Day pop-up window.
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Managing Column Reports

The Column Manager is available from most Search Results pages. It allows you to 
apply a different Column report layout to your search results. There are two types of 
column reports:

• System — System reports are pre-defined and come loaded with the 
program. They cannot be modified directly; you must first make a copy, then 
modify and rename the copy. 

• Personal — Personal reports are created by you and, therefore, can be edited 
and deleted by you.

To apply a different column report layout:

• From the Search Results page, click the Columns drop-down list and select the 
name of a report. 

The Search Results are displayed in the new column layout.

To access the Column Manager:

• From a Search Results page, click the [ ] icon adjacent to the Columns drop-
down list at the top of the page.
The Column Manager pop-up window opens: 

To set a personal default column report:

• From the Column Manager, click the Personal Default Column drop-down list 
and choose the name of a report you like. 
It will be applied automatically to your Search Results pages.

To select a default 
column report, click the 
drop-down list and 
choose a report to 
apply automatically to 
search results.
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Creating a New Column Report

TEMPO 5 allows you to create custom column layouts (or “list views”) for the Search 
Results list that will let you present your data any way you want. 
The Column Manager feature is particularly useful for preparing custom export 
formats and column reports for search results. See “Exporting Data from TEMPO 5” on 
page 330.

To create a new column layout:

1. From the Column Manager pop-up window, click the Create new column 
report link.
The Column Manager > Edit page opens. 

2. Type a name for the new column report in the Grid Name field.
3. Select the access level option: 

• Personal — available only to you.
• Office — available to all agents in your office, as read-only.
• System — available to the entire MLS, as read-only.

4. Build the column layout by selecting the field(s) you want from the Available 
items list.
• enter the first few letters of what you want to search for in the Search for 

field text box. The list shortens to display the matching items.
• highlight a field in the list, then click the right [ ] arrow to add it to the 

Selected items list. Hold down the CTRL or SHIFT key to select multiple items.
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• to remove a field, highlight it in the Selected items list, then click the left [ ] 
arrow to move it back to the Available items list.

• to change the order of the selected fields, highlight a field in the Selected 
items list, then click the up [ ] or down [ ] arrow to move it to a new 
position. 

Note: The top field in the list will appear as the far left column in the 
grid; the bottom field in the list will appear as the far right column.

5. Click Save. 
The new column report name appears in the Available Column Reports list on 
the Column Manager pop-up window. The remaining links become available. 
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Copying a Selected Column Report

NOTE! System reports are pre-defined and come pre-loaded with the application. You 
cannot modify these. Instead, you can take a copy; modify it then rename it. 

To copy an existing Column report layout:

1. From the Column Manager pop-up window, highlight a report in the Available 
Column Reports list. 

2. Click the Copy selected column report link.
The Column Manager > Edit pop-up window opens. 

NOTE! The Grid Name field shows the name “Copy of [column report name]”. 

3. Type a name (or accept ‘Copy of ’) for the new column report in the Grid Name 
field.

4. Build the column layout by selecting the field(s) you want from the Available 
items list.
• enter the first few letters of what you want to search for in the Search for 

field text box. The list shortens to display the matching items.
• highlight a field in the list, then click the right [ ] arrow to add it to the 

Selected items list. Hold down the CTRL or SHIFT key to select multiple items.
• to remove a field, highlight it in the Selected items list, then click the left [ ] 

arrow to move it back to the Available items list.
• to change the order of the selected fields, highlight a field in the Selected 

items list, then click the up [ ] or down [ ] arrow to move it to a new 
position. 

5. Click Save. 
The copied report appears in the Available Column Reports list on the 
Column Manager pop-up window. The remaining links become available. 

6. To further customize the report, click the Add or remove fields, Change field 
sort order or Change field format links. See “Editing an Existing Column Report” 
on page 322.
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Editing an Existing Column Report

The Column Manager lets you quickly modify your own (Personal) Column report 
layouts. You can add or remove fields, change the field sort order on Search Results 
pages or change a field format.

NOTE! You can’t modify a Column report created at the System level. Instead, you 
must make a copy of the report, then rename it. For example, copy the Default 
Client Grid report that came pre-loaded with TEMPO 5 and either accept the 
name ‘Copy of Default Client Grid’ or name it something else. 

To add or remove fields from a selected Column report:

1. From the Column Manager pop-up window, highlight a Personal Column report 
in the Available Column Reports list.

2. Click the Add or remove fields link.
The Column Manager > Edit pop-up window opens.

3. To add a field, highlight it in the Available items list, then click the right [ ] 
arrow to add it to the Selected items list. 
• use the Search for field to help you locate the field you want to add.
• hold down the CTRL or SHIFT key to select multiple items.

4. To remove a field, highlight it in the Selected items list, then click the left [ ] 
arrow to move it back to the Available items list. 
• hold down the CTRL or SHIFT key to select multiple items.

5. To change the order of the selected fields, highlight a field in the Selected items 
list, then click the up [ ] or down [ ] arrow to move it to a new position. 
Note: The top field in the list will appear as the far left column in the 
grid; the bottom field in the list will appear as the far right column.

6. Click Save. 

To change the field sort order in a selected Column report:

1. Highlight a Personal Column report in the Available Column Reports list.
2. Click the Change field sort order link. 
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The Column Sort Order pop-up window opens. 

3. Click the Sort by drop-down list and select one of the column fields by which you 
want to sort. 

4. Click either the Ascending or Descending option button to the right of the 
drop-down list.
Note: If the column (selected in the Sort by list) results in duplicate 
values, you can sort the values further by using the Then by lists.

5. Click the first Then by drop-down list and specify another column name.
6. Click either the Ascending or Descending option button.
7. If needed, specify another column name in the second Then by drop-down list.
8. Click either the Ascending or Descending option button.
9. Click Save.

A message box appears confirming your changes.
10. Click Save.

Sort Order Example:

Here is an example of what a list would look like if it were sorted first by Status, then 
by Area, and then by List Price (all ascending):
Status Area List Price
Active 100 $100,000
Active 100 $200,000
Active 200 $100,000
Active 200 $200,000
Closed 100 $100,000
Closed 100 $200,000
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Closed 200 $100,000
Closed 200 $200,000

To change the field format:

1. From the Column Manager pop-up window, highlight a Personal Column report 
in the Available Column Reports list.

2. Click the Change field format link.
The Customize Columns pop-up window opens. 

3. Highlight the name of the column header you want to customize in the Columns 
list.
• use the up [ ] or down [ ] arrow to change the column order in the list.

4. Change the selected column’s settings:
• Column Header — type the text of the column’s header labels you want to 

appear.
• Prefix/Suffix — type some pre-defined text you want to appear before or 

after the field value within a column. For example, you may want the Square 
Footage column to always display “Sq Ft” after the value.

• Alignment — specify the column’s field values to line up to the Left, Right, 
or Center.

• Field Mask — click the drop-down list and choose a pre-defined formatting 
option to apply to the selected column. This setting is only available for 
numeric fields and lets you control how the value is presented. For example, 
you can determine how many decimal places to show, if you want to use 
comma separators, etc.
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• Display Format — click the drop-down list and choose a display format for 
the selected column. This is applicable to the fields that have two ways of 
displaying data; such as Short Code or Long Description.

• Use this Display Format for all fields in this grid — select this link to 
apply the same format to all columns.

NOTE! Unless you are preparing a column layout for printing customer reports, the 
Short Code is usually the best option because it lets you display more columns 
of information on-screen.

5. Specify the Column Width expressed as a number of characters.
6. Select the Best fit all columns check box if you want the program to 

automatically optimize the column fit for the page. This means that all of the 
columns dynamically resize so that they accommodate, but are not wider than, the 
maximum width of their contents.

NOTE! Clear the Best fit all columns check box to turn off this feature. 

7. Click Save.
A message box appears confirming your changes.

8. Click OK.

Deleting a Column Report

You can delete Personal Column reports only. System reports or Office/Board 
reports for which you do not have administration rights, cannot be removed.

To delete an existing Personal column report:

1. From the Column Manager pop-up window, highlight a Personal Column report 
in the Available Column Reports list.

2. Click Delete column report.
A message box appears prompting you to confirm the deletion.

3. Click OK.
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Setting a Personal Default Column Report

You can specify the name of a Column report to be applied automatically (by default) 
to your Search Results lists. 

To specify a default Column report layout:

• From the Column Manager pop-up window, click the Personal Default Column 
drop-down list and select the name of a report you want assigned as the default. 
Your Search results are displayed in the Column report layout specified.
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Importing Client Information

TEMPO 5 has a built-in import feature that enables you to import client information 
from other sources, such as Microsoft Outlook or Top Producer®.
Client information is also added automatically whenever a prospect electronically 
inquires about a listing on your Agent Web Site. See “Client Gateway” on page 40.

To import client information into TEMPO 5:

1. From the Contact Manager page, select the Import button. 
The Client Import page opens. 

2. In the Data Format section, select the option button that describes the 
application (and version) from which you want to import client information: 
• Import Microsoft Outlook 2000 or later 

• Import Top Producer 6.0 or 6i Contacts

• Import Top Producer 7i Contacts

3. Select what you want TEMPO 5 to do if the program already contains a record 
with the same name as one that is being imported: 
• Keep the client record — the new contact record will not be imported.
• Overwrite the client record with the one being imported — existing 

client information in the TEMPO 5 database will be replaced with the 
imported client information.

• Add a new client record (resulting in duplicate records) — both the existing 
and imported client records are preserved; however, this may result in 
duplicate client records.

4. Click Next. 
The Client Import page opens with on-screen instructions for the application 
you chose in step #2.

5. If you are importing from: 
• Microsoft Outlook, the records from the Contacts folder in Outlook’s 

Personal Folders will be imported. Go to step 6.
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• Top Producer, follow the on-screen instructions to export your Top Producer 
contacts to a text file (.txt or .csv). Once the export file has been created and 
saved, click Next to open the last page of the Client Import wizard. 

• Click Browse to navigate to where you saved the Top Producer export 
file, highlight it and click Open. 

6. Click Import.
A message dialog appears telling you the contacts have been imported 
successfully.

7. Click OK.
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Exporting Data from TEMPO 5

TEMPO 5 lets you export information and images for use in other areas of the 
program, or in other applications, such as Microsoft® Excel®. You can export:
• contact records
• listing data 
• hotsheet data 
• member and office system data
A file compression option is available to reduce the file size for faster export time. 
If you choose this option, the export file will be a zipped (.zip) file.

Exporting Contact Records

Choose some or all of your contact records to export. To export some of your 
records, select them from the Contact Manager list before you click Export. 
To export all client records, either select all by clicking on the check box column 
header, or leave them all unselected. The system assumes you mean to select them all 
and will have the correct option button chosen accordingly.

To export client data from Contact Manager:

1. From the main menu, click Prospects > Contact Manager.
2. From the Contact Manager page, select the records to export from the list.
3. Click the Export button.

The Client Data Export page opens. 

Note: In the Select Records to Export section, the correct option 
button will be selected. 

4. Click the Data Export Format drop-down list and choose an option:
• Comma delimited — values in the text file will be separated by commas.
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• Tab delimited — values will be separated by tabs.
5. In the Export Options section, select the Compress file check box if you are 

performing a large export (more than 100 records) and want to decrease the size 
of the file and the time it will take to download. 

6. Click Next.
The next page of the wizard opens. 

7. Click the Select Export Grid Format drop-down list and choose one of the grid 
formats. These formats specify the fields to be exported, and the order in the 
which they are exported. 

8. Select the Include Column Headers? check box to include the column headers 
(name of the column, such as Name) as the first row in the exported file. This 
helps you identify the data in each of the columns.

9. Click Next. 
A File Download dialog box opens.

10. Click Save. 
11. Use the Save As dialog box to navigate to a convenient location on your computer 

to save the file. 
Note: The file is automatically named “clients_[current date]_[system 
number].txt”, or .zip if you chose compression. You can change this name 
by typing a new one in the File Name field of the Save As dialog box.

12. Click Save again to complete the process.
The Download complete dialog opens. 

13. Click Close.
14. Click Back to return to the Contact Manager page.
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Exporting Listings Data

Using TEMPO 5, you can quickly and easily export listing data in a format that can be 
opened by another application, such as Microsoft® Excel®.

To export listings data:

1. From a Search Results page, select one or more listings to export from the list. 
Note: To export all records, do not select any of them.

2. Click the Download button (which is also available on the Search Criteria page).
The Listing Data Export page opens. 

3. In the Select Records to Export section, the appropriate option will be selected, 
based on the previous page (step #1):
• Selected Records

• All Records

4. Click the Data Export Format drop-down list and choose one of the options:
• Comma Delimited — values in the text file will be separated by commas.
• Tab Delimited — values in the text file will be separated by the Tab 

character.
• Pocket Real Estate3 — text file will be exported directly to Pocket Real 

Estate for use on a specific personal handheld device (PDA).
5. In the Export Options section, select the Compress file check box if you are 

performing a large export (more than 100 records) and want to decrease the size 
of the file and the time it will take to download.

6. Click Next.
Note: If you are exporting to Pocket Real Estate, the export process 
begins immediately. Otherwise, the wizard continues, as below.
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The next page of the wizard opens. 

7. Click the Select Export Grid Format drop-down list and choose one of the grid 
formats. These formats specify the fields to be exported, and the order in which 
they are exported.

NOTE! Before exporting client data, you may want to use the Column Manager to 
create a special Grid format (i.e., column layout) that contains additional and/or 
different Client Record fields. This will allow you to create an export file in the 
precise format required. See “Column Manager” on page 317.

8. Select the Include Column Headers? check box to include the column headers 
as the first row in the exported file.

9. Click Next. 
A File Download dialog box opens.

10. Click Save. 
11. Use the Save As dialog box to navigate to a convenient location on your computer 

to save the file. 
Note: The file is automatically named “listings_[current date]_[system 
number].txt”, or .zip if you chose compression. You can change this name 
by typing a new one in the File Name field of the Save As dialog box.

12. Click Save again to complete the process.
The Download complete dialog opens. 

13. Click Close.
14. Click Back to return to the Search Results page.
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Exporting Hotsheet Data

Using TEMPO 5, you can quickly and easily export hotsheet data in a format that can 
be opened by another application, such as Microsoft® Excel®.

To export hotsheet data:

1. From the Hot Sheets Results page, select one or more hotsheets to export from 
the list. 
Note: To export all records, do not select any of them.

2. Click the Download button.
The Hotsheet Data Export page opens. 

3. The rest of the procedure is the same as exporting contact data. See “Exporting 
Contact Records” on page 330.
Note: The file is automatically named “hotsheet_[current date]_[system 
number].txt”, or .zip if you chose compression. You can change this name 
by typing a new one in the File Name field of the Save As dialog box.

Exporting Member or Office System Data

TEMPO 5 gives you the ability to export member system and office system data. 

To export member or office system data:

1. From the main menu, click Member Info, then Member Search or Office 
Search.

2. The rest of the procedure is the same as exporting contact data. See “Exporting 
Contact Records” on page 330



Charting Market Data

Displaying Market Trends Graphically
Market Area Activity Charts
Price Comparisons to DOM Reports



Charting Market Data

336 TEMPO 5 User Guide

Displaying Market Trends Graphically

TEMPO 5 can generate eye catching charts to highlight historical market trends and 
compare listing and sale price differences using MLS data. Give your reports some 
impact by inserting these comparative charts into your CMAs and flyer presentations. 
There are two types of charts available: 
• Market Area Activity — create three levels of geographical chart for a single 

listing record. 
• List Price vs. Sale Price with DOM comparison — create a chart comparing 

the list price, sale price and the number of days on market for multiple listing 
records (maximum 20).

To generate a chart for a single listing record:

1. From the listing Search Results page, select one record in the list.
2. Using the mouse, point to the Information icon to display the Quick Access 

menu, then click the Charts icon. 
The Charts dialog opens. 

3. Click the Chart drop-down list and select:
• Market Area Activity by Area Number — charts the activity based on the 

Area Number search criteria (e.g. 306). 
4. To cut and paste this chart into another program, click the Copy Chart to 

Clipboard button.
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• when you are ready to insert the chart, press CTRL + V to paste from the 
clipboard.

5. Click Print to send this chart to the printer.
A standard Windows Print dialog opens.

6. Choose your print settings and click Print.
7. Click Close to exit the Chart dialog.

To generate a chart for multiple listing records:

1. From the Search Results page, select multiple records, then click the Details tab.
2. Select Charts from the sidebar.

The Charts dialog box opens. 

3. Click the Chart drop-down list and select: 
• List Price vs. Sale Price with DOM Comparison — charts the sales 

activity based on the list price, sale price and number of days on market for up 
to 20 properties.

4. To cut and paste this chart into another program, click the Copy Chart to 
Clipboard button.
• when you are ready to insert the chart, press CTRL + V to paste from the 

clipboard.
5. Click Print to send this chart to the printer.

A standard Windows Print dialog opens.
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6. Choose your print settings and click Print. See “Printing” on page 265.
7. Click Close to exit the Chart dialog.

NOTE! When creating charts from here, the Charts dialog gives you access to all of the 
reports; that is, Market Area Activity and List Price vs. Sales Price reports, 
regardless of whether you have selected one record or multiple records.

Market Area Activity Charts

Market Area Activity charts are generated for a single listing and compares the 
number of Active, New and Sold listings (Y-axis) against the Average Sale Price in 
000’s (Z-axis) over a period of years (X-axis) for a specific geographical area. You can 
narrow the geographical area to three levels, each getting progressively more specific.

Price Comparisons to DOM Reports

List Price vs. Sale price with Days on Market Comparison charts are generated for 
multiple listings (X-axis) and compares both the List Price and subsequent Sale Price 
(Y-axis) against the number of Days on Market (Z-axis) and subsequent Sale Price. 
Based on MLS or CMA data, this chart can be inserted into your CMA presentations 
to justify the List Price of a property.
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Data Security Overview

The Adaptive Security feature is a way for MLS Boards to secure their MLS data from 
misuse by having the ability to set rules for all members, and specify actions when 
those rules are broken. 

NOTE! These instructions are for the MLS users.

This security feature is designed to pick up on software behavior patterns that 
represent possible misuse, for example, concurrent logins, multiple login attempts, 
high numbers of downloads, long session times, etc.
The security implementation includes:
• Duplicate Login Management
• Password Management
• IP Tracking
• Advanced Reporting

About Duplicate Logins

The Duplicate Login Management feature has two levels of management: Basic and 
Advanced. Basic Management has five standard rules that determine how TEMPO 5 
will react every time a duplicate login violation is detected. See “Basic Management” on 
page 341.
If you want to set up more customized rules and actions for all or individual 
members, use Advanced Management. It enables you to do more than the Basic 
Management options such as applying special rules that you define yourself. See 
“Advanced Management” on page 343.

How Rules Work

Basically there are three parts to every rule you set up. 
1. Overall time frame — The system tracks the number of duplicate login violations 

for an overall specified time frame that you define, (today minus #hours).
2. Threshold limit — Each rule has a specified quantity that you define. When the 

user exceeds the limit, an associated action is executed. Two rules can NOT have 
the same number.

3. Resulting action — Every rule has a specific action linked to it, so when applied, 
the rule executes a consequence, such as account suspension.
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Basic Management

This area allows you to determine how the system will react every time a duplicate 
login violation occurs.

To access the basic login security features:

1. From the main menu, click My Tools > System Tools > System Settings > 
Defaults.

2. Click Duplicate Login Management.
The Basic Management tab opens by default. 

3. Select one of the Duplicate Login Settings rule options:
Note: In all of the options, violations are recorded. 

• Deny access to the system on duplicate login attempts — denies login to 
a second user who enters the same User ID as the current user who is already 
logged in. 

Note: This option disables the Advanced Management options.

• Prompt to terminate currently logged in user's session — asks a second 
user (using the same User ID to log in) if they want to terminate the current 
user’s session. 
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• Automatically terminate the currently logged in user's session — 
informs the currently logged in user that a second user (with the same User 
ID) has logged in which automatically terminates their session.

• Automatically terminate the currently logged in user's session AND 
deny access to the new user attempting to access the system — informs 
all currently logged in users that their sessions are terminated; another user 
attempting to log in using the same User ID is denied login for the moment.

• Do nothing, but continue to count violations — duplicate login checking 
is not enabled, unless the advanced duplicate management is enabled. 
See “Advanced Management” on page 343.

Note: Click the more information link to view additional information 
and examples for each of the options.

4. Click Save.
5. When the message box appears confirming your changes have been saved, click 

OK.
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Advanced Management

This area allows you to enable or disable the security feature for all users; or create 
member-specific rules to be executed after a specific number of violations has 
occurred.

To access the advanced login security features:

1. From the Duplicate Login Management page, click the Advanced Management 
tab. 

2. Select one of the following global options:
• Enable Advanced Duplicate Login Management — enables this feature 

for all users.
• Disable Advanced Duplicate Login Management — disables this feature 

for all users.
The label text displays either ENABLED or DISABLED. 

3. Select the Allow for Use of Member-Specific Overrides check box to enable 
specific rules for individual members. See “Member Specific Options” on page 350.
Note: This option operates independently from the global options in 
step #2 and can only be set on a per board basis.



Adaptive Security

344 TEMPO 5 User Guide

4. In the All Rules are evaluated from within the LAST [x] hours field, define ‘x’ 
as the number of hours that, when subtracted from today, defines the time frame 
the system requires to track the number of consecutive violations.

5. Click the footer bar controls to do the following:
• Reset ALL users — resets the Violation Counter to zero for all users, 

without losing track of the actual number of duplicate logins. 
• Manage Actions — displays the Manage Actions dialog which enables you 

to create, edit or delete actions to be assigned to your rules. See “Managing 
Existing Actions” on page 348.

• Add NEW rule — adds a new row to the page, enabling you to specify the 
time frame and assign an action to the rules. See “Adding a New Rule” on 
page 344.

6. Click Save.
NOTE! Any rules that do not have actions associated with them will be automatically 

deleted when you click Save.

Adding a New Rule

Each new rule you create must specify a number of consecutive login violations not 
to be exceeded; and a specific action to be executed when the number is exceeded. 
The rules will appear at the bottom of the Advanced Management page in ascending 
order (based on the number of violations).

Note: You will see the rules sorted properly upon your next login.

To create a new member-specific rule:

1. From the Advanced Management page, click Add NEW Rule from the footer 
bar.
A new row appears in the bottom half of the page. 

2. Ensure the time frame is set, for example 720 hours (one month). 
The system needs this time frame reference to track the number of violations.

3. Specify the number of consecutive duplicate login violations, for example 10.
This is the number that, when exceeded, the rule and its associated action will be 
executed.

4. Click the drop-down box and select:

Set the time frame. Specify the number of duplicate 
login violations.

Select or create an 
associated action.

Edit and Delete 
buttons.
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• Select an Action — displays a list of existing actions.
• Create an Action — lets you create a new action to add to the list. 

See “Creating an Action” on page 345.
5. To modify the new rule, click one of the following buttons:

• Edit — displays the Duplicate Login Action [action name] dialog box which 
enables you to modify the selected action associated with the rule. 

• Delete — enables you to remove the rule. When the message box appears 
prompting you to confirm the deletion, click OK.

6. Click Save.

Creating an Action

You can create a new action to associate to the new rule. This action will be executed 
whenever the rule is broken.

To create a new action:

1. Assuming you have added a rule on the Advanced Management page, click the 
drop-down list at the end of the row and select Create an Action.
The Duplicate Login Action dialog box opens. 

2. Select one of the options available in the Settings section:
• Require the user to activate their session by sending an activation code 

to their primary e-mail address — select this option to lock out the user 
until they enter an activation code. The User ID remains inoperable until the 
activation code has been entered. Other users do not experience any 
disruption.
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• Force to change password — select this option to prompt the user logging 
in to change the password. Other users already logged in will be forced off the 
system once the password has been changed.

• Suspend user access — select this option to suspend an account. The user 
and other members who use the same User ID, will see a suspension message 
and their session will be terminated. 
Enter the e-mail address for the Board’s administrator who wants to be 
notified that someone has been suspended, then click the Change access 
flag of user to drop-down list and choose an amount of time the suspension 
should last, for example Suspend for 30 minutes. The Suspension 
Message button becomes enabled, letting you create a custom message, 
otherwise the default suspension message is displayed. See “Creating a 
Suspension Message” below. 

• Prompt to answer random Password Reminder Question on each login 
— select this option to display one of the personal verification questions 
randomly upon each login attempt. The question must be answered correctly 
for successful login. 
Further define this option by selecting the Suspend user access check box 
and specifying a maximum number of attempts the user has at answering the 
question. Then click the Change access flag of user to drop-down list and 
choose an amount of time the suspension should last, for example Suspend 
for 30 minutes. The Suspension Message button becomes enabled, letting 
you create a message. See “Creating a Suspension Message” below.

3. Click Save.
The Save Action dialog box opens.

4. Type a descriptive name for this new action in the field.
5. Click OK.

The action will now be available in the drop-down list, ready to be selected and 
associated with new rules.

Creating a Suspension Message

You can create a rich text message that will appear to all users who receive a 
suspension, and will persist until the suspension has ended or the board has re-
defined the action. Each board can have its own suspension message, which is directly 
associated with a suspension type action that is executed upon a rule violation. 

NOTE! Should you delete this message, the system default message will be used. 

To create a customized suspension message:

1. Click the Suspension Message button, available when certain options are 
selected on the Duplicate Login Action [action name] dialog box. 
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The Suspension Message pop-up window opens. 

2. Type the text of the message in the text box.
Note: The default system message will NOT be overwritten.

3. Place your cursor in the body of the text, then click the Insert Merge Field 
drop-down list and select a merge field. 
When the message is displayed, the appropriate values will be inserted into the 
merge fields. For example, the SuspensionDate field automatically inserts the 
date and time the suspension was recorded into the message.

4. Click Save.
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Managing Existing Actions

You can create, edit, rename or delete actions using the Manage Actions dialog box.

To access the Manage Actions feature:

1. From the Advanced Management page, click Manage Actions from the footer 
bar.
The Manage Actions pop-up window opens. 

2. To modify an existing action in the list, click a button at the end of the row:
• Rename [ ] — displays the Rename Action dialog box, letting you type a 

new name for the action. 
• Edit [ ] — displays the Duplicate Login Action dialog box, letting you 

modify the settings. 
• Delete [ ] — lets you delete an action, if there are no rules associated with 

it.
3. Click the New Action button at the bottom of the page to create a new action.
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Active Violations

The Active Violations tab shows a list of all members who currently have violations 
that prevent them from accessing the system. By looking at the violations reported, 
you can determine whether the rules are too strict or if you have more violators than 
previously suspected.

To generate a report of all current active violations:

1. From the Duplicate Login Management page, click the Active Violations tab. 
The page opens showing the current date and time the report was created. 

2. Click the Refresh List button on the footer bar to display the most up-to-date 
view. 
Note: It is possible that upon refreshing the list, some of the violations 
will have been dealt with and, therefore, gone from the list. Other more 
current violators will have appeared.

3. Click the Print button on the footer bar to generate a report.
A standard Windows Print dialog box opens.

4. Choose your printer options, then click OK.
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Member Specific Options

If you’ve selected the Allow for Use of Member-Specific Overrides check box on 
the Advanced Management page, you can manage duplicate logins for specific 
members directly from their record. 

NOTE! These options are only available to MLS level administrators.

To manage duplicate logins for a specific member:

1. On the Advanced Management page, ensure the Allow for Use of Member-
Specific Overrides check box is selected.

2. From the main menu, click My Tools > Membership/Office > Membership 
Maintenance.
The Tools > User Inventory > User Maintenance page opens.

3. Click the Search for user link and perform a search.
4. From the Search Results dialog box, select a member from the list then click the 

Edit Selected User button.
5. From the member record, click Options & Statistics to expand the section.

6. In the Duplicate Login Management section, click one of the following 
options:
• Follow the default system rules for this user — this is the default 

selection. When selected, the rule specified on the Duplicate Login 
Management page is followed. 
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• Use special rules for this user — lets you create a special set of rules that 
will apply only to this user when they log in. Click the Edit link to display the 
Member Specific Duplicate Login Rules pop-up window, which lets you add 
new rules and manage actions. 

Note: The Member-Specific Duplicate Login Rules pop-up window is 
used in the same way as the Advanced Management window is used to 
create new rules. Click the Add a NEW Rule button and follow the 
instructions in “Adding a New Rule” on page 344 . Additionally, click the 
Manage Actions button to display the Manage Actions pop-up window. 
See “Managing Existing Actions” on page 348.

• Turn off duplicate login management for this user — when selected, 
login checking will not be performed on this member. 

Note: Violations are still tracked and recorded.

7. In the Number of simultaneous logins allowed text box, enter a number 
representing the number of duplicate logins allowed before the associated action 
is taken.
• select the Unlimited check box to allow any number of duplicate logins. 

No action will be taken.
8. Click Apply.
9. In the Options section, do one of the following:

• select the Force a Password Change on user’s next login check box to 
temporarily lock the member out of the system until they enter a new 
password on their next login. Click Apply.

• click the Send an Activation Code link to automatically send (via the 
displayed e-mail address) the activation code required by the user to log in 
successfully.

10. The Current Status section is a view-only area where the administrator can see 
the Current Sessions Number for this member (the number of active sessions 
that are running).

11. In the Statistics section, click the drop-down lists and select a duration (today, 
current week, last month, etc.) for each recorded statistic you want to view: 
• total number of duplicate login violations
• total number of failed password attempts
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